computer software for math and science
**Important Information**

Except as otherwise expressly stated in the License that accompanies a program, Texas Instruments makes no warranty, either express or implied, including but not limited to any implied warranties of merchantability and fitness for a particular purpose, regarding any programs or book materials and makes such materials available solely on an "as-is" basis. In no event shall Texas Instruments be liable to anyone for special, collateral, incidental, or consequential damages in connection with or arising out of the purchase or use of these materials, and the sole and exclusive liability of Texas Instruments, regardless of the form of action, shall not exceed the amount set forth in the license for the program. Moreover, Texas Instruments shall not be liable for any claim of any kind whatsoever against the use of these materials by any other party.

**License**

Please see the complete license installed in C:\Program Files\TI Education\TI-Nspire.

© 2007 Texas Instruments Incorporated

Microsoft®, Windows®, Excel®, Vernier EasyTemp®, Go!®Temp and Go!®Motion are trademarks of their respective owners.
Contents

Important Information ........................................................................................................ ii
License .......................................................................................................................... ii

Introduction ................................................................................................................ 1
The TI-Nspire™ computer software for math and science ........................................... 1
How to use this guidebook ....................................................................................... 1

Getting Started ......................................................................................................... 3
The TI-Nspire™ computer software Home Screen ....................................................... 3
Using menus ............................................................................................................... 4
   Menu Options ......................................................................................................... 4
Using tool bars ......................................................................................................... 8
   Tool bar contents ................................................................................................. 8
The Page Sorter ......................................................................................................... 10
Using the Work Area ............................................................................................... 11
   Multiple work areas on one page .................................................................... 11
   Creating multiple work areas .................................................................. 12
   Adding an application to a page ................................................................ 12
   Repositioning (swapping) applications on a page .................................... 13
   Deleting pages or applications ................................................................ 13
The TI-Nspire™ Keypad .......................................................................................... 13
Using the TI-Nspire™ keypad .............................................................................. 14
Language Settings ................................................................................................. 14
   Changing the Language: ............................................................................ 14
Document Settings .................................................................................................. 15
   Customizing document settings ................................................................ 16
   Applying document settings to the system ............................................. 17
Using the catalog .................................................................................................... 17
   Opening the catalog ...................................................................................... 18
   Entering special characters or templates ................................................ 19
Changing the desktop view .................................................................................. 20
   TI-Nspire™ Handheld View ...................................................................... 20
   Presentation View ......................................................................................... 21

Working with Documents ....................................................................................... 23
Creating a new document ....................................................................................... 23
   Adding an application to a page ................................................................ 24
   Adding multiple applications to a page ................................................. 25
   Adding a problem to a document .......................................................... 27
   Adding a page to a problem ................................................................ 27
Using the Page Sorter ............................................................................................. 28
   Selecting pages in the Page Sorter ....................................................... 28
Rearranging pages in the Page Sorter ........................................ 28
Saving documents ........................................................................ 29
  Saving a document with a new name ........................................ 29
Printing documents ....................................................................... 30
  Using Print Preview .................................................................. 31
Linking values on pages ............................................................... 31
  Creating TI-Nspire™ variables ................................................. 32
  Special considerations for variables .................................... 34
  Checking a variable’s value using the Calculator application ... 36
  Using (linking) TI-Nspire™ variables .................................... 36
  Removing a linked variable .................................................... 39

Using Calculator .............................................................................. 41
Getting started with the Calculator application............................ 41
  Before you begin .................................................................... 46
Entering and evaluating math expressions .................................... 46
  Options for entering expressions ......................................... 46
  Entering simple math expressions ....................................... 46
  Controlling the form of a result ............................................ 47
Inserting items from the Catalog ................................................. 48
  Using an expression template ............................................. 49
Creating matrices ....................................................................... 50
  Inserting a row or column into a matrix ................................ 50
  Inserting expressions using a wizard .................................... 51
Creating a piecewise function ..................................................... 52
Deferring evaluation ................................................................... 53
Working with variables ............................................................... 53
  Storing a value in a variable ............................................... 53
  Alternative methods for storing a variable ......................... 54
  Checking a variable’s value ................................................ 54
  Using a variable in a calculation ........................................ 54
  Updating a variable ............................................................ 55
Types of variables ...................................................................... 55
  Entering multiple statements on the entry line .................. 55
Rules for naming variables ....................................................... 56
  Reusing the last answer ....................................................... 57
  Temporarily substituting a value for a variable ................... 58
Creating user-defined functions and programs ......................... 58
  Defining a single-line function ........................................... 58
  Defining a multiple-line function using templates ............. 58
  Defining a multiple-line function manually ....................... 60
  Defining a program .......................................................... 61
Recalling a function or program definition ................................ 62
Editing Calculator expressions .................................................... 62
Positioning the cursor in an expression............................... 62
Inserting into an expression in the entry line ............... 63
Selecting part of an expression.......................................... 63
Deleting all or part of an expression on the entry line ...... 63
Financial calculations ......................................................... 63
Using the Finance Solver....................................................... 63
Finance functions included................................................... 65
Working with the Calculator history..................................... 65
Viewing the Calculator history............................................. 65
Reusing a previous expression or result........................... 66
Deleting an expression from the history........................... 67
Clearing the Calculator history.......................................... 67

Using Graphs & Geometry ..................................................69
Getting started with Graphs & Geometry.......................... 69
Getting acquainted with Graphs & Geometry.............. 70
The Tool menu................................................................... 70
Using the Context menu..................................................... 79
The work area.................................................................... 79
The graphing view ............................................................. 80
The plane geometry view .................................................. 80
The analytic window......................................................... 81
To remove the analytic window from the work area .... 82
Creating and manipulating axes ........................................ 85
Moving about the work area ............................................ 87
Turning the grid on or off ................................................ 88
Attaching an object to the grid ....................................... 89
The Zoom feature ............................................................ 89
Checking page contents ................................................... 92
The entry line.................................................................... 92
Additional Graphs & Geometry features ......................... 94
Keystroke shortcuts........................................................ 94
Using the tab and arrow keys ......................................... 94
Attribute settings ............................................................ 95
Changing the thickness and style of a line/outline........... 97
Locking measured values and points.............................. 98
Working with functions ..................................................... 99
Using the entry line........................................................ 99
Using the entry line expand button................................. 100
Using the Text tool to enter functions............................. 100
Graphing inequalities ....................................................... 102
Renaming f(x) ................................................................. 102
Editing functions ............................................................ 103
Hiding a function on the work area............................... 104
Deleting a function ........................................................ 105
Clearing the work area...............................................................105
The Trace tools ...........................................................................105
  Using Graph Trace ................................................................106
  Using Geometry Trace ........................................................107
  Using Erase Geometry Trace ..............................................108
Manually manipulating functions .............................................109
  Manipulating a linear function .........................................110
  Manipulating a quadratic function ....................................110
  Manipulating a sine or cosine function .............................111
Working with multiple objects at one time .........................112
  Selecting multiple objects ...............................................112
  Deleting multiple selections ..........................................113
  Moving multiple selections ...........................................113
Drawing and working with points and lines ..........................113
Points ...........................................................................................114
  Creating a point...................................................................114
  Creating a point on a specific object..................................114
  Defining an intersection point(s) .......................................115
  Labeling (identifying) a point ..........................................115
  Naming a point ...................................................................116
  Redefining a point...............................................................117
Linear objects ..............................................................................118
  Creating a line .....................................................................118
  Creating a ray ......................................................................118
  Creating a line segment....................................................119
  Creating a line segment with defined midpoint .................120
  Creating a parallel line .......................................................121
  Creating a perpendicular line ............................................122
  Creating a vector ...............................................................123
  Moving a vector................................................................124
  Resizing a vector................................................................124
  Creating a tangent .............................................................124
Creating and working with objects (shapes) ............................125
  Creating a circle...................................................................125
  Moving a circle...................................................................126
  Resizing a circle..................................................................126
  Creating a triangle ..............................................................129
  Moving a triangle ..............................................................129
  Reshaping a triangle ...........................................................130
  Creating a rectangle...........................................................130
  Creating a polygon...........................................................131
  Moving a polygon .............................................................132
  Reshaping a polygon..........................................................132
  Creating a regular polygon ..............................................133
Transferring Measurements .......................................................134
  Transferring a measurement.............................................134
Transferring a numerical text entry to an axis ............... 135
Transferring a measurement onto a circle .................. 136
Measuring graphs and objects ...................................... 137
Identifying equations for circles and lines .................. 137
Measuring length ...................................................... 138
Finding the area of a circular disc, polygon, rectangle or triangle ........................................... 140
Finding the perimeter of a circular disc, polygon, rectangle or triangle ........................................... 140
Finding the measure of an angle ................................ 141
Defining an angle with three points .............................. 141
Repositioning a measured value .................................. 142
Finding the slope of a line, ray, segment or vector ............ 142
Adding text to the work area ...................................... 143
Moving text ................................................................. 144
Using the Calculate tool ............................................ 144
Exploring functions, graphs, and objects ...................... 145
Finding points of interest: zeroes, minima, maxima .... 146
Finding the definite integral of a function .................... 147
Finding the derivative of a function at a point (the slope) ......................................................... 148
Transformations .............................................................. 149
Exploring symmetry .................................................... 149
Exploring reflection ..................................................... 150
Exploring translation .................................................. 151
Exploring rotation ........................................................ 152
Exploring dilation ......................................................... 153
Other investigations ...................................................... 155
Bisecting a segment defined on a line ......................... 155
Bisecting a segment .................................................... 156
Bisecting an implied segment ....................................... 157
Bisecting an angle ........................................................ 158
Bisecting an implied angle .......................................... 159
Creating a locus .......................................................... 160
Animating objects ........................................................ 162
Animating one point on an object ............................... 162
The animation control panel ....................................... 163
Changing the animation of a point in motion ............... 164
Pausing and resuming animation ................................. 164
Resetting animation .................................................... 164
Stopping animation ..................................................... 164
Plotting collected data ............................................... 165
Creating a scatter plot ............................................... 165
Using Data & Statistics ................................................................. 169
The Tool menu .............................................................................. 170
Getting started with Data & Statistics .............................................. 175
Creating plots from spreadsheet data.............................................. 175
Plotting data from Lists & Spreadsheet ......................................... 175
Creating a split page with Data & Statistics and Lists & Spreadsheet .............................................. 178
Plotting the contents of linked variables ........................................... 178
Plot types ....................................................................................... 181
Dot plots........................................................................................ 181
Creating a dot plot ........................................................................ 182
Box plots......................................................................................... 183
Creating a boxplot ........................................................................ 183
To change the boxplot from modified to standard ....................... 185
Extending Box Plot Whiskers ....................................................... 185
Showing Box Plot Outliers .......................................................... 187
Histograms .................................................................................... 188
Creating a histogram ..................................................................... 188
Adjusting the bins interactively ...................................................... 189
Adjusting bins numerically ............................................................ 190
To change the scale: .................................................................... 193
Plotting a value ............................................................................. 193
Removing a plotted value ............................................................. 195
Normal probability plots ................................................................ 195
Creating a normal probability plot ................................................. 195
Scatter Plots.................................................................................... 195
From the Lists & Spreadsheet work area: .................................. 196
From the Data & Statistics work area: ........................................ 196
X-Y line plots.................................................................................. 198
Multiple Plots ............................................................................... 198
Exploring data ............................................................................... 199
Moving points or bins of data .......................................................... 200
Selecting multiple points ............................................................... 202
Selecting a range of points ............................................................ 204
Changing plot type ....................................................................... 206
Rescaling a graph ........................................................................ 207
Adding a movable line ................................................................... 210
Rotating a movable line ............................................................... 211
Showing regression lines .............................................................. 213
Showing residual squares ............................................................. 215
Using Window/Zoom tools ............................................................. 216
Graphing Functions ....................................................................... 218
Graphing multiple functions using the Plot Function tool .......... 218
Entering functions from other applications ................................... 219
Using Lists & Spreadsheet .................................................................227
Getting started with tables............................................................227
Before you begin...........................................................................231
Navigating in a spreadsheet..........................................................231
Inserting a cell range into a formula .............................................232
Methods of entering data .............................................................234
Entering a math expression, text, or spreadsheet
formula ..........................................................................................235
Working with individual cells ........................................................236
Creating absolute and relative cell references .........................236
Inserting items from the Catalog ..................................................237
Deleting the contents of a cell or block of cells .........................238
Copying a cell or block of cells .....................................................239
Filling adjacent cells .....................................................................240
Sharing a cell value as a variable ................................................241
Linking a cell to a variable .............................................................241
Preventing name conflicts .............................................................242
Working with rows and columns of data .................................243
Selecting a row or column ............................................................243
Resizing a row or column .............................................................243
Inserting an empty row or column ..............................................244
Deleting entire rows or columns ................................................244
Copying rows or columns .............................................................245
Moving a column ........................................................................246
Sorting data ..................................................................................247
Sorting a range of cells in a column .............................................247
Sorting a rectangular region ........................................................248
Sorting entire columns .................................................................249
Generating columns of data ........................................................250
Creating column values based on another column .................250
Generating a list of random numbers ........................................252
Generating a numerical sequence .............................................252
Creating and sharing spreadsheet data as lists .......................254
Sharing a spreadsheet column as a list variable .......................254
Linking to an existing list variable ..............................................257
Inserting an element in a list ......................................................257
Deleting an element from a list .................................................257
Graphing spreadsheet data ..........................................................258
Capturing data from Graphs & Geometry.................................260
  Capturing data manually ....................................................260
  Capturing data automatically.............................................262
Creating function tables.................................................................................................263
  Showing and Hiding function tables......................................264
  Generating a function table ..............................................265
  Adding a function table from Graphs & Geometry...........266
  Viewing values in a function table ....................................266
  Editing a function................................................................267
  Changing the settings for a function table .......................267
  Deleting a column in the function table............................268
Using table data for statistical analysis .................................................................268
  Plotting statistical data .....................................................268
Statistical calculations .....................................................................................................270
  Performing a statistical calculation ....................................270
  Supported Statistical Calculations ....................................272
Distributions.....................................................................................................................276
  Calculating distributions ....................................................277
  Supported Distribution functions .....................................279
Confidence Intervals .......................................................................................................285
  Supported Confidence Intervals .......................................285
Stat tests ..........................................................................................................................288
  Supported Statistical tests................................................288
Statistics Input Descriptions ..........................................................................................294
Exchanging data with other computer software ..........................................................295
  Example - copying data from TI DataEditor ...................296
  Example - copying cells from an Excel® spreadsheet .......297

Using Notes .........................................................................................................................301
  Getting started with the Notes application .......................301
  The Notes tool menu ........................................................302
  Before you begin ................................................................303
  The Notes work area .......................................................303
  Notes templates ..................................................................303
  Applying a Notes template ..............................................304
  Using the Q&A Template ................................................304
  Using the Proof Template ..............................................304
  Inserting comments ........................................................305
  Formatting Notes text .......................................................306
  Selecting text ......................................................................306
  Applying a text format ....................................................306
  Inserting geometric shape symbols ................................306
  Entering and evaluating expressions ................................307
  Entering an expression ....................................................307
  Evaluating an expression .................................................307
### Working with TI-Nspire™ libraries

- What is a library? ................................................................. 309
- Creating libraries and library objects ................................. 310
- Private and Public library objects ...................................... 310
  - Using short and long names ............................................. 311
- Using library objects .......................................................... 311
  - Using a public library object ......................................... 312
  - Using a private library object ....................................... 312
- Included libraries ............................................................ 312

### Programming

- Overview of the Program Editor ......................................... 313
- The Program Editor menu .................................................. 314
- Defining a program or function ........................................... 317
  - Starting a new Program Editor ....................................... 317
- Entering lines into a function or program .............................. 318
- Inserting comments ......................................................... 319
- Checking syntax .............................................................. 320
- Storing the function or program ........................................ 320
- Viewing an existing program or function .............................. 320
- Opening an existing function or program .............................. 321
- Importing a program from a library ..................................... 322
- Creating a copy of a function or program ............................. 322
- Renaming a program or function ........................................ 323
- Changing the library access level ....................................... 323
- Finding text .......................................................................... 324
- Closing the current function or program .............................. 324
- Running programs and evaluating functions .......................... 324
  - Using short and long names ............................................. 324
  - Using a Public library function or program ...................... 325
  - Using a Private library function or program ...................... 325
  - Running a non-library program or function ...................... 326
- Getting values into a program ............................................. 326
  - Example of passing values to a program ......................... 327
- Displaying information ..................................................... 328
- Using local variables ......................................................... 328
  - Example of a local variable ............................................. 328
  - What causes an undefined variable error message? .......... 329
  - You must initialize local variables ................................ 329
- Differences between functions and programs ....................... 329
- Calling one program from another ...................................... 330
  - Calling a separate program ............................................ 330
  - Defining and calling an internal subroutine ...................... 330
  - Notes about using subroutines ....................................... 331
  - Avoiding circular-definition errors ................................. 331
Controlling the flow of a function or program ........................................332
Using If, Lbl, and Goto to control program flow ....................................332
   If Command ........................................................................332
   If...Then...EndIf structures .............................................333
   If...Then...Else... EndIf structures ..................................333
   If...Then...ElseIf... EndIf structures ..............................334
   Lbl and Goto commands ...............................................334
Using loops to repeat a group of commands .........................................335
   For...EndFor loops ....................................................335
   While...EndWhile loops ..............................................336
   Loop...EndLoop loops .................................................337
   Repeating a loop immediately .......................................338
   Lbl and Goto loops ....................................................338
Changing mode settings ....................................................................338
   Setting a mode ............................................................338
Debugging programs and handling errors .............................................339
   Techniques for debugging .............................................339
   Error-handling commands ...........................................339

Data Collection .................................................................................341
   Compatible sensors .....................................................341
   Experimental data ......................................................341
   Starting the Data Collection tool ....................................342
      Automatic start mode ...............................................342
      Manually starting the Data Collection tool .................343
   Data Collection controls ............................................344
   Running an experiment and collecting data ..................345
   Data Collection names ................................................347
   Storing collected data ................................................347
      To save temperature data .........................................347
      To save motion data ................................................347
   Retrieving stored experimental results .......................350
   Troubleshooting the Data Collection tool ....................350

Appendix: Service and Support .........................................................353
   Texas Instruments Support and Service .........................353
      For general information ...........................................353
      Service and warranty information ..........................353

Index .................................................................................................355
Introduction

The TI-Nspire™ computer software for math and science

This guidebook provides information about powerful, advanced software from Texas Instruments: the TI-Nspire™ computer software for math and science.

How to use this guidebook

This guidebook is intended to provide instruction for the basic operation of the TI-Nspire™ computer software for math and science.

The chapters in this guidebook include:

Getting Started - Provides start up information and offers students and educators an overview of the basic operations of the TI-Nspire™ computer software.

Working with Documents - Provides instruction for creating and working with documents.

Using Calculator - Provides an overview of the Calculator application.

Using Graphs & Geometry - Provides an overview of the Graphs & Geometry application.

Using Lists & Spreadsheet - Provides an overview of the Lists & Spreadsheet application.

Using Data & Statistics - Provides instruction for using the Data & Statistics application to analyze data created in other applications.

Using Notes - Provides an overview of the Notes application.

Data Collection - Provides an overview of the Data Collection tool.

Using Libraries - Provides instruction for creating and using Libraries.

Using Program Editor - Provides instruction for creating and modifying Programs using the Program Editor.

Service and Warranty Information - Includes service and warranty information and contact information for technical support.
The TI-Nspire™ computer software Home Screen

The TI-Nspire™ computer software home screen provides all the tools you need to create documents and work with problems. The example below illustrates the home screen with its main parts labeled. Following the home screen, you can find detailed descriptions of each labeled part.

1. **Menu bar** - provides tools for working with documents and modifying system settings.
2. **Tool bar** - provides quick access to tools for working with documents.
3. **Page Sorter** - provides a thumbnail view of each page in the document.
# Using menus

Menus provide the options you need to create and edit documents and problems. You can also use these menus to modify system settings.

## Menu Options

The following table lists the options available under each menu, what the option does, and a shortcut key or alternate access method, if one exists. As you work with the TI-Nspire™ computer software, note that all menu options may not always be available, depending upon what you are doing.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Purpose</th>
<th>Shortcut; Alternate</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>New Document</td>
<td>Creates a new document in the work area.</td>
<td>Ctrl + N; tool bar icon</td>
</tr>
<tr>
<td></td>
<td>Open Document</td>
<td>Displays a file browser window to let you select an existing document to open.</td>
<td>Ctrl + O; tool bar icon</td>
</tr>
<tr>
<td></td>
<td>Close</td>
<td>Closes the document and prompts you to save.</td>
<td>Ctrl + W</td>
</tr>
<tr>
<td>Save Document</td>
<td>Save Document</td>
<td>Saves the document currently in the work area.</td>
<td>Ctrl + S; tool bar icon</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the current document in a new folder and/or under a new name.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Print</td>
<td>Prints the current document.</td>
<td>Ctrl + P; tool bar icon</td>
</tr>
<tr>
<td>Change Language</td>
<td>Opens a dialog box that allows you to change the language settings.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document Settings</td>
<td>Opens a dialog box that allows you to modify the document settings and apply them to the entire system, if desired.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu Name</td>
<td>Menu Option</td>
<td>Purpose</td>
<td>Shortcut; Alternate</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>---------</td>
<td>---------------------</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td></td>
<td>Closes all applications and prompts to save the currently active document.</td>
<td>Alt + F4</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Undo</td>
<td>Removes your latest action and displays the work area as it was before the action.</td>
<td>Ctrl + Z; tool icon</td>
</tr>
<tr>
<td></td>
<td>Redo</td>
<td>Re-applies the latest action that the Undo command removed.</td>
<td>Ctrl + Y; tool icon</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>Removes a selected portion of information from the work area.</td>
<td>Ctrl + X; tool bar icon</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Makes a copy of a selected portion of the information in the work area.</td>
<td>Ctrl + C; tool bar icon</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>Inserts information, either cut or copied, at a designated location in the work area.</td>
<td>Ctrl + V; tool bar icon</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Removes the selected application from the current page.</td>
<td>Tool Bar icon</td>
</tr>
<tr>
<td></td>
<td>Select Application</td>
<td>Selects the application (border is highlighted to indicate that the application is selected)</td>
<td>Ctrl + K</td>
</tr>
<tr>
<td></td>
<td>Swap Application</td>
<td>Swaps the location of the selected application with the current application.</td>
<td></td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Layout ▼</td>
<td>Enables you to select one of eight layouts for your page.</td>
<td>Application Tool Bar Menu</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Menu Option</td>
<td>Purpose</td>
<td>Shortcut; Alternate</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td></td>
<td><strong>TI-Nspire™ Handheld View</strong></td>
<td>Displays the work area as it would appear on the handheld.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Presentation View</strong></td>
<td>Removes the Page Sorter from the display and displays pages at full size.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Keypad</strong></td>
<td>Displays the TI-Nspire™ keypad</td>
<td>Tool Bar icon</td>
</tr>
<tr>
<td></td>
<td><strong>Collapse All</strong></td>
<td>Collapses all pages in the Page Sorter so that only the problems are listed for the open document.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Expand All</strong></td>
<td>Expands the problems in the Page Sorter so that all pages of all problems are listed.</td>
<td></td>
</tr>
<tr>
<td><strong>Insert</strong></td>
<td><strong>Problem</strong></td>
<td>Adds a new problem to the current document.</td>
<td>Tool Bar Insert Menu</td>
</tr>
<tr>
<td></td>
<td><strong>Page</strong></td>
<td>Adds a new page to the current problem.</td>
<td>Tool Bar Insert Menu</td>
</tr>
<tr>
<td></td>
<td><strong>Calculator</strong></td>
<td>Adds the Calculator application to the selected page.</td>
<td>Tool Bar Insert Menu</td>
</tr>
<tr>
<td></td>
<td><strong>Graphs &amp; Geometry</strong></td>
<td>Adds the Graphs &amp; Geometry application to the selected page.</td>
<td>Tool Bar Insert Menu</td>
</tr>
<tr>
<td></td>
<td><strong>Lists &amp; Spreadsheet</strong></td>
<td>Adds the Lists &amp; Spreadsheet application to the selected page.</td>
<td>Tool Bar Insert Menu</td>
</tr>
<tr>
<td></td>
<td><strong>Notes</strong></td>
<td>Adds the Notes application to the selected page.</td>
<td>Tool Bar Insert Menu</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Menu Option</td>
<td>Purpose</td>
<td>Shortcut; Alternate</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Data &amp; Statistics</td>
<td>Adds the Data &amp; Statistics application to the selected page.</td>
<td>Tool Bar Insert Menu</td>
<td></td>
</tr>
<tr>
<td>Program Editor</td>
<td>Allows you to create, view, open or import a program.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tools</td>
<td>Variables</td>
<td>Displays variables available for use in the current problem.</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td></td>
<td>Catalog</td>
<td>Displays the catalog.</td>
<td>Tool Bar icon</td>
</tr>
<tr>
<td></td>
<td>Symbols</td>
<td>Displays the symbol palette.</td>
<td>Tool Bar icon</td>
</tr>
<tr>
<td></td>
<td>Math Templates</td>
<td>Displays the math templates palette.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Refresh Libraries</td>
<td>Refreshes the list of libraries that have been stored and whose library documents have been saved.</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>TI-Nspire™ Help</td>
<td>Provides online help information for this software.</td>
<td>F1</td>
</tr>
<tr>
<td></td>
<td>Activate...</td>
<td>Allows you to activate your software if you are using a trial copy. This option is only available when using a trial version of the TI-Nspire™ computer software.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>About</td>
<td>Displays information about the TI-Nspire™ product.</td>
<td></td>
</tr>
</tbody>
</table>
Using tool bars

The TI-Nspire™ computer software tool bars provide shortcuts to the most frequently used menu options. When you move your cursor slowly over a tool icon, a brief text description of it displays on the screen.

Tool bar contents

The following table lists the tools available on the tool bar. These tools provide document-level operations. As you add applications to pages in your document, you will see that each application has its own tool bar, providing functions unique to that application. Application-specific tools are discussed in each application chapter.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
<th>Alternate Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Icon]</td>
<td>New Document - Creates a new document. If another document is open, you are asked if you want to save it before starting a new document.</td>
<td>File Menu - New Document; Ctrl + N</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Open Document - Displays a file browser window to let you select an existing document to open.</td>
<td>File Menu - Open Document; Ctrl + O</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Save - Saves the document currently active in your work area.</td>
<td>File Menu - Save Document; Ctrl + S</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Print - Opens the Print dialog box and enables you to print one or more pages in the open document.</td>
<td>File Menu - Print; Ctrl + P</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Undo - removes the outcome of your last action.</td>
<td>Edit Menu - Undo; Ctrl + Z</td>
</tr>
<tr>
<td>![Folder Icon]</td>
<td>Redo - re-applies the action undone by the Undo command. Redo is not available unless you first perform an Undo command.</td>
<td>Edit Menu - Redo; Ctrl + Y</td>
</tr>
<tr>
<td>Tool</td>
<td>Description</td>
<td>Alternate Access</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>![Scissors]</td>
<td><strong>Cut</strong> - removes the selected text or objects on the active page that you want removed.</td>
<td>Edit Menu - Cut; Ctrl + X</td>
</tr>
<tr>
<td>![Clipboard]</td>
<td><strong>Copy</strong> - makes an exact copy of the selected text or objects on the active page that you want to replicate.</td>
<td>Edit Menu - Copy; Ctrl + C</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>Paste</strong> - pastes the text or objects previously cut or copied onto a selected page.</td>
<td>Edit Menu - Paste; Ctrl + V</td>
</tr>
<tr>
<td>![Delete]</td>
<td><strong>Delete</strong> - removes the selected item.</td>
<td>Edit Menu - Delete page</td>
</tr>
<tr>
<td>![Page Layout]</td>
<td><strong>Page Layout</strong> - provides a choice of eight different page layouts.</td>
<td>View Menu - Layout</td>
</tr>
<tr>
<td>![Insert]</td>
<td><strong>Insert</strong> - allows you to insert a problem space, page, or add applications to the current page.</td>
<td>Insert Menu</td>
</tr>
<tr>
<td>![Keypad]</td>
<td>View a floating handheld keypad - the keypad can be used to manipulate objects and perform calculations, in the same way as the handheld keypad.</td>
<td></td>
</tr>
<tr>
<td>![Variable]</td>
<td><strong>Variable/Linking</strong> - allows you to link a variable to another page in the current problem.</td>
<td></td>
</tr>
<tr>
<td>![Catalog]</td>
<td><strong>Catalog</strong> - allows you to insert command and functions, units, symbols and expression templates.</td>
<td></td>
</tr>
<tr>
<td>![Symbol Palette]</td>
<td><strong>Symbol Palette</strong> - allows you to insert symbols.</td>
<td></td>
</tr>
<tr>
<td>![Template Palette]</td>
<td><strong>Template Palette</strong> - allows you to insert expression templates.</td>
<td></td>
</tr>
</tbody>
</table>
The Page Sorter

The Page Sorter is the area on the left side of the screen. It displays thumbnail views of all pages in the document. Use the Page Sorter to move to different pages in your document, and to quickly move and rearrange pages.

- **Page Sorter** - displays thumbnail sketches of all pages in all problems in the current document. Use the scroll bar to view pages off the screen.

- **Active page** - this is the page currently highlighted in the navigation pane and active in the work area.

- **Problem/Page counter** - displays the problem number followed by the page number.

---

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
<th>Alternate Access</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh Libraries icon" /></td>
<td>Refresh Libraries - updates the list of libraries that have been stored and whose library documents have been saved.</td>
<td></td>
</tr>
</tbody>
</table>
**Using the Work Area**

The work area displays the active page in the document. You can add one or more applications to the page.

**Multiple work areas on one page**

You can divide each page into as many as four work areas. This allows you to use multiple applications on a page. The example below illustrates a page that has been divided into three work areas.
When you have multiple work areas on a page, the tool bar for the application in use displays as the application tool bar.

**Creating multiple work areas**

1. Click **Page Layout** to display the page layout menu.
2. Move the cursor to highlight the layout you wish to add to the page, and click to select it.

   The page displays the new layout.

**Adding an application to a page**

When you first open a new document, or add a new page to a document, you can click the center of the page to display the application menu, and select an application to add to the page.

If you are working with an application on a page, and want to add another one, you must change the page layout to one that accommodates multiple work areas.

![Application tool bar and Problem/Page counter](image)

1. **Application tool bar** - This area contains the tools and tool menus specific to the application active on the page.
2. **Problem/Page counter** - The first value represents the problem number of your active page, while the second value tells you the page number within the problem. For the example above, the counter reads 1.1, the first page of the first problem in the document.
Repositioning (swapping) applications on a page

If you want to change the position of applications on a page with multiple applications, you can do so by "swapping" the positions of two applications.

1. Select Swap Application from the Edit menu.

   **Note:** The last active application you worked on is automatically selected as the first application to be swapped.

2. Click on the second application to be swapped. The swap is done when the second application is selected.

   **Note:** When there are only two work areas, the selected application automatically swaps position with the other application on the work area.

To cancel a swap, press Esc. Press Ctrl Tab to cancel the swap and shift focus to the next app in the page layout.

Deleting pages or applications

You can delete an entire page or remove an application from a work area using the delete tools on the tool bar.

**Deleting a page**

1. Select the page you want to delete.

2. Select **Edit** > **Delete** or click the Delete icon, ![x](image).

**Deleting an application from a page**

1. Click the application you want to delete.

2. Select either **Edit** > **Select Application** or press **Ctrl + K**.

   The selected application blinks on the page.

3. Click ![x](image) or select **Edit** > **Delete**.

**The TI-Nspire™ Keypad**

The TI-Nspire™ computer software allows you to display and use a virtual keypad, which directly mimics the behavior of the handheld keyboard. Use the keypad to enter expressions and perform calculations with the desktop software, just as you do with the handheld.
**Note:** Many of the procedures in this guidebook include pressing handheld keys. Some of these keys are available on your computer keyboard, but if you display and use the keypad, you will have access to much of the functionality and shortcuts available on the handheld keyboard.

**Using the TI-Nspire™ keypad**

1. To display the keypad, select **View > Keypad** or click ![Keypad icon]. The keypad displays.

![Keypad](image)

**Language Settings**

You specify the language for the software to display when you install it. If you want to change the language settings, you may do so at any time.

**Changing the Language:**

1. Select **File > Change Language**.
   
The Choose a Language dialog box displays.
2. Use the dropdown menu to select the desired language. You must restart the application for the language change to take effect.

3. Click **Quit Now** to apply your change. If you have made changes to the current document, you will be prompted to save it.

4. To restart the software, select **Start > Programs > TI Tools > TI-Nspire** or click the TI-Nspire™ icon on your desktop.

**Document Settings**

You can change document settings to meet your needs for a specific set of problems. Document settings apply to the document you are working in, and can also be applied as the default settings for the system. When you customize these settings, the new options become the default settings for your work. These can be set using the TI-Nspire™ computer software and transmitted to a handheld when the handheld is connected to the computer.

**Document Settings Options**

The following table lists the document settings and their possible values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Digits</td>
<td>Float, Float1 - Float12, Fix0 - Fix12</td>
</tr>
<tr>
<td>Angle</td>
<td>Radian, Degree, Gradian</td>
</tr>
<tr>
<td>Exponential Format</td>
<td>Normal, Scientific, Engineering</td>
</tr>
<tr>
<td>Real or Complex Format</td>
<td>Real, Rectangular, Polar</td>
</tr>
</tbody>
</table>
Customizing document settings

1. Select **File > Document Settings**.

   The Document Settings window displays.

2. Use the dropdown menus to view and select the desired option for each category.

3. When you have modified the settings to suit your needs, click **OK** to save the changes and close the window.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto or Approximate</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>Exact</td>
</tr>
<tr>
<td></td>
<td>Approximate</td>
</tr>
<tr>
<td>Vector Format</td>
<td>Rectangular</td>
</tr>
<tr>
<td></td>
<td>Cylindrical</td>
</tr>
<tr>
<td></td>
<td>Spherical</td>
</tr>
<tr>
<td>Base</td>
<td>Decimal</td>
</tr>
<tr>
<td></td>
<td>Hex</td>
</tr>
<tr>
<td></td>
<td>Binary</td>
</tr>
<tr>
<td>Unit System</td>
<td>SI</td>
</tr>
<tr>
<td></td>
<td>Eng/US</td>
</tr>
</tbody>
</table>
Applying document settings to the system

- Click **Apply to System** to apply the document settings to the entire system. A prompt displays, asking you to verify that this is what you want to do.

![Apply to System dialog](image)

Using the catalog

Use the catalog to insert commands and functions, units, symbols and expression templates into your problems. The catalog window uses five tabs to categorize commands, special characters and templates:

1. Contains all commands and functions, in alphabetical order
2. Contains all math functions
3. Provides a symbol palette for adding special characters.
4. Contains math templates for creating two dimensional objects, including product, sum, square root and integral.
5. Shows Public library (LibPub) objects.
Open the catalog

1. Press \( \text{\textcopyright} \) on the keypad to open the catalog.

2. Select the tab that contains the function, symbol or expression you want to insert into your problem.

3. Use the scroll bar or down arrow to display the item, and click to select it.

4. Press \( \text{\textcopyright} \) or double-click to insert the item.

Note: Some functions have a wizard to help you enter function arguments. If you prefer to enter the argument values directly on the entry line, you may need to click the wizard icon to disable it.
**Entering special characters or templates**

There are two icons on the tool bar that give you quick access to symbols and templates:

- The first icon provides a symbol palette for adding special characters.

- The second icon contains math templates for creating two dimensional objects, including square root, integral, and product sum.

1. To access one of the palettes, click the desired icon to open the palette.
2. Use the scrollbar, arrow keys, or mouse click to highlight the item.
3. Press **Enter** or double-click to insert the item.
Changing the desktop view

The TI-Nspire™ computer software allows you to change the display to meet specific needs.

To change the desktop view:

- Click View on the tool menu and select TI-Nspire™ Handheld View or Presentation view.

TI-Nspire™ Handheld View

The Handheld View allows you to preview documents as they will appear on the handheld.
**Presentation View**

The Presentation View displays pages without the navigation pane. This view is useful when displaying documents with a digital projector.
Working with Documents

All work that you create and save with the TI-Nspire™ computer software is stored as a document. A document consists of one or more problems. Each problem contains one or more pages. A single page displays in the work area on your screen. All work occurs on pages.

Note: A TI-Nspire™ math and science learning technology document can contain up to 30 problems, and each problem can contain a maximum of 50 pages.

Creating a new document

When you first open the TI-Nspire™ computer software, a blank document with one problem opens automatically. A blank page displays on the work area of the desktop. You can add applications and content to this page to create a document.

You can create a new document at any time using the following steps.

- Select File > New or click .
  The new document opens in the work area and displays a blank page.
Adding an application to a page

To add an application to a page:

1. Select the Insert menu or click Insert to display the application list.
2. Click to select the application you want to add to the page. The application displays on the page, with a toolbar specific to that application.

Adding multiple applications to a page

By default, each page contains space to add one application. If you need to add more than one application to a page, you can change the layout to accommodate as many as four applications.

1. Select the View Menu and then select Layout, or click \( \text{Page Layout} \) to display the page layout menu.
2. Highlight the layout you wish to add to the page, and click to select it.

The page displays the new layout. You can add an application to each of the new work areas on the page.
Adding a problem to a document

A document can contain as many as 30 problems. To add a new problem to a document:

- Select the Insert Menu and then select Problem, or click and select **Problem**.

A new problem and one new page are added to your document.

Adding a page to a problem

Each problem can contain up to 50 pages. There are three ways to add a new page to a problem.

- Click **Insert** and select **Page**.
  
  A new page displays. Select an application to add to the page.
  
  -- or --

- Select the Insert Menu and then select **Page**.
  
  A new page displays. Select an application to add to the page.
  
  -- or --

- Press **Ctrl + I**.
  
  A new page displays. Select an application to add to the page.
Using the Page Sorter

The Page Sorter is the area on the left side of the screen. It displays thumbnail views of all pages in the document. Use the Page Sorter to move to different pages in your document, and to quickly move and rearrange pages.

1. **Page Sorter** - displays thumbnail sketches of all pages in all problems in the current document. Use the scroll bar to view pages off the screen.

2. **Active page** - this is the page currently highlighted in the Page Sorter and active in the work area.

3. **Problem/Page counter** - displays the problem number followed by the page number.

Selecting pages in the Page Sorter

The Page Sorter always indicates the active page in the work area.

- If you are working on a page in the work area, this page is indicated in the page sorter by a bold black border.
- If you are actively using the Page Sorter, the active page displayed in the work area has a blue border in the Page Sorter pane.

Clicking on any page in the Page Sorter makes it the active page, and it displays in the work area.

Rearranging pages in the Page Sorter

Use the Page Sorter to change the order of pages within a problem.

1. Click to select the thumbnail view of the page in the Page Sorter.
2. Hold down the mouse button and drag the page to the desired position, and release to drop it in the new location.

**Saving documents**

To save a new document:

1. Select **File > Save As...** , or press .

   The Save TI-Nspire™ Document dialog opens. The default location for saving documents is My Documents/TI-Nspire.

2. Select (or create) a folder in which to store the document.

3. Type a name for the new document.

4. Click **OK** to save the document.

   Documents are saved with the extension .tns.

**Saving a document with a new name**

You can save a document in a new folder and/or with a new name. To do this:

1. Select **File > Save As...** .

   The Save As ... dialog opens. Select (or create) a folder in which to store the document.

2. Type a new name for the document.
3. Click **OK** to save the document with a new name.

**Printing documents**

If your computer is connected to a printer, you can print the contents of an open document. To access the print dialog, do one of the following:

- Select **File > Print**.
- Press **Ctrl + P**.

You can also click the Printer icon in the tool bar. This immediately prints the contents of the page displayed in the work area.

The Print dialog enables you to select:

- a range of problems to be printed, including all problems in the document.
- the number of copies to be printed.
- the size of the paper in your printer. The default is Letter in the US and A4 in Europe.
- the orientation of the printout: portrait or landscape. Landscape is the default option.
- page scaling, if desired. The default is **None**. The printer fits the visible page on the printout, but some cropping may occur. The second option, **Print Screen**, prints what is visible on the TI-Nspire™ card.
- the ability to preview what the printout will look like by clicking the Print Preview button.

Once you have selected the print job parameters, select **Print**.

**Note**: If you do not change any print settings, the entire document is printed, not just the page displayed in the work area.
Using Print Preview

This option enables you to see how your document printout will appear before you enter a print request. You can move from page-to-page in this view to review the entire range of pages in your print request.

Linking values on pages

Variable linking is a powerful tool for building and exploring mathematical models. Values and functions created or defined in one application can interact with other TI-Nspire™ computer software for math and science applications to share data. (The relationship between Graphs & Geometry and Data Collection is a special one and is discussed in the Data Collection chapter.)

There are a few features to keep in mind when using linked items:

- Values can be linked between applications on one page or between different pages of the same problem.
- Since all applications are linked to the same actual data, if you delete it from any application, all references to the data are lost.
- If the linked value is changed in the original application, the change is reflected in all linked usages.

Each application allows you to define a value or function as a variable. Defining a variable is the first step in linking values.
Creating TI-Nspire™ variables

Variables can be any portion or attribute of an object or function created within an application. Examples of attributes that can become variables are the area of a rectangle, the radius of a circle, the value contained in a spreadsheet cell or the contents of a row or column, or a function expression. When you create a variable, it is stored in memory.

Types of variables

You can store the following data types as variables:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>2.54  1.25e6   2\pi  xmin/10  2+3i  (x−2)^2  \sqrt{2}/2</td>
</tr>
<tr>
<td>List</td>
<td>{2, 4, 6, 8}  {1, 1, 2}</td>
</tr>
</tbody>
</table>
| Matrix             | \[
|                   | 1  2  3  \\
|                   | 3  6  9
|                   | This can be entered as: [1,2,3;3,6,9]         |
| Character string   | “Hello”   “xmin/10”   “The answer is:”       |
| Function           | myfunc( arg )  ellipse( x, y, r1, r2 )         |
| Measurement        | area, perimeter, length, slope, angle         |

Creating a variable from a Graphs & Geometry value

1. Click to select the value to store as a variable.

2. Do one of the following:

   - From the TI-Nspire™ tool bar, select the Variables tool (\text{\text{\texttt{\textbf{\textcolor{red}{\texttt{var}}}}}}). The Variables options are displayed with Store highlighted.
   - Press \text{\text{\texttt{Ctrl + L}}} to display the Variables options. Store is highlighted.
   - Select the Tools Menu and select the Variables option. The Variables options are displayed with Store highlighted.
3. Press **Enter**. **VAR :=** appears before the selected value.
   This is the default variable name. Type over **VAR** with the variable name you want to give the value.

4. When the variable name is typed, press **Enter**.
   The value is saved to that variable name, and the stored value or its name appears in bold text to indicate it is a stored value.

---

**Creating a variable from a Lists & Spreadsheet cell value**

You can share a cell value with other applications. When defining or referring to a shared cell in Lists & Spreadsheet, you precede the name with an apostrophe (‘).

1. Click the cell that you want to share.
2. Press **VAR**.
A formula is inserted into the cell with var as a placeholder for a variable name.

3. Replace the letters "var" with a name for the variable, and press \( \text{·} \).

The value is now available as a variable to other applications within the same problem.

**Note:** If a variable with the name you specified already exists in the current problem space, Lists & Spreadsheet displays an error message.

**Creating Calculator variables**

As alternatives to using \( \text{\textasciitilde} \text{\textasciitilde} \), you can use " := " or the Define command. All of the following statements are equivalent.

\[
5+8^3 \rightarrow \text{num} \\
\text{num} := 5+8^3 \\
\text{Define} \text{num} = 5+8^3
\]

**Special considerations for variables**

**Rules for naming variables**

Variable and function names that you create must meet the following naming rules.

**Note:** Avoid defining variables that use the same names as those used for statistical analysis. In some cases, an error condition could occur. Variable names used for statistical analysis are listed in the Appendix of Functions, under the StatMatrix entry.

- You can use 1 to 16 characters consisting of letters, digits, and the underscore character (\_). Letters can be U.S. or Greek letters (but not \( \Pi \) or \( \pi \)), accented letters, and international letters.
- You can use uppercase or lowercase letters. The names \( AB22, \text{Ab22}, \text{aB22}, \text{ab22} \) all refer to the same variable.
- The first character cannot be a digit.
- Do not use spaces.
- If you use an underscore as the first character, the variable is considered a type of unit, such as \( _m, _\text{ft}, \text{and } _\text{in} \). Units do not allow subsequent underscores in the name.
- You cannot use a preassigned variable or function name, such as \( \text{ans} \) or \( \text{min} \).

**Note:** For a complete list of TI-Nspire™ functions, refer to the TI-Nspire™ Reference Guide.
Here are some examples:

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Valid?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Myvar</td>
<td>Yes</td>
</tr>
<tr>
<td>My var</td>
<td>No. Contains a space.</td>
</tr>
<tr>
<td>a</td>
<td>Yes</td>
</tr>
<tr>
<td>Log</td>
<td>No. Name is preassigned to the \texttt{log( )} function.</td>
</tr>
<tr>
<td>Log1</td>
<td>Yes</td>
</tr>
<tr>
<td>3rdTotal</td>
<td>No. Starts with a digit.</td>
</tr>
</tbody>
</table>

**Preventing name conflicts**

A TI-Nspire™ shared variable can have the same name as a table cell or column letter. To help you prevent name conflicts in your table formulas, Lists & Spreadsheet provides syntax rules.

- To refer to a variable whose name could conflict with the name of a cell (such as A1), precede the variable name with an apostrophe (‘A1).
- To refer to a table column (such as A) without conflicting with a single-letter variable name $A$, follow the column letter with a pair of brackets ($A[]$).

<table>
<thead>
<tr>
<th>Use this syntax:</th>
<th>To refer to:</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>myvar</td>
<td>The shared variable \texttt{myvar}.</td>
<td>No special syntax is needed, because this name does not conflict with a cell or column reference.</td>
</tr>
<tr>
<td>A1</td>
<td>The table cell at column A, row 1.</td>
<td>This syntax always refers to table cell A1—never to variable $A1$.</td>
</tr>
<tr>
<td>A</td>
<td>The shared variable $A$.</td>
<td>This syntax never refers to column A.</td>
</tr>
<tr>
<td>A[]</td>
<td>Column A of the current table.</td>
<td>Brackets make this a reference to column A—never to variable $A$.</td>
</tr>
</tbody>
</table>
Checking a variable’s value using the Calculator application

You can check the value of an existing variable by entering its name on the Calculator entry line.

▶ On the Calculator entry line, type the variable name `num` and press Enter.

The value most recently stored in `num` displays as the result.

| num | 517 |

Using (linking) TI-Nspire™ variables

Sharing, or linking, the variables you create is a powerful tool for math exploration. The display of linked variables is automatically updated when the variable’s value changes.

In the following two examples, two data lists were created in Lists & Spreadsheet and then plotted in Graphs & Geometry.

When the values are altered in Lists & Spreadsheet, they are automatically updated in Graphs & Geometry.
Linking to shared variables

To use a stored variable:

1. Display the page and select the location or object to which you want to link to a variable.

2. Do one of the following:
   
   - From the TI-Nspire™ tool bar, select the Variables tool (\(\text{var}\)). The Variables options are displayed with Store highlighted.
   
   - Press \textbf{Ctrl + L} to display the Variables options. Store is highlighted.
   
   - Select the Tools Menu and select the Variables option. The Variables options are displayed with Store highlighted.

3. Use \(\uparrow\) and \(\downarrow\) to scroll the list, or type part of the variable name.
   
   As you type, the TI-Nspire™ system displays a list of variables that begin with the letters you typed. Typing part of the name enables you to locate a variable more quickly if the list is long.
4. When you locate and highlight the name of the variable you want to use, click the name or press **Enter**.

   The selected variable value is linked.

**Linking a Lists & Spreadsheet cell to a variable**

When you link a cell to a variable, Lists & Spreadsheet keeps the cell value updated to reflect the current value of the variable. The variable can be any variable in the current problem and can be defined in Graphs & Geometry, Calculator, or any instance of Lists & Spreadsheet.

**Note:** Do not link to a system variable. Doing so could prevent the variable from being updated by the system. System variables include `ans`, `StatMatrix`, and statistics results (such as `RegEqn`, `dfError`, and `Resid`).

1. Click the cell that you want to link to the variable.

2. Click **var**, and click **Cell**.

   The VarLink menu displays.

3. Under **Link To**, scroll to the name of the variable and click it.

   The cell shows the value of the variable.
**Removing a linked variable**

To remove a linked variable from a page:

1. Select the linked variable.
2. Do one of the following:
   - From the TI-Nspire™ tool bar, select the Variables tool (\(\text{var}\)).
   - Press **Ctrl + L** to display the Variables options.
   - Select the Tools Menu and select the Variables option.

   The Variables options are displayed.

3. Select **Unlink**.

   The link is removed from the value, and the value displays without any bolding.
Using Calculator

Getting started with the Calculator application

The Calculator application gives you a place to enter and evaluate math expressions. You can also use it to define variables, functions, and programs. When you define or edit a variable, function, or program, it becomes available to any TI-Nspire™ math and science learning technology application—such as Graphs & Geometry—that resides in the same problem.

You can also use Calculator to define library objects, such as variables, functions, and programs, which are accessible from any problem of any document. For information on creating library objects, see the “Libraries” section of the documentation.

Define \( \text{cube}(n) = n^3 \)

Done

\( f_1(x) = \text{cube}(x) \)

\( f_2(x) = \)
1. Calculator menu – This menu is available anytime you are in the Calculator work area. The menu in this screen snapshot may not exactly match the menu on your screen.

2. Calculator work area
   - You enter a math expression on the entry line and then press Enter to evaluate the expression.
   - Expressions display in standard mathematical notation as you enter them.
   - Entered expressions and results show in the Calculator history.

3. Example of Calculator variables used in another TI-Nspire™ application

The Calculator tool menu
The Calculator tool menu lets you enter and evaluate a variety of math expressions.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Define</td>
<td>Inserts the Define command.</td>
</tr>
<tr>
<td></td>
<td>Recall Definition</td>
<td>Lets you view, reuse, or modify a function or program that you have defined.</td>
</tr>
<tr>
<td></td>
<td>Delete Variable</td>
<td>Inserts the delVar command.</td>
</tr>
<tr>
<td></td>
<td>Clear a-z</td>
<td>Deletes all variables with single-letter names.</td>
</tr>
<tr>
<td></td>
<td>Clear History</td>
<td>Deletes all expressions in the Calculator history.</td>
</tr>
<tr>
<td></td>
<td>Insert Comment</td>
<td>Lets you insert text.</td>
</tr>
<tr>
<td></td>
<td>Library</td>
<td>Lets you refresh all libraries, set LibPub or LibPriv access, or insert a “\” character</td>
</tr>
<tr>
<td>Number</td>
<td>Convert to Decimal</td>
<td>Inserts ▶Decimal command.</td>
</tr>
<tr>
<td></td>
<td>Factor</td>
<td>Inserts factor().</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Menu Option</td>
<td>Function</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>Least Common Multiple</td>
<td>Inserts \texttt{lcm}().</td>
<td></td>
</tr>
<tr>
<td>Greatest Common Divisor</td>
<td>Inserts \texttt{gcd}() function.</td>
<td></td>
</tr>
<tr>
<td>Remainder</td>
<td>Inserts \texttt{remain}().</td>
<td></td>
</tr>
<tr>
<td>Fraction Tools</td>
<td>Lets you select \texttt{propFrac}, \texttt{getNum}, \texttt{getDenom}.</td>
<td></td>
</tr>
<tr>
<td>Number Tools</td>
<td>Lets you select \texttt{round}, \texttt{iPart}, \texttt{fPart}, \texttt{sign}, \texttt{mod}, \texttt{floor}, or \texttt{ceiling}.</td>
<td></td>
</tr>
</tbody>
</table>

**Complex**

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Complex Conjugate</td>
<td>Inserts \texttt{conj}.</td>
</tr>
<tr>
<td></td>
<td>Real Part</td>
<td>Inserts \texttt{real}.</td>
</tr>
<tr>
<td></td>
<td>Imaginary Part</td>
<td>Inserts \texttt{imag}.</td>
</tr>
<tr>
<td></td>
<td>Polar Angle</td>
<td>Inserts \texttt{angle}.</td>
</tr>
<tr>
<td></td>
<td>Magnitude</td>
<td>Inserts the absolute value template.</td>
</tr>
<tr>
<td></td>
<td>Convert to Polar</td>
<td>Inserts \texttt{Polar} command.</td>
</tr>
<tr>
<td></td>
<td>Convert to Rectangular</td>
<td>Inserts \texttt{Rect} command.</td>
</tr>
</tbody>
</table>

**Calculations**

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Numerical Solve</td>
<td>Inserts \texttt{nSolve}.</td>
</tr>
<tr>
<td></td>
<td>Numerical Function Minimum</td>
<td>Inserts \texttt{nfMin}.</td>
</tr>
<tr>
<td></td>
<td>Numerical Function Maximum</td>
<td>Inserts \texttt{nfMax}.</td>
</tr>
<tr>
<td></td>
<td>Numerical Derivative</td>
<td>Inserts \texttt{nDeriv}.</td>
</tr>
<tr>
<td></td>
<td>Numerical Integral</td>
<td>Inserts \texttt{nInt}.</td>
</tr>
<tr>
<td></td>
<td>Finance Solver</td>
<td>Starts the Finance Solver.</td>
</tr>
</tbody>
</table>

**Probability**

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Factorial (!)</td>
<td>Inserts !.</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Menu Option</td>
<td>Function</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Permutations</td>
<td>Inserts $nPr()$.</td>
<td></td>
</tr>
<tr>
<td>Combinations</td>
<td>Inserts $nCr()$.</td>
<td></td>
</tr>
<tr>
<td>Random</td>
<td>Lets you select $rand()$, $randInt()$, $randBin()$, $randNorm()$, $randSamp()$, or $RandSeed$.</td>
<td></td>
</tr>
<tr>
<td>Distributions</td>
<td>Lets you select from several distributions, such as $Normal Pdf$, $Binomial Cdf$, and $Inverse F$.</td>
<td></td>
</tr>
</tbody>
</table>

### Statistics

<p>| Stat Calculations | Lets you select from several statistics calculations, such as one-variable analysis, two-variable analysis, and regressions. | |
| Stat Results      | Inserts the $stat.results$ variable. | |
| List Math         | Lets you select from several list calculations, such as minimum, maximum, and mean. | |
| List Operations   | Lets you select from several list operations, such as sorting, filling, and converting to a matrix. | |
| Distributions     | Lets you select from several distributions, such as $Normal Pdf$, $Binomial Cdf$, and $Inverse F$. | |
| Confidence Intervals | Lets you select from several confidence intervals, such as $t interval$ and $z interval$. | |
| Stat Tests        | Lets you select from several tests such as $ANOVA$, $t test$, $z test$. | |</p>
<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Matrix &amp; Vector</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transpose</td>
<td>Insert T</td>
<td></td>
</tr>
<tr>
<td>Determinant</td>
<td>Insert det()</td>
<td></td>
</tr>
<tr>
<td>Row-Echelon Form</td>
<td>Insert ref()</td>
<td></td>
</tr>
<tr>
<td>Reduced Row-Echelon Form</td>
<td>Insert rref()</td>
<td></td>
</tr>
<tr>
<td>Simultaneous</td>
<td>Insert simult()</td>
<td></td>
</tr>
<tr>
<td>Create</td>
<td>Let you select from several matrix-creation options, such as identity, diagonal, submatrix, and others.</td>
<td></td>
</tr>
<tr>
<td>Norms</td>
<td>Let you select norm(), rowNorm(), or colNorm().</td>
<td></td>
</tr>
<tr>
<td>Dimensions</td>
<td>Let you select dim(), rowDim(), or colDim().</td>
<td></td>
</tr>
<tr>
<td>Row Operations</td>
<td>Let you select rowSwap(), rowAdd(), mRow(), or mRowAdd().</td>
<td></td>
</tr>
<tr>
<td>Element Operations</td>
<td>Insert “dot” operators such as .+ (dot add) and .^ (dot power).</td>
<td></td>
</tr>
<tr>
<td>Advanced</td>
<td>Insert eigVl(), eigVc(), LU, or QR.</td>
<td></td>
</tr>
<tr>
<td>Vector</td>
<td>Insert unitV(), crossP(), dotP(), ►Polar, ►Rect, ►Cylind, or ►Sphere.</td>
<td></td>
</tr>
<tr>
<td><strong>Functions &amp; Programs</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program Editor</td>
<td>Let you view, open for editing, import, or create a new program or function.</td>
<td></td>
</tr>
<tr>
<td>Func...EndFunc</td>
<td>Insert a template for creating a function.</td>
<td></td>
</tr>
</tbody>
</table>
### Before you begin

- Open the computer software, and add the Calculator application to a document.

### Entering and evaluating math expressions

#### Options for entering expressions

Calculator lets you enter and edit expressions through several methods.

- By clicking keys on the virtual keypad, including the Catalog (key. (To display the virtual keypad, click **View > Keypad**.)
- By selecting items from the Calculator menu
- By pressing shortcut keys on the computer keyboard.

#### Entering simple math expressions

**Note:** To enter a negative number on the handheld, press \(\text{ neg} \). To enter a negative number on a computer keyboard, press the hyphen key (-).

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prgm...EndPrgm</td>
<td></td>
<td>Inserts a template for creating a program.</td>
</tr>
<tr>
<td>Local</td>
<td></td>
<td>Inserts the <strong>Local</strong> command.</td>
</tr>
<tr>
<td>Control</td>
<td></td>
<td>Lets you select from a list of function and program-control templates, such as <strong>If...Then...EndIf</strong>, <strong>While...EndWhile</strong>, <strong>Try...Else...EndTry</strong>, and others.</td>
</tr>
<tr>
<td>Transfer</td>
<td></td>
<td>Inserts transfer commands <strong>Return</strong>, <strong>Cycle</strong>, <strong>Exit</strong>, <strong>Lbl</strong>, <strong>Stop</strong>, or <strong>Goto</strong>.</td>
</tr>
<tr>
<td>Disp</td>
<td></td>
<td>Displays intermediate results.</td>
</tr>
<tr>
<td>Mode</td>
<td></td>
<td>Inserts commands for setting or reading modes, such as display digits, angle mode, base mode, and others.</td>
</tr>
<tr>
<td>Add New Line</td>
<td></td>
<td>Starts a new line within a function or program definition.</td>
</tr>
</tbody>
</table>
Suppose you want to evaluate \( \frac{2^8 \cdot 43}{12} \)

1. Select the entry line in the Calculator work area.
2. Type \( 2^8 \) to begin the expression.

\[
2^8
\]

3. Press \( \downarrow \) to return the cursor to the baseline, and then type \( \times 43/12 \).

\[
2^8 \cdot 43/12
\]

4. Press \( \text{Enter} \) to evaluate the expression.

The expression displays in standard mathematical notation, and the result displays on the right side of the Calculator.

\[
\frac{2^8 \cdot 43}{12} = \frac{2752}{3}
\]

**Note:** If a result does not fit on the same line with the expression, it displays on the next line.

**Controlling the form of a result**

You might expect to see a decimal result instead of \( \frac{2752}{3} \) in the preceding example. A close decimal equivalent is \( 917.33333... \), but that’s only an approximation.

By default, Calculator retains the more precise form: \( \frac{2752}{3} \). Any result that is not a whole number displays in a fractional form. This reduces rounding errors that could be introduced by intermediate results in chained calculations.

You can force a decimal approximation in a result:

- By holding down \( \text{Ctrl} \) before pressing \( \text{Enter} \) to evaluate the expression.

\[
\frac{2^8 \cdot 43}{12} \quad 917.333
\]

*Pressing \( \text{Ctrl} \) \( \text{Enter} \) forces approximate result.*
• By including a decimal in the expression (for example, 43. instead of 43).

\[
\frac{2^8 \cdot 43.}{12} = 917.333
\]

• By wrapping the expression in the \texttt{approx()} function.

\[
\text{approx}\left(\frac{2^8 \cdot 43}{12}\right) = 917.333
\]

• By changing the document’s \texttt{Auto or Approximate} mode setting to Approximate. (On the \texttt{File} menu, select \texttt{Document Settings}.) Note that this method forces all results in all of the document’s problems to approximate.

**Inserting items from the Catalog**

You can use the Catalog to insert system functions and commands, symbols, and expression templates into the Calculator entry line.

1. Click \textcolor{red}{\textbf{Catalog}} to open the Catalog.

   ![Catalog Window]

   \textbf{Note:} Some functions have a wizard that prompts you for each argument. If you prefer to enter the argument values directly on the entry line, you may need to disable the wizard.

2. Click the tab for the category of the item.
1. Click to display the Template palette.

2. Select to insert the algebraic sum template.

   The template appears on the entry line with small blocks representing elements that you can enter. A cursor appears next to one of the elements to show that you can type a value for that element.

3. Use the arrow keys to move the cursor to each element’s position, and type a value or expression for each element.
4. Press **Enter** to evaluate the expression.

\[
\sum_{n=3}^{7} \binom{n}{3}
\]

\[= 25\]

**Creating matrices**

1. Click \(\text{\textbullet}\) to display the Template palette.

2. Select \(\text{\textbullet}\).

The Create a Matrix dialog box displays.

3. Type the **Number of rows**.
4. Type the **Number of columns**, and then select **OK**.

Calculator displays a template with spaces for the rows and columns.

**Note:** If you create a matrix with a large number of rows and columns, it may take a few moments to appear.

5. Type the matrix values into the template, and press **Enter** to define the matrix.

**Inserting a row or column into a matrix**

- To insert a new row, hold down **Alt** and press **Enter**.
To insert a new column, hold down **Shift** and press **Enter**.

**Inserting expressions using a wizard**

You can use a wizard to simplify entering some expressions. The wizard contains labeled boxes to help you enter the arguments in the expression.

For example, suppose you want to fit a $y=mx+b$ linear regression model to the following two lists:

{1,2,3,4,5}
{5,8,11,14,17}

1. Click **Catalog** to open the Catalog.
2. Click **Catalog** to show an alphabetic list of functions.
3. Press **¶**, and then press **L** to jump to the entries that begin with “L.”
4. Press **¶** as necessary to highlight **LinRegMx**.
5. If the Use Wizard option is not checked, click it.
6. Press **Enter**.
   
   A wizard opens, giving you a labeled box to type each argument.

7. Type \{1,2,3,4,5\} as **X List**.
8. Press **Tab** to move to the **Y List** box.
9. Type \{5,8,11,14,17\} as **Y List**.
10. If you want to store the regression equation in a specific variable, press **Tab**, and then replace **Save RegEqn To** with the name of the variable.
11. Select **OK** to close the wizard and insert the expression into the entry line.

Calculator inserts the expression and adds a statement to display the variable `stat.results`, which will contain the results.

```
LinRegMx {1,2,3,4,5},{5,8,11,14,17},1 : stat.results
```

Calculator then displays the `stat.results` variables.

```
LinRegMx \{1,2,3,4,5\},\{5,8,11,14,17\},1: stat.results
```

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| "Title" | "Linear Regression (mx+b)"
| "RegEqn" | "m*x+b"
| "m" | 3. |
| "b" | 2. |
| "r^2" | 1. |
| "r" | 1. |
| "Resid" | "\{\ldots\}" |

**Note:** You can copy values from the `stat.results` variables and paste them into the entry line.

**Creating a piecewise function**

1. Begin the function definition. For example, type the following.

```
Define f(x,y)=
```

2. Click to display the Template palette.

3. Select .

The Piecewise Function dialog box displays.

4. Type the **Number of Function Pieces**, and select **OK**.
Calculator displays a template with spaces for the pieces.

5. Type the expressions into the template, and press **Enter** to define the function.

6. Enter an expression to evaluate or graph the function. For example, enter the expression $e(1, 2)$ on the Calculator entry line.

**Deferring evaluation**

You don’t have to complete and evaluate an expression as soon as you begin typing it. You can type part of an expression, leave to check some work you did on another page, and then come back to complete the expression later.

**Working with variables**

When you first store a value in a variable, you give the variable a name.

- If the variable does not already exist, Calculator creates it.
- If the variable already exists, Calculator updates it.

Variables within a problem are shared by TI-Nspire™ math and science learning technology applications. For example, you can create a variable in Calculator and then use or modify it in Graphs & Geometry or Lists & Spreadsheet within the same problem.

Exception: Variables created with the **Local** command within a user-defined function or program are not accessible outside that function or program.

**Storing a value in a variable**

This example creates a variable named `num` and stores the result of the expression $5+8^3$ in that variable.

1. On the Calculator entry line, type the expression $5+8^3$.

   $5+8^3$

2. Press $\uparrow$ to expand the cursor to the baseline.

   $5+8^3$

3. On the virtual keypad, click $\text{ctrl} \text{var}$ and then type the variable name `num`.  

---

Using Calculator
Using Calculator

This means: Calculate \(5+8^3\) and store the result as a variable named \(num\).

4. Press Enter.

Calculator creates the variable \(num\) and stores the result there.

\[
5+8^3 \rightarrow num
\]

\[
5+8^3 \rightarrow num \quad 517
\]

**Alternative methods for storing a variable**

As alternatives to using \(\rightarrow\) (store), you can use " :=" or the Define command. All of the following statements are equivalent.

\[
5+8^3 \rightarrow num
\]

\[
um := 5+8^3
\]

Define \(num=5+8^3\)

**Checking a variable’s value**

You can check the value of an existing variable by entering its name on the Calculator entry line.

- On the Calculator entry line, type the variable name \(num\) and press Enter.

The value most recently stored in \(num\) displays as the result.

\[
\begin{array}{c|c}
\hline
\text{num} & 517 \\
\hline
\end{array}
\]

**Using a variable in a calculation**

After storing a value in a variable, you can use the variable name in an expression as a substitute for the stored value.

1. Type \(4*25*num^2\) on the entry line, and press Enter.

Calculator substitutes 517, the value currently assigned to \(num\), and evaluates the expression.

\[
4\cdot25\cdot num^2 \quad 26728900
\]

2. Type \(4*25*nonum^2\), and press Enter.
Because the variable \textit{nonum} has not been defined, the expression returns an error message.

**Updating a variable**

If you want to update a variable with the result of a calculation, you must store the result explicitly.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Result</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{a := 2}</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>\texttt{a}</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>\texttt{a := a^3}</td>
<td>8</td>
<td>Variable \textit{a} updated with result.</td>
</tr>
<tr>
<td>\texttt{a}</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>\texttt{a^2 \rightarrow a}</td>
<td>64</td>
<td>Variable \textit{a} updated with result.</td>
</tr>
<tr>
<td>\texttt{a}</td>
<td>64</td>
<td></td>
</tr>
</tbody>
</table>

**Types of variables**

You can store the following TI-Nspire™ math and science learning technology data types as variables:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>2.54 $\ 1.25\times10^6 \ 2\pi \ 2+3i \ \sqrt{2}/2$</td>
</tr>
<tr>
<td>List</td>
<td>{2, 4, 6, 8} $\ {1, 1, 2}$</td>
</tr>
</tbody>
</table>
| Matrix | \[
\begin{bmatrix}
1 & 2 & 3 \\
3 & 6 & 9 \\
\end{bmatrix}
\] This can be entered as: \{1,2,3;3,6,9\} |
| Character string | “Hello” $\ "xmin/10" \ “The answer is:”$ |
| Function | myfunc(arg) $\ \text{ellipse}(x, y, r1, r2)$ |

**Entering multiple statements on the entry line**

To enter several statements on a single line, separate them with a colon (\texttt{:"}:"). Only the result of the last expression is shown.
\[ a = 5 : b = 2 : \frac{a}{b} \cdot 1. \]

### Rules for naming variables

**Note:** In the unlikely event that you create a variable with the same name as one used for statistical analysis or by the Finance Solver, an error condition could occur. If you begin entering a variable name that is already in use in the current problem, the software shows the entry in **bold** to let you know.

- Variable names must be in one of the forms \( xxx \) or \( xxx.yyy \). The \( xxx \) part can have 1 to 16 characters. The \( yyy \) part, if used, can have 1 to 15 characters. If you use the \( xxx.yyy \) form, both \( xxx \) and \( yyy \) are required; you cannot start or end a variable name with a period "."
- Characters can consist of letters, digits, and the underscore character \( _ { } \). Letters can be U.S. or Greek letters (but not \( \Pi \) or \( \pi \)), accented letters, and international letters.
- You can use uppercase or lowercase letters. The names \( AB22, Ab22, \ aB22, \) and \( ab22 \) all refer to the same variable.
- You cannot use a digit as the first character of \( xxx \) or \( yyy \).
- Do not use spaces.
- If you want a variable to be treated as a complex number, use an underscore as the last character of the name.
- You cannot use an underscore as the first character of the name.
- You cannot use a preassigned variable, function, or command name, such as \( \text{Ans}, \ \text{min}, \) or \( \text{tan}. \)

**Note:** For a complete list of TI-Nspire™ functions, refer to the Reference Guide.
- Library documents and library objects are subject to additional naming restrictions. For details, see the “Libraries” section of the documentation.

Here are some examples:

<table>
<thead>
<tr>
<th>Variable names</th>
<th>Valid?</th>
</tr>
</thead>
<tbody>
<tr>
<td>( Myvar, my.var )</td>
<td>Yes</td>
</tr>
<tr>
<td>( My var, list 1 )</td>
<td>No. Contains a space.</td>
</tr>
<tr>
<td>( a, b, c )</td>
<td>Yes</td>
</tr>
<tr>
<td>( Log, \ Ans )</td>
<td>No. Preassigned to a system function or variable.</td>
</tr>
</tbody>
</table>
Reusing the last answer

Each instance of Calculator automatically stores the last calculated result as a variable named Ans. You can use Ans to create a chain of calculations.

**Note:** Do not link to Ans or any system variable. Doing so could prevent the variable from being updated by the system. System variables include statistics results (such as `Stat.RegEqn`, `Stat.dfError`, and `Stat.Resid`) and Finance Solver variables (such as `tvm.n`, `tvm.pmt`, and `tvm.fv`).

As an example of using Ans, calculate the area of a garden plot that is 1.7 meters by 4.2 meters. Then use the area to calculate the yield per square meter if the plot produces a total of 147 tomatoes.

1. On the Calculator entry line, type `1.7*4.2`, and press Enter.

```
1.7·4.2  7.14
```

2. Type `147/ans`, and press Enter to find the yield.

```
147  20.5882
7.14
```

As a second example, calculate \( \frac{3.76}{-7.9+\sqrt{5}} \) and then add \( 2\cdot\log(45) \).

3. Type `3.76/(-7.9+sqrt(5))`, and press Enter.

```
\frac{3.76}{-7.9+\sqrt{5}}  -.66385
```

4. Type `ans+2*log(45)`, and press Enter.

```
-.66384977522033+2\cdot\log_{10}(45)  2.64258
```
Temporarily substituting a value for a variable

Use the “|” (such that) operator to assign a value to a variable for just a single execution of the expression.

<table>
<thead>
<tr>
<th>a:=200.12</th>
<th>200.12</th>
</tr>
</thead>
<tbody>
<tr>
<td>a^2</td>
<td>a=100</td>
</tr>
<tr>
<td>a</td>
<td>200.12</td>
</tr>
</tbody>
</table>

Creating user-defined functions and programs

You can use the Define command to create your own functions and programs. You can create them in the Calculator application or in the Program Editor and then use them in other TI-Nspire™ applications.

For information on programming with the Program Editor, see the “Programming” and “Libraries” sections of the documentation.

Defining a single-line function

Suppose you want to define a function named cube() that calculates the cube of a number or variable.

1. On the Calculator entry line, type Define cube(x)=x^3 and press Enter.

   Define cube(x)=x^3  Done

   The message “Done” confirms that the function has been defined.

2. Type cube(2) and press Enter to test the function.

   cube(2)  8

Defining a multiple-line function using templates

You can define a function consisting of multiple statements entered on separate lines. A multiple-line function may be easier to read than one with multiple statements separated by colons.

Note: You can create multiple-line functions only by using the Define command. You cannot use the := or → operators to create multiple-line definitions. The Func...EndFunc template serves as a container for the statements.
As an example, define a function named \( g(x, y) \) that compares two arguments \( x \) and \( y \). If argument \( x \) > argument \( y \), the function should return the value of \( x \). Otherwise, it should return the value of \( y \).

1. On the Calculator entry line, type \textbf{Define} \( g(x, y) = \). Do not press \textbf{Enter} yet.

\[
\text{Define } g(x, y) = \]

2. On the \textbf{Functions & Programs} menu, select \textbf{Func...EndFunc}.

\[
\text{define } g(x, y) = \text{Func} \\
\]

Calculator inserts the template.

3. On the \textbf{Functions & Programs} menu, select \textbf{Control}, and then select \textbf{If...Then...Else...EndIf}.

\[
\text{define } g(x, y) = \text{Func} \\
\quad \text{If } x \geq y \text{ Then} \\
\quad \quad \text{Else} \\
\quad \quad \text{EndIf} \\
\text{EndFunc}
\]

4. Type the remaining parts of the function, using the arrow keys to move the cursor from line to line.

\[
\text{define } g(x, y) = \text{Func} \\
\quad \text{If } x > y \text{ Then} \\
\quad \quad \text{return } x \\
\quad \quad \text{Else} \\
\quad \quad \text{return } y \\
\quad \text{EndIf} \\
\text{EndFunc}
\]

5. Press \textbf{Enter} to complete the definition.

6. Evaluate \( g(3, -7) \) to test the function.

\textit{Using Calculator} 59
Defining a multiple-line function manually

**Note:** To start each new line without completing the function definition, you hold down **Alt** and press **Enter**.

As an example, define a function \( \text{cum\_sum}(x) \) that calculates the cumulative sum of integers from 1 through \( x \).

1. On the Calculator entry line, type \( \text{Define cum\_sum}(x)= \). Do not press **Enter** yet.

\[
\text{define cum\_sum}(x)=
\]

2. On the **Functions & Programs** menu, select **Func...EndFunc**. Calculator inserts the template.

\[
\text{define cum\_sum}(x)=\text{Func}
\]

\[
\quad \text{\text{:}}
\]

\[
\quad \text{EndFunc}
\]

3. Type the following lines, pressing **Alt Enter** at the end of each line.

\[
\text{Define cum\_sum}(x)=\text{Func}
\]

\[
\quad \text{Local } i, \text{temp\_sum}
\]

\[
\quad \text{temp\_sum}:=0
\]

\[
\text{For } i, 1, x
\]

\[
\quad \text{temp\_sum}:=\text{temp\_sum}+i
\]

\[
\text{EndFor}
\]

\[
\text{Return } \text{temp\_sum}
\]

\[
\text{EndFunc}
\]

4. After typing \( \text{Return temp\_sum} \), press **Enter** to complete the definition.

5. Evaluate \( \text{cum\_sum}(5) \) to test the function.

\[
\text{cum\_sum}(5)
\]

15
**Defining a program**

Defining a program is similar to defining a multiple-line function. The `Prgm...EndPrgm` template serves as a container for the program statements.

As an example, create a program named \( g(x,y) \) that compares two arguments. Based on the comparison, the program should display the text “\( x \) greater than \( y \)” or “\( x \) not greater than \( y \)” (showing the values of \( x \) and \( y \) in the text).

1. On the Calculator entry line, type `Define prog1(x,y)=`. Do not press `Enter` yet.

   
   \[
   \text{Define } \text{prog1}(x,y) =
   \]

2. On the **Functions & Programs** menu, select **Prgm...EndPrgm**. Calculator inserts the template.

   
   \[
   \text{Define } \text{prog1}(x,y) = \text{Prgm}
   \begin{array}{l}
   \end{array}
   \text{EndPrgm}
   \]

3. On the **Functions & Programs** menu, select **Control**, and then select **If...Then...Else...EndIf**. Calculator inserts the template.

   
   \[
   \text{Define } \text{prog1}(x,y) = \text{Prgm}
   \begin{array}{l}
   \text{If} \quad \text{Then}
   \end{array}
   \begin{array}{l}
   \end{array}
   \text{Else}
   \begin{array}{l}
   \end{array}
   \text{EndIf}
   \text{EndPrgm}
   \]

4. Type the remaining parts of the function, using the arrow keys to move the cursor from line to line.
Define \( \text{prog1}(x,y) = \text{Prgm} \)
   \[
   \text{If } x>y \text{ Then} \\
   \text{Disp } x, " \text{ greater than } ", y \\
   \text{Else} \\
   \text{Disp } x, " \text{ not greater than } ", y \\
   \text{EndIf} \\
   \text{EndPrgm}
   \]
Done

5. Press **Enter** to complete the definition.
6. Execute \( \text{prog1}(3, -7) \) to test the program.

\[
\begin{align*}
\text{prog1}(3, -7) \\
3 \text{ greater than } -7
\end{align*}
\]
Done

**Recalling a function or program definition**
You might want to reuse or modify a function or program that you have defined.

1. On the **Actions** menu, select **Recall Definition**.
   A dialog box appears with a list of defined functions and programs.
2. Select the name from the list.
   The definition (For example \( \text{Define } f(x) = 1/x + 3 \)) is pasted into the entry line for editing.

**Editing Calculator expressions**
Although you cannot edit an expression in the Calculator history, you can copy all or part of an expression from the history and paste it to the entry line. You can then edit the entry line.

**Positioning the cursor in an expression**

- Press **Tab** to cycle through the parameters of a template.
  – or –
Press ‹, ›, ▲, or ▼ to move the cursor through the expression. The cursor moves to the closest valid position in the direction that you press.

**Note:** An expression template may force the cursor to move through its parameters, even though some parameters may not be exactly in the path of the cursor movement. For example, moving upward from the main argument of an integral always moves the cursor to the top limit.

**Inserting into an expression in the entry line**

1. Position the cursor at the point where you want to insert additional elements.
2. Type the elements that you want to insert.

**Note:** When you insert an open parenthesis, Calculator adds a temporary close parenthesis, displayed in gray. You can override the temporary parenthesis by typing the same parenthesis manually or by entering something past the temporary parenthesis (thereby implicitly validating its position in the expression). After you override the temporary gray parenthesis, it is replaced with a black parenthesis.

**Selecting part of an expression**

1. Click a starting point in the expression.
2. Press and hold the **Shift** key and press ‹, ›, ▲, or ▼ to select.

– or –

Drag through the expression to select.

**Deleting all or part of an expression on the entry line**

1. Select the part of the expression to delete.
2. Press **Delete**.

**Financial calculations**

Several TI-Nspire™ functions provide financial calculations, such as time value of money, amortization calculations, and return on investment calculations.

The Calculator application also includes a Finance Solver. It lets you dynamically solve several types of problems, such as loans and investments.

**Using the Finance Solver**

1. On the **Calculations** menu, select **Finance Solver**.
The solver displays its default values (or previous values, if you have already used the solver in the current problem).

2. Enter each known value, using the tab key to cycle through the items.
   - The help information at the bottom of the solver describes each item.
   - You might need to temporarily skip the value that you want to calculate.
   - Make sure to set \texttt{PpY}, \texttt{CpY}, and \texttt{PmtAt} to the correct settings (12, 12, and END in this example).

3. Press Tab as necessary to select the item that you want to calculate, and then press Enter.

The solver calculates the value and stores all the values in “tvm.” variables, such as \texttt{tvm.n} and \texttt{tvm.pmt}. These variables are accessible to all TI-Nspire™ applications within the same problem.
Finance functions included
In addition to the Finance Solver, TI-Nspire™ built-in finance functions include:

- TVM functions for calculating future value, present value, number of payments, interest rate, and payment amount.
- Amortization information such as amortization tables, balance, sum of interest payments, and sum of principal payments.
- Net present value, internal rate of return, and modified rate of return.
- Conversions between nominal and effective interest rates, and calculation of days between dates.

Notes:
- Finance functions do not automatically store their argument values or results to the TVM variables.
- For a complete list of TI-Nspire™ functions, refer to the Reference Guide.

Working with the Calculator history
As you enter and evaluate expressions in the Calculator application, each entry/result pair is saved in the Calculator history. The history gives you a way to review your calculations, repeat a set of calculations, and copy expressions for reuse in other pages or documents.

Viewing the Calculator history
The history of the expressions you have entered accumulates above the entry line, with the most recent expression at the bottom. If the history does not fit in the Calculator work area, you can scroll through the history.

Note: You may notice a processing slowdown when the history contains a large number of entries.

- Press ▲ or ▼.
  - or –
    - Drag the scrollbar slider.
Reusing a previous expression or result

You can copy an expression, subexpression, or result from the Calculator history and paste it into the entry line or into other TI-Nspire™ applications.

1. Scroll to the item that you want to copy.
2. Select the item.
3. Press Ctrl C to make the copy.
4. Select the location where you want the copy.
5. Press Ctrl V to paste the copy.

Note: The float setting for the current document may limit the number of decimal places displayed in a result. To capture the result in its full precision, select it either by scrolling with the up and down arrow keys or by triple-clicking it.
$$\sqrt{\frac{2^8 \cdot 12}{42}} \quad 8.55236$$

**Note:** If you copy an expression that uses variables into a different problem, the values of those variables are not copied. You must define the variables in the problem where you paste the expression.

**Deleting an expression from the history**

When you delete an expression, all variables and functions defined in the expression retain their current values.

1. Drag or use the arrow keys to select the expression that you want to delete.

$$\sqrt{\frac{2^8 \cdot 12}{42}} \quad 8.55236$$

2. Press **Delete**.
   
   The expression and its result are removed.

**Clearing the Calculator history**

When you clear the history, all variables and functions defined in the history retain their current values. If you clear the history by mistake, use the undo feature.

1. On the **Actions** menu, select **Clear History**.

   All expressions and results are removed from the history.
Using Graphs & Geometry

Getting started with Graphs & Geometry

The Graphs & Geometry application enables you to:

- Graph and explore functions.
- Create and explore geometric shapes.
- Animate points on objects or graphs and explore their behavior.
- Graph data collected by the Data Collection tool.
- Explore graphical and geometric transformations.
- Explore and investigate concepts of calculus.
- Link to data created by other applications and utilize it in Graphs & Geometry.

1. Graphs & Geometry toolbar (displays when a Graphs & Geometry work area is active)
2. Sample Graphs & Geometry work area in Plane Geometry View with Analytic Window shown
3. Graphs & Geometry data entry line
Getting acquainted with Graphs & Geometry

Open the TI-Nspire™ computer software, and add the Graphs & Geometry application to your page.

When you add Graphs & Geometry to a page, your work area contains the x and y axes for a graph, as well as a function entry line and Graphs & Geometry-specific tools.

The basic components of the Graphs & Geometry application are the:

- Tool menu line
- Work area (which contains the axes)
- Entry line.

The Tool menu

The Graphs & Geometry tool menu appears immediately above the work area on the screen. It displays icons for menus that contain tools which enable you to graph and explore different types of functions, draw and explore geometric structures, as well as other capabilities which will be covered in this chapter.

The following tables contain a brief summary of what each menu contains or tool enables you to do within the Graphs & Geometry work area.

<table>
<thead>
<tr>
<th>Menu Option List</th>
<th>Overview of Tool Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td>Provides tools to access the pointer, hide or show various graph features, add text, delete all objects in the work area, access the calculate tool, and access the attributes for an object or function.</td>
</tr>
<tr>
<td>View</td>
<td>Provides tools to manipulate the work area features and display.</td>
</tr>
<tr>
<td>Graph Type</td>
<td>Enables you to select the type of graph to plot in the work area: function, parametric, polar, or scatter plot. The entry line below the work area shows the notational conventions to use to specify a function for the selected graph type.</td>
</tr>
<tr>
<td>Window</td>
<td>Provides different Zoom settings as well as the ability to define the x- and y-axis minimums and maximums.</td>
</tr>
<tr>
<td>Menu Option List</td>
<td>Overview of Tool Actions</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Trace</td>
<td>Creates and activates a trace on the graph. Sets the trace increment and enables you to create and remove geometric trace.</td>
</tr>
<tr>
<td>Points &amp; Lines</td>
<td>Provides tools for drawing various types of points, lines, segments, rays, tangents, and vectors.</td>
</tr>
<tr>
<td>Measurement</td>
<td>Provides tools for measuring angles, lengths, areas, integrals, and slope.</td>
</tr>
<tr>
<td>Shapes</td>
<td>Provides tools for drawing circles, triangles, rectangles, and polygons.</td>
</tr>
<tr>
<td>Construction</td>
<td>Provides tools to define perpendicular and parallel lines, bisectors, midpoints, locus, compass, and perform measurement transfers.</td>
</tr>
<tr>
<td>Transformation</td>
<td>Provides tools for symmetry, reflection, translation, rotation, and dilation.</td>
</tr>
</tbody>
</table>

### Action Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>Selects, moves, and manipulates objects.</td>
</tr>
<tr>
<td>Hide/Show</td>
<td>Enables you to hide or display any object, function, or feature on the work area.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Enables you to change the attributes of a selected object in the work area. Attributes vary depending upon the object selected.</td>
</tr>
<tr>
<td>Delete All</td>
<td>Removes all objects and graphed functions from the page.</td>
</tr>
<tr>
<td>Text</td>
<td>Places user-created alpha-numeric values on the page. Numerical values can be applied to objects. The tool can be used to enter a function and graph it.</td>
</tr>
<tr>
<td>Coordinates and Equations</td>
<td>Displays the coordinates of a point or the equation of a line or circle.</td>
</tr>
<tr>
<td>Tool name</td>
<td>Tool function</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculate</td>
<td>Opens the calculate tool to perform calculations using measurements, numerical values, or calculation results. This tool is different from the Calculator application.</td>
</tr>
<tr>
<td>Redefine</td>
<td>Redefines a previously defined point to a new location. For example, it can define a point in free space to a location on an object or from one object to another object.</td>
</tr>
<tr>
<td>Data Collection</td>
<td>Adds the Data Collection tool to the current Graphs &amp; Geometry page. See the Data Collection chapter for details on using this tool.</td>
</tr>
</tbody>
</table>

### View Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphing</td>
<td>Places the work area in graphing mode. When you add Graphs &amp; Geometry to a page the Cartesian axes displays in the work area with a function entry line below.</td>
</tr>
<tr>
<td>Plane Geometry</td>
<td>Places the work area in geometry mode. Show scale displays, but no axes, grid, or entry line displays.</td>
</tr>
<tr>
<td>Show Analytic Window</td>
<td>Opens a small graphing window on a plane geometry work area. Places the Graphs &amp; Geometry work area in modeling mode. This tool can be used only after Plane Geometry is selected.</td>
</tr>
<tr>
<td>Hide (Show) Axes</td>
<td>Hides the axes if they are currently displayed on the page. Displays the axes if none are displayed on the page.</td>
</tr>
<tr>
<td>Show (Hide) Grid</td>
<td>Turns the grid on or off on the page. Objects can be attached to the grid when the grid is displayed.</td>
</tr>
<tr>
<td>Hide (Show) Entry Line</td>
<td>Hides or displays the entry line on the page.</td>
</tr>
<tr>
<td>Tool name</td>
<td>Tool function</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Show (Hide) Scale" /></td>
<td>Toggles between showing and hiding the scale legend on the work area. When the scale is shown, the value and/or units can be changed to desired values/units. This applies only to geometric constructions.</td>
</tr>
<tr>
<td><img src="image" alt="Add Function Table" /></td>
<td>Launches the Lists &amp; Spreadsheet function table. When launched from Graphs &amp; Geometry, it is pre-populated with all functions defined in the problem with the exception of hidden functions. More information on using Function Tables is available in the Lists &amp; Spreadsheet chapter of this document.</td>
</tr>
</tbody>
</table>

**Graphing Type Menu Tools**

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Function" /></td>
<td>Displays the function mode entry line at the bottom of the work area.</td>
</tr>
<tr>
<td><img src="image" alt="Parametric" /></td>
<td>Displays the parametric mode entry line at the bottom of the work area. This display shows the t-min, t-max, and t-step values. The defaults are 0-2(\pi) for t-min, t-max, and (\pi/24) for t-step.</td>
</tr>
<tr>
<td><img src="image" alt="Polar" /></td>
<td>Displays the Polar mode entry line at the bottom of the work area. This display shows the (\theta)-min, (\theta)-max, and (\theta)-step values. The defaults are 0-2(\pi) for (\theta)-min and (\theta)-max, and (\pi/24) for (\theta)-step.</td>
</tr>
<tr>
<td><img src="image" alt="Scatter Plot" /></td>
<td>Displays the Scatter Plot mode entry line at the bottom of the work area.</td>
</tr>
</tbody>
</table>

**Window Menu Tools**

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Window Settings" /></td>
<td>Displays the Window Settings dialog that enables you to enter the x-min, x-max, y-min, and y-max values for the axes.</td>
</tr>
<tr>
<td>Tool name</td>
<td>Tool function</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Zoom - Box</td>
<td>Enables you to define an area that you want to enlarge.</td>
</tr>
<tr>
<td>Zoom - In</td>
<td>Enables you to define the center point of the zoom in location. The Zoom In factor is approximately 2.</td>
</tr>
<tr>
<td>Zoom - Out</td>
<td>Enables you to define the center point of the zoom out location. The Zoom Out factor is approximately 2.</td>
</tr>
<tr>
<td>Zoom - Standard</td>
<td>Automatically sets $x_{\text{min}}$, $x_{\text{max}}$, $y_{\text{min}}$, and $y_{\text{max}}$ to center the origin. The $x$ and $y$ scale factors are equal. This is the default axes setting when Graphs &amp; Geometry is first added to a page.</td>
</tr>
<tr>
<td>Zoom - Quadrant 1</td>
<td>Automatically sets $x_{\text{min}}$, $x_{\text{max}}$, $y_{\text{min}}$, and $y_{\text{max}}$ to emphasize the first quadrant. The $x$ and $y$ scale factors are equal.</td>
</tr>
<tr>
<td>Zoom - User</td>
<td>If you have modified any window settings (such as $x_{\text{min}}$), Zoom-User saves the present settings. If you have not modified any window settings since last selecting Zoom-User, Zoom-User restores those settings.</td>
</tr>
<tr>
<td>Zoom - Trig</td>
<td>Automatically sets $x_{\text{min}}$ and $x_{\text{max}}$ to integer multiples of $\pi$. The $x$ and $y$ scale factors are equal.</td>
</tr>
<tr>
<td>Zoom - Data</td>
<td>Redefines the axes so that all statistical data points are displayed.</td>
</tr>
<tr>
<td>Zoom - Fit</td>
<td>Recalculates $y_{\text{min}}$ and $y_{\text{max}}$ to include the minimum and maximum $y$ values of all functions between the current $x_{\text{min}}$ and $x_{\text{max}}$. Hidden functions are not included.</td>
</tr>
</tbody>
</table>
### Trace Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Graph Trace" /></td>
<td>Places and activates a trace point on the graph, enabling you to trace a function and identify points of interest as they are encountered during the trace.</td>
</tr>
<tr>
<td><img src="image" alt="Trace Setting" /></td>
<td>Enables you to set the increment to use between consecutive values jumped to during Graph Trace.</td>
</tr>
<tr>
<td><img src="image" alt="Geometry Trace" /></td>
<td>Enables you to view the pathway of a geometric or analytic object (such as a function graph) on the work area. The pathway has a delayed fade. As more movement occurs on the work area, older portions of the pathway fade. If you temporarily halt movement, a portion of the trace path remains displayed.</td>
</tr>
<tr>
<td><img src="image" alt="Erase Geometry Trace" /></td>
<td>Halts geometric trace and erases all persistent pathways on the work area.</td>
</tr>
</tbody>
</table>

### Points and Lines Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Point" /></td>
<td>Constructs a point defined in free space, on an object, or at the intersection of two objects.</td>
</tr>
<tr>
<td><img src="image" alt="Point On" /></td>
<td>Constructs a point defined on an object. When the object is a function graph, the coordinates are displayed.</td>
</tr>
<tr>
<td><img src="image" alt="Intersection Point" /></td>
<td>Constructs a point at each intersection of two selected objects.</td>
</tr>
<tr>
<td><img src="image" alt="Line" /></td>
<td>Constructs an infinite line defined by two points or by a point and a direction. If you press Shift while creating the line, you limit its orientation, relative to the x-axis or the horizontal aspect of the screen, by 15° increments.</td>
</tr>
</tbody>
</table>
### Tool Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment</td>
<td>Constructs a segment, defined by two end points, which may be created or defined in free space or on a defined object. If you press Shift while creating the segment, you limit its orientation, relative to the x-axis or the horizontal aspect of the screen, by 15° increments.</td>
</tr>
<tr>
<td>Ray</td>
<td>Constructs a ray, defined by two points or by a point and a direction, extending infinitely. If you press Shift while creating the ray, you limit its orientation, relative to the x-axis or the horizontal aspect of the screen, by 15° increments.</td>
</tr>
<tr>
<td>Tangent</td>
<td>Creates a tangent line.</td>
</tr>
<tr>
<td>Vector</td>
<td>Constructs a vector with magnitude and direction defined by two points. If you press Shift while creating the vector, you limit its orientation, relative to the x-axis or the horizontal aspect of the screen, by 15° increments.</td>
</tr>
</tbody>
</table>

### Measurement Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Displays the distance between two selected points or the length of a segment, perimeter, circumference, or radius.</td>
</tr>
<tr>
<td>Area</td>
<td>Displays the area of a selected polygon or circle.</td>
</tr>
<tr>
<td>Slope</td>
<td>Displays the slope of a selected line or segment. A vertical slope is represented by ∞.</td>
</tr>
<tr>
<td>Angle</td>
<td>Displays the measure of an angle or an angle defined by three selected points.</td>
</tr>
</tbody>
</table>
Using Graphs & Geometry

### Shapes Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Integral</strong></td>
<td>Calculates and displays the numerical value of the integral of a selected function, and shades the area between the curve and the x-axis from point a to point b.</td>
</tr>
<tr>
<td><strong>Circle</strong></td>
<td>Constructs a circle. The center point is defined by the first click on the page and the radius is determined by the second click.</td>
</tr>
<tr>
<td><strong>Triangle</strong></td>
<td>Constructs a triangle, defined by three points (vertices), which may be created or defined in free space or on a defined object.</td>
</tr>
<tr>
<td><strong>Rectangle</strong></td>
<td>Constructs a rectangle.</td>
</tr>
<tr>
<td><strong>Polygon</strong></td>
<td>Constructs an $n$-sided polygon. Each click defines a vertex, and the polygon is completed by clicking the initial vertex or by pressing Enter.</td>
</tr>
<tr>
<td><strong>Regular Polygon</strong></td>
<td>Constructs an $n$-sided regular polygon.</td>
</tr>
</tbody>
</table>

### Construction Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Perpendicular</strong></td>
<td>Constructs a line perpendicular to a selected line, segment, ray, vector, axis, or side of a polygon, and passing through a created or selected point.</td>
</tr>
<tr>
<td><strong>Parallel</strong></td>
<td>Constructs a line parallel to a selected line, segment, ray, vector, axis, or side of a polygon, and passing through a created or selected point.</td>
</tr>
<tr>
<td><strong>Perpendicular Bisector</strong></td>
<td>Constructs a perpendicular line that bisects two points, a segment, or side of a polygon.</td>
</tr>
<tr>
<td>Tool name</td>
<td>Tool function</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Angle Bisector</td>
<td>Constructs a line that bisects an angle identified by three selected points where the second point is the vertex.</td>
</tr>
<tr>
<td>Midpoint</td>
<td>Constructs a midpoint of two selected points, a segment, or side of a polygon.</td>
</tr>
<tr>
<td>Locus</td>
<td>Constructs the locus of a point or object defined by the movement of a driver point along a pathway. Pathways are geometric shapes and function graphs.</td>
</tr>
<tr>
<td>Compass</td>
<td>Constructs a circle from a center point with a radius defined by a selected segment or the distance between two points.</td>
</tr>
<tr>
<td>Measurement Transfer</td>
<td>Transfers an entered or measured value to a selected object, axis, or function graph. If the original value changes, the change is also reflected in the transferred measurement.</td>
</tr>
</tbody>
</table>

**Transformation Menu Tools**

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symmetry</td>
<td>Creates the image of an object rotated $180^\circ$ around a point.</td>
</tr>
<tr>
<td>Reflection</td>
<td>Creates the image of an object reflected across a line, segment, ray, vector, axis, or side of a polygon.</td>
</tr>
<tr>
<td>Translation</td>
<td>Creates the image of an object translated by a specified vector.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Creates the image of an object rotated around a point by a specified angular value.</td>
</tr>
<tr>
<td>Dilation</td>
<td>Creates the image of an object dilated from a point by a specified factor.</td>
</tr>
</tbody>
</table>
Note: When you select a tool to use, that tool’s icon displays in the upper left corner of the Graphs & Geometry page. It is there to remind you which tool is currently active.

Using the Context menu

The context menu provides the tools most commonly used with the selected object, function, or axes.

To display the context menu, right click on an object, function, or anywhere on the work area.

The first two options on this menu are:

- **Recent**: lists the 9 most recent tools you used. This is a session-level listing. The tools used on any Graphs & Geometry page are shown, regardless of the document in which they are used.

- **Attributes**: enables you to access the attributes appropriate for the function, object, or work area

Additional options that are appropriate for your selection also display on the menu. For example, the Context menu for a triangle also contains the Hide/Show, Delete, Length, and Area options.

The following examples show the context menu for a function and a circle.

The work area

There are two work area views available:

- **Graphing**
- **Plane Geometry**
The graphing view

The graphing view is the default Graphs & Geometry work area display. It contains:

- the default Cartesian axes in the Zoom Standard format (1:1 scale).
- the entry line from which you can graph up to 100 functions.

Axes, entry line, and grid can all be displayed or hidden, but in this view, no scale for any drawn shapes (e.g. Circle, etc.) can be displayed. All objects created in this view are analytic objects. Therefore, their displayed size and proportion are affected only by the scale of the axis system (the command "Show Scale" has no effect).

The plane geometry view

The plane geometry view removes the axes and entry line from the work area to enable you to draw geometric shapes and explore them. In this view, you can display and set a scale for your drawings.

To change to Plane Geometry view:

1. From the View menu, select the Plane Geometry View tool.
2. The display refreshes to clear the axes and entry line and display a default scale. Any graphs or drawings created in graphing view are not displayed on the plane geometry area.

To return to graphing mode:

- From the View Menu, select the Graphing View tool.
The display refreshes to show the axes and entry line.

**Note:** Any geometric constructions created while in the plane geometry view are retained and displayed along with any previously-created graphs.

---

**The analytic window**

The analytic (graphing) window is available in the plane geometry view. It adds an analytic (graphing) window on top of a portion of the plane geometry work area. This provides a combination work area that enables you to use both work area types without toggling the view between them.

To open the analytic window:

1. Ensure that the work area is in Plane Geometry view.
2. From the View menu, select Show Analytic Window.
3. A reduced size graphing window opens on the lower left corner of the plane geometry space.
You can alter the work area, without changing the view, to temporarily:

- hide the axes. Any graphs or objects remain displayed on the work area.
- hide the entry line.
- hide the scale.
- resize the axes using the zoom tools or by dragging tic marks.

To display more of the plane geometry area, pan the screen.

**To remove the analytic window from the work area**

1. From the View menu, select Hide Analytic Window.

**Object behavior in different views**

When you create an object in the graph area, it is called an analytic object, and all points of the object reside on the graph plane. When you change the axes scale, you automatically affect the appearance of the object. If you calculate a value associated with the object such as the area, only generic units are assigned (\textit{u} for unit). These objects remain associated with the coordinate plane until you delete them or redefine them to the plane geometry area. When working with a modeling view work area, you cannot move an analytic object onto the plane geometry area.
When you create an object in the plane geometry area, it is a geometric object. These objects can have an assigned scale, such as miles or centimeters, instead of u for units. You can lock a point, such as one vertex of a triangle, on the work area, but since the object is not tied to a coordinate plane, you cannot display coordinates for that vertex. When working with a modeling view work area, you can move a geometric object into the graphing work area. The object remains a geometric object, and is not associated with the axes.

The examples below shows a modeling work area and the two types of objects: A is an analytic object while B is a geometric object.

While the two circles appear identical, they do not behave in the same way. Analytic objects are impacted when the graph area is altered. In the next example, the axes were altered. Notice that only Circle A’s appearance is affected by the change.
If you construct an object while the axis is hidden, the object created will be a geometric object. However, if you construct an analytic object and later hide the axis, the object remains an analytical one.
**Summary of differences**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Graph Area</th>
<th>Plane Geometry Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect Ratio</td>
<td>Adjustable; initially 1:1</td>
<td>Always 1:1 (static)</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>Generic (displayed as u)</td>
<td>User-defined (per scale)</td>
</tr>
<tr>
<td>Area Graph Type</td>
<td>Cartesian (default) or Polar</td>
<td>Euclidian</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Uses</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Define and graph functions to:</td>
<td>• Construct Euclidean objects</td>
</tr>
<tr>
<td></td>
<td>− Graph functions of the form f (x)</td>
<td>• Create transformations</td>
</tr>
<tr>
<td></td>
<td>− Create scatter plots</td>
<td>• Determine measurements (e.g.,</td>
</tr>
<tr>
<td></td>
<td>− Graph polar equations</td>
<td>length, angle, area)</td>
</tr>
<tr>
<td></td>
<td>− Graph parametric functions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Construct analytic objects</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Label equations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Identify coordinates for discrete points</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Behavior</td>
<td>Analytic constructions must remain in the</td>
<td>Geometric constructions can be</td>
</tr>
<tr>
<td></td>
<td>analytic area.</td>
<td>moved into the analytic area but</td>
</tr>
<tr>
<td></td>
<td></td>
<td>remain geometric in nature.</td>
</tr>
</tbody>
</table>

**Creating and manipulating axes**

When you add the Graphs & Geometry application to a page, Cartesian axes displays by default.

You can change the appearance of your axes in the following ways:

1. Adjust the length of the axes:
   - When using Plane Geometry mode with Show Analytic Window,
     - Select an axis and retype the domain or range labels.
Select an axis and drag to increase or decrease the numbers on the scale and tic mark spacing.

The aspect ratio of the axes is retained. To modify the scale of only one axis, press the Shift key as you adjust the value or drag the line.

2. Use the Zoom tool options to adjust the view.

3. Adjust the end style of the axes using the Attributes tool. Display the Attributes tool by:
   - selecting it from the menu or
   - right clicking on an axis between two tic marks.

Press the left and right arrow keys to display the desired end style. The attributes list for the axes also enables you to select a Zoom option.

4. Adjust the axes scale and tic mark spacing manually.
   a) Click and hold one tic mark, and move it on the axis. The spacing and number of tic marks increases (or decreases) on both axes.
b) To adjust the scale and tic mark spacing on a single axis, press and hold Shift, and then grab and drag a tic mark on that axis.

5. Adjust the location of the axes. To move the existing axes without resizing or rescaling them, click in and drag an empty region of the screen until the axes are in the desired location.

6. Use the Window Setting tool ( ) to define the x-max, x-min, y-max, y-min, and trace step values for the axes. When selected, this tool opens a dialog that enables you to enter the values desired. The current values are initially displayed. Type over them to enter new values.

You can hide and redisplay axes using the Hide/Show Axes tool.

▶ From the View menu, select the Hide/Show Axes tool ( ).
  • If the axes are shown on the page, selecting this tool hides them.
  • If the axes are hidden on the page, selecting this tool redispalyes them.

**Moving about the work area**

Graphs of functions may extend beyond the visible portion of your screen. This does not mean they are truncated. You can view them by panning the screen. To pan the screen:

1. Click and hold the mouse button in an open area of the page.
2. Move to display different portions of the screen.
The TI-Nspire™ computer software for math and science lets you resize the computer screen to change the display area.

- Select View > TI-Nspire™ Handheld View. All objects on the page are increased in size.
  
  To return the display to the original size, select View > TI-Nspire™ Handheld View again.

**Turning the grid on or off**

Graphs & Geometry can display a grid in addition to the axes for a function. You control the sizing of the grid as well as whether or not it is visible.

To display the grid:

- From the View menu, select the Show Grid tool ( ).
You resize the grid by rescaling the axes.

To turn the grid off:

- From the View menu, select the Hide Grid tool ( ).

  When the tool is selected, the page updates to remove the grid.

In addition, you can attach a function, graph, or object to the grid while the grid is displayed.

**Attaching an object to the grid**

1. Display the grid on the page if it is not already present.

2. Draw an object on the grid. Positioning the object so that points coincide with grid marks attaches the object to the grid.

   For example, if you draw a triangle, then one or more of the vertices must coincide with grid marks.

**Note:** You do not have to attach an object or graph to the grid. When you attach an object to the grid, its subsequent relocation is constrained to other grid points. Analytic objects are affected by axes changes regardless of whether or not they are attached to the grid.

To unattach an object from the grid, select and redefine it so that points do not coincide with grid marks. If you hide the grid, objects attached to it remain displayed on the page and remain attached to the grid even though it is no longer visible.

**The Zoom feature**

For screens with many function graphs, it can be difficult to view intersections and other areas of interest. To temporarily change your view of the screen, use the Zoom feature.
To use Zoom:
1. Open the Window menu.
2. Click the Zoom option you want to use.

In the following examples, all options except Zoom-Fit started with the graph of $x^2$. Zoom-Fit shows a graph of a sine function.

The options are:

- **Zoom - Box**

- **Zoom - In**

- **Zoom - Out**
• **Zoom - Standard**

![Zoom Standard Graph]

• **Zoom - Quadrant 1**

![Zoom Quadrant 1 Graph]

• **Zoom - User** (appears the same as Zoom - Standard if no new configuration is saved)

![Zoom User Graph]

• **Zoom - Trig**

![Zoom Trig Graph]
• Zoom - Data

3. The graph displays in the selected zoom view.

   If you select Zoom Box, you must specify the first and third corners of the box.

   If you select either Zoom In or Zoom Out, you must specify the center point before the graph is redrawn.

4. To return the graph to its initial state, either select Undo (Undo) or select Zoom - Standard from the Zoom menu.

Checking page contents

When creating content on your computer for use on the handheld, select TI-Nspire™ Handheld View from the View menu to see the page as it will appear on the handheld screen. By using this view, you can adjust the contents on the page to ensure it displays completely and correctly on the TI-Nspire™ handheld screen.

The entry line

The Entry line appears at the bottom of the Graphs & Geometry work area. When the line is not active, it is grayed out.
From left to right, the parts of this line are:

1. Hide/Show function button.
2. Attributes button.
3. f1(x) = is the default notation for a function or inequality.
4. Blank area into which you enter the function, polar equation, inequality, parametric, or scatter plot data to be graphed.
5. Expand/Contract (History) button.

Parametric Mode entry line.

Scatter Plot Mode entry line

Polar Mode entry line
**Additional Graphs & Geometry features**

**Keystroke shortcuts**

There are keystroke shortcuts that can simplify your work with Graphs & Geometry. These are:

<table>
<thead>
<tr>
<th>Keystrokes:</th>
<th>Task accomplished:</th>
</tr>
</thead>
<tbody>
<tr>
<td>clear</td>
<td>Removes a selected object from the work area.</td>
</tr>
<tr>
<td></td>
<td>When used with the Line or Circle tool, constrains Circle and linear objects (Line, Ray, etc.) construction to discrete intervals (e.g. Circle to integer radius values’ linear objects to multiples of 15 degrees).</td>
</tr>
<tr>
<td>(+) (+) (-)</td>
<td>When a number is under the pointer, the + and - keys enable you to change the number of displayed digits.</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>When a number is under the pointer, the &lt; and &gt; keys decrease or increase a value.</td>
</tr>
</tbody>
</table>

**Using the tab and arrow keys**

While the pointer allows you to access the many features and tools contained in Graphs & Geometry, you can also use the Tab and arrow keys to access these features. Using these keys is easier or more convenient than using the pointer.

The Tab key:

- First Tab stop: places the cursor to the right of the equal sign on the function entry line. This allows you to create a new expression.
- Second Tab stop: highlights the Expand/Collapse entry line history button.
- Third Tab stop: highlights the Hide/Show button on the entry line.
- Fourth Tab stop: highlights the Attributes button on the entry line.
- Fifth Tab stop: focuses on the Pause/Start button of the animation control bar, if present. If the Data Collection control bar is displayed, focuses on the Start/Stop button.
- Sixth Tab stop: focuses on the graphing portion of the page and commits any editing changes. The pointer is active on the page.

**Note:** Press **Shift Tab** to move through the steps in reverse order.
The arrow keys:

- **Up and Down** - moves up and down among functions in the function history list. Moves up and down any tool menu list as well as the attributes list. When using the Trace tool, enables you to move to and trace a different graph when more than one graph is on the page.

- **Left and Right** - moves along the entry line, one space or one button at a time. When using the Trace tool, moves the trace cursor along the graph, either left or right. When viewing an attribute list, steps through the options for one attribute.

### Attribute settings

The following table lists the attributes available when working with objects. The list of available attributes depends upon the object you select. To view attributes, select the Attributes tool ( ).

When the tool is selected, move the cursor to the work area and select the object or function whose attributes you want to change. The column of attributes available displays on the work area near the object or function.

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon(s)</th>
<th>Options</th>
<th>Available for use on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Weight</td>
<td>![Icon]</td>
<td>Thin, Medium, Thick</td>
<td>Line, Tangent, Segment, Ray, Vector, Circle, Triangle, Polygon, Regular Polygon, Rectangle, Graphed Functions, Integrals, Polar Equations</td>
</tr>
<tr>
<td>Line Style</td>
<td>![Icon]</td>
<td>Solid, Dashed, Dotted</td>
<td>Line, Tangent, Segment, Ray, Vector, Circle, Triangle, Polygon, Regular Polygon, Rectangle, Graphed Functions, Polar Equations, Integrals</td>
</tr>
<tr>
<td>Animation</td>
<td>![Icon]</td>
<td>Unidirectional Animation Speed, Alternating Animation Speed</td>
<td>Point, Point On</td>
</tr>
<tr>
<td>Name</td>
<td>Icon(s)</td>
<td>Options</td>
<td>Available for use on</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>Fill</td>
<td><img src="image1.png" alt="Icons" /></td>
<td>No fill, White, Light Grey, Med Grey, Grey, Dark Grey, Black</td>
<td>Circle, Triangle, Polygon, Regular Polygon, Rectangle, Integrals</td>
</tr>
<tr>
<td>Lock/Unlock</td>
<td><img src="image2.png" alt="Icons" /></td>
<td></td>
<td>Point, Point On, Intersection Point, Length, Perimeter, Area, Angle</td>
</tr>
<tr>
<td>Point Style</td>
<td><img src="image3.png" alt="Icons" /></td>
<td>Small dot, Large dot, Hollow circle, Solid square, Hollow square, x, +</td>
<td>Point, Point On, Intersection Point</td>
</tr>
<tr>
<td>Activation</td>
<td><img src="image4.png" alt="Icons" /></td>
<td>Point Activated, Point Deactivated</td>
<td>Points</td>
</tr>
<tr>
<td>Graph Appearance</td>
<td><img src="image5.png" alt="Icons" /></td>
<td>Continuous, Discrete, Number of Points, Step Size</td>
<td>Graphed Functions, Polar Equations, Parametric Curves</td>
</tr>
<tr>
<td>Axes Style</td>
<td><img src="image6.png" alt="Icons" /></td>
<td>Grid, No Grid</td>
<td>Axes</td>
</tr>
<tr>
<td>Axes Settings</td>
<td><img src="image7.png" alt="Icons" /></td>
<td>Axes user settings, Axes Quadrant 1 settings, Axes Trig settings, Axes Stat settings, Axes standard settings</td>
<td>Axes</td>
</tr>
</tbody>
</table>
### Changing the thickness and style of a line/outline

You can control the thickness and appearance of the lines and outlines of shapes that you create on the screen. To adjust the thickness of the lines:

1. From the Actions menu, select the Attributes tool ( ).
2. Select the object whose line you want to change.
   Use ▲ and ▼ to move through the list of attributes.
3. Highlight the thickness option, and use ◀ or ▶ to move through the thickness options.
   As you move through the options, the thickness immediately changes on the screen.
4. When the desired thickness displays on the screen, press **Enter** or click to confirm the change.
   The Attributes bar disappears.

### Table of Options

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon(s)</th>
<th>Options</th>
<th>Available for use on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axes End Style</td>
<td>![Axes Icon]</td>
<td>No Arrow, Positive Arrows, All Arrows</td>
<td>Axes</td>
</tr>
<tr>
<td>Axes Tic Labels</td>
<td>![Tic Labels Icon]</td>
<td>Tic labels are shown, Tic labels are not shown</td>
<td>Axes</td>
</tr>
<tr>
<td>Line Equation Type</td>
<td>![Line Icon]</td>
<td>Cartesian (y=), Canonical ( _=0)</td>
<td>Line, Tangent, Segment, Ray, Vector</td>
</tr>
<tr>
<td>Equation Type</td>
<td>![Equation Icon]</td>
<td>Canonical (...=0), Cartesian (...=r^2)</td>
<td>Circle</td>
</tr>
<tr>
<td>Plot Points</td>
<td>![Plot Points Icon]</td>
<td>Discrete Points, Connected Points</td>
<td>Parametrics, Scatter Plots, Polar equations</td>
</tr>
<tr>
<td>Labels</td>
<td>![Labels Icon]</td>
<td>y=, f( ), f( )=, y=f( ), f,</td>
<td>Graphed Functions</td>
</tr>
</tbody>
</table>
Use the same method to change the style of the line, selecting the style attribute, instead of the thickness attribute.

**Locking measured values and points**

Graphs & Geometry allows you to lock one or many values or points. To do this:

1. From the Actions menu, select the Attributes tool ( ).
2. Select the value or point that you want to lock.
3. Use ▲ and ▼ to locate the Lock attribute.
4. Use ◀ or ▶ to select Lock.
5. Click or press **Enter** to lock the value or point.

A lock icon appears near the locked value or point.

An example of when locking measured values is useful is the problem of maximizing an area contained within a fixed perimeter. In this case, a rectangle is created with the correct perimeter, and both the perimeter and area values are displayed. The perimeter value is locked. As you alter the sides of the rectangle, the perimeter remains unchanged but the area changes. When the optimum area displays, you can measure the sides to obtain the necessary dimensions.
**Working with functions**

The entry line under the work area lets you specify functions in the format supported for each graph type in Graphs & Geometry.

**Using the entry line**

The entry line displays at the bottom of the page. The entry line displays the form to use to type the function that corresponds to the selected graph type. To type details for a function on the entry line:

1. Select the graph type to set the graphing mode. You can specify multiple functions for each graph type. The default graph type is Function, so the form \( f_1(x) \) = displays.

2. Type the data for the type of function you want to graph using the function formatting that displays on the entry line:
   - To graph a function, select Function on the Graph Type menu. The work area and entry line change to function mode. Enter an expression for the function after the equal sign.
   - To graph a parametric equation, select Parametric. The work area and entry line change to parametric mode. Type expressions for \( x_n(t) \) and \( y_n(t) \). Specifying alternate values for the default t-min, t-max, and t-step displayed is optional.
   - To graph a polar equation, select Polar. The work area and entry line change to polar mode. Type an expression for \( r_n(\theta) \). Specifying alternate values for the default \( \theta \)-minimum and \( \theta \)-maximum, and \( \theta \)-step displayed is optional.
   - To graph a scatter plot, select Scatter Plot. The work area and entry line change to scatter plot mode. Click the arrows that display to choose \( x \) and \( y \) for \( s_n \).

3. Press **Enter** or **Tab**.

After your selection is graphed, the entry line changes to enable you to specify another graph of the same type. For example, after you graph \( f_1(x) \), the entry line changes to \( f_2(x) = \) to enable you to enter another function.

As you graph multiple functions on one set of axes, Graphs & Geometry labels each with its function. You can define and graph a maximum of 99 functions of each type. For example, you use function mode to specify functions \((f_1(x) - f_{99}(x)) \). You can also rename multiple functions that use custom names, for example, \( g_1(x) \).

**Note:** If you draw a geometric figure, the entry line may disappear from the page. Press **Ctrl G** to select the Show Entry Line tool (\( \text{Show Entry Line} \)).
Using the entry line expand button

Click the entry line to display a line-by-line history list of the functions entered on the screen. The list displays functions in the order of entry (top to bottom), with the most recent entry closest to the entry line. Use ▲ and ▼ to move up and down the list.

Use the function history to edit, change the attributes of, delete, or hide (or redisplay) a specific function or graph.

Using the Text tool to enter functions

You can graph functions, including functions of the form "y=", by typing them into a text box. To graph a function this way:

1. From the Actions menu, select the Text tool (licted).  
2. Click the work area to place the text box. Type the function you want to graph.
3. Drag the text box to the x-axis, and drop it on the axis. 
Graphs & Geometry graphs the function on the axes.
Regarding how you enter functions, each function is labeled on the graph for identification.

**Graphing inequalities**

Function mode enables you to define a function that uses a symbol other than the equal sign. To change = to a different sign and graph the inequality:

1. Position the cursor to the right of the equal sign.
   
   Press **Backspace** to delete the equal sign.

2. Type the desired sign or use the Symbol Palette to enter the appropriate inequality. The possible inequalities are: >, <, ≤, and ≥.

3. Type the rest of the inequality expression.
   
   Press **Enter** to graph it.

   The expression, as typed, displays next to the graph. Shading is always present on the graphs of inequalities to show the values that satisfy the inequality. If you graph two inequalities that overlap, the area of overlap is shaded darker than either of the individual inequality graphs.

**Renaming f(x)**

fn(x) is the default naming convention for functions and inequalities entered into Graphs & Geometry. The number, represented by n, increases as you enter more functions.

To change fn(x) on the entry line:

1. Place your cursor to the right of the = sign in the entry line.
2. Press **Backspace** until the line is blank.

3. Type the letters/numbers for the system you want to use, and then type the function or inequality you want to enter.

4. Press **Enter** to graph the function.

Notice that the label shown next to the graph is identical to what you entered.

**Note:** When you use a customized naming convention, you must manually rename each function or inequality entered to continue the custom naming convention.

**Editing functions**

You can edit graphed functions, one function at a time. To edit a function:

1. Use one of the following methods to access the function:
   - Press **Esc** and double click the function label on the graph.
   - Use the entry line Expand button or the up arrow to move to the function.

The expression displays in a text box, ready to edit.
2. Move the cursor to the portion of the function you want to change.

3. If you are adding to the expression, type the new characters into the function.
   If you need to delete a portion of the function, remove the unneeded characters and type any new characters.

4. Press Enter to graph the revised function.

Hiding a function on the work area
1. Click the Expand button or press Tab until the Expand button has focus, and then press Enter to display the function history list.

2. Use the function history list to locate the function you want to hide on the work area.

3. Click the Hide/Show button (⊙) to the left of the function.
   The graph of the function as well as its label are hidden on the screen. The Hide/Show button appearance changes in the list to indicate that the function is hidden. To redisplay the function, repeat the steps above.
**Note:** You can also hide a function by first selecting Hide/Show on the Actions menu, clicking the function on the work area, and pressing Esc to exit Hide/Show.

Deleting a function

To remove a function from your graph:

1. Select the function by clicking on its graph.
   
   You can also select a function by using the Expand button to list all functions on the work area, then selecting the function in the list.

2. Press Delete.
   
   The function is removed from the page and from the list of graphed functions.

Clearing the work area

To remove all functions and objects from the work area at one time, select Actions > Delete All

The system displays a delete confirmation box.

1. Select Yes, and all objects and functions are deleted.
   
   The axes remain displayed.

The Trace tools

Graphs & Geometry provides two trace tools:

- Graph Trace - point-by-point trace of the graph for a function, parametric or polar equation, or scatter plot.
- Geometry Trace - trail of functions or objects.
There is also an Erase Geometry Trace tool. This removes all geometry trace echoes from the work area.

**Using Graph Trace**

Using the trace tool is another method of moving about a function, parametric, polar, or scatter plot graph. To enable the trace tool:

1. Select the Graph Trace tool ( ).
   The trace point displays on the graph.
2. The trace cursor can be moved in several ways:
   - Press ▲▼ to move along the function’s graph. The coordinates of each point displays during the trace.
   - Press ►◄ to move from one function graph to another or to a scatter plot. The point's coordinates update to reflect the new location of the trace. The trace cursor is positioned on the point of the new graph or plot with the closest x value to the last point identified on the previously traced function or graph.
   - Type a number and press **Enter** to move the trace cursor to that x value on the function’s graph.

**Notes:**

- When you trace beyond the initially visible graph, the screen pans to show the area being traced.
- To set the Trace Step increment to use between consecutive jumps during the trace, select the Trace Settings tool ( ). Click Enter Value and type the increment. Otherwise, the increment used between the "steps" of the trace is set using the increment specified when you defined the function, as with a function graph for parametric or polar equation.
- To create a persistent point while in Graph-Trace mode, press **Enter**.
- As you approach points of interest such as the maximum or minimum, the one-letter designator and the point's coordinates display. These disappear once you move the trace point beyond them.
- To trace several functions simultaneously, press the up or down arrow key until the cursor becomes a vertical dashed line. The coordinates of the intersection with the dashed line display for each function graph. Use the left/right arrow keys to move the cursor. Vertical movement is not
supported. You cannot trace multiple polar and parametric equations simultaneously.

- If you select another tool, Graph-Trace becomes inactive.

To exit Graph-Trace mode, press Esc.

Using Geometry Trace

The Geometry Trace tool enables you to leave a visible trail of an object when it is moved on the work area. The movement can be done manually or by using the Animation tool.

**Note:** The trace trail cannot be selected or manipulated.

To use Geometry Trace:

1. Create an object or function.

2. From the Trace menu, select the Geometry Trace tool.

3. Click the object or function. Either:
   - manually grab and move the object, or
   - select a point and animate it.

If you use animation, the point must be selected for geometry trace as well as animation.

The amount of trace track displayed on the work area depends upon the amount of movement.

- If the object moves very little, then the entire track remains displayed until you erase it.
- If the object moves a lot, the track can obscure a significant portion of the work area. In this case, the older portions of the
track fade out to prevent the work area from becoming obscured by the track.

In the following example, a line segment was drawn and selected for geometry trace. Movement of the segment was done manually.

**Using Erase Geometry Trace**

The easiest way to remove the trace tracks from the work area without deleting any objects or functions is to select the Erase Geometry Trace tool 🗑️.

When selected, this tool removes immediately all trace tracks from the work area.
Manually manipulating functions

When you have graphed a function, you can use the Pointer tool ( ) to translate, stretch and/or rotate it by grabbing its graph. As you maneuver the graph, its symbolic representation also changes.

You can manipulate the following types of functions:

- Linear function; \( y=b \)
- Linear function; \( y=ax+b \)
- Quadratic function; \( y=a(x-b)^2+c \)
- Exponential function; \( y=\exp(ax+b)+c \)
- Exponential function; \( y=b\exp(ax)+c \)
- Exponential function; \( y=d\exp(ax+b)+c \)
- Logarithmic function; \( y=a\ln(cx+b)+d \)
- Sinusoidal function; \( y=a\sin(cx+b)+d \)
- Cosinusoidal function; \( y=a\cos(cx+b)+d \)
Manipulating a linear function

Initial function graph

Function translated along the $x$-axis. (Notice the revised function label) To translate, “grab” near the middle of the graph then drag.

Manually rotated function. To rotate, “grab” near the ends of the graph then drag.

Manipulating a quadratic function

Original quadratic function

Manually rotated function. To stretch, “grab” away from the vertex of the graph then drag.
Manipulating a sine or cosine function

To translate, “grab” near the vertex of the graph then drag.
Working with multiple objects at one time

You can select multiple objects and perform the same actions on them.

Selecting multiple objects

There are two ways to select multiple objects. To select using the pointer:

1. Click the first object you want to select. Text indicates the type of object selected and the outline of the shape blinks to indicate selection.

2. Move to the second object and click it.

3. Continue selecting objects in this way until all are selected.

   As each object is selected, its shape outline blinks.

To deselect objects:

1. To deselect one selected object, click the object again.

2. To deselect all selected objects, click on a space without any objects.

To select using a selection box:

1. Click once on a space without any objects.

   As you move the cursor, a box outline appears on the screen.

2. Move the cursor around the screen until all or a part of all the objects you want to select are contained in the box.

3. Click a second time to complete the selection box.

   Note: If you need to select an individual object from a group of objects, you can use a selection box to activate the group. After the
objects begin to blink, position the cursor on or press **Tab** to reach the object you want to select and press **Enter**.

To cancel the selection box selections:

1. To cancel the selection box before it is completed, press **Esc** or 
2. To cancel the selection box after it is completed, click on a clear space in the work area without any objects or press **Esc**.

**Deleting multiple selections**
- To delete multiple selected objects, press the delete key on the computer keyboard.

**Note:** The origin and the axes cannot be deleted even if they are selected for deletion.

**Moving multiple selections**

1. To move all selected objects, move the cursor to one of the objects. The cursor changes to indicate that the object can be grabbed.
2. “Grab” the object and move it to the new location. All other selected objects will move along with the object moved by the cursor.

**Note:** If any non-moveable object is selected with moveable objects, then all objects must be moved individually. Examples of objects that cannot be moved in a multiple selection are objects attached to an axis, locked objects, and objects defined by one or more objects with a locked point or value.

**Drawing and working with points and lines**

In addition to graphing functions, you can also use the axes to draw points and lines. The types of points and lines you can create are:

- Points: Point, Point on, Intersection point(s)
- Labeling and naming a point
- Redefining a point
- Lines
- Rays
- Segments
- Segment with defined midpoint
- Parallel line
Points

There are three tools for creating points:

- Point
- Point On
- Intersection Point

Creating a point

You can create an independent, moveable point using the Point tool.

1. From the Points & Lines menu, select the Point tool (●).
2. Move to the work area, and click to create a point.

You can move the point about the graph using the Pointer ( направленная стрелка).

Note: Although two points define a line, you do not create lines with the Point tool.

Creating a point on a specific object

1. From the Points & Lines menu, select the Point On tool (●).
2. Click on an object to create a specific point on the object.

You can move the point about or along the object using the Pointer ( направленная стрелка).
Defining an intersection point(s)

**Note:** To use this tool, two drawn objects must have one or more intersection points.

1. From the Points & Lines menu, select the Intersection Point tool ( ).
2. Click on one object near its intersection with a second object.

The exact intersection point between the two objects is drawn. If the two objects intersect in more than one place, all intersection points are drawn.

Labeling (identifying) a point

You can identify the coordinates of any Analytic point (which you construct in the Graphing View, or within the Analytic Window of the Plane Geometry View) using the Coordinates and Equations tool ( ). To label a point:

1. From the Graphing view, create a point if it does not exist.

   You can also select a point on an object using the Point On tool ( ).

---

**Using Graphs & Geometry**

115
2. From the Actions menu, select the Coordinates and Equations tool.

   Move the cursor toward the point’s location, and the coordinates blink.

3. To add the coordinates to the work area, click to select the point and then press Enter, or click the point to anchor the coordinates on the work area.

   The coordinates stop blinking and are displayed in parentheses. The format used is based upon the Locale you selected.

If you move the point to a different location, the new coordinates are updated to the new position.

**Naming a point**

You might not need to label a point but instead, you want to name it for easy reference. You can name points and vertices, regardless of the Graphs & Geometry work area view. Since they are not tied to a specific coordinate, names remain unchanged if you alter the location of any portion of an object. There are two methods for creating names.

1. One method is to use the Text tool after you create an object.
2. A second method is to name them as you create them. To add a name as you create an point, type a letter or name immediately after you define the point.

For example, when creating a triangle, typing the letter “x” after creating the first vertex names that vertex “x”. The two remaining vertices can be named “y” and “z” in the same way when they are created.

**Redefining a point**

You can redefine a point from an open area to an object, from one object to another, or from the analytic to the geometric zone (or vice versa.) To redefine a point:

1. Create a point.
   (Note that in the examples, the point coordinates are labeled.)

![Diagram of a point with coordinates (10, 8.5)]

2. From the Actions menu, select the Redefine tool (Redefine tool).

3. Select the point to be redefined, then select the object.
   The point moves to the object.

![Diagram of a point with coordinates (5.8, 5.7)]

**Note:** A point can be redefined from one object to another. The procedure is the same as described above.
In these examples, the point is redefined from the circle to the segment.

**Linear objects**

The linear objects you can create and explore are located on the Points & Lines menu. Graphs & Geometry creates “smart” lines and rays. This means that the meaningful portion of the line or ray is displayed rather than having the object project to infinity. This feature reduces clutter on the work area.

**Creating a line**

1. From the Points & Lines menu, select the Line tool ( ).
2. Click a location to start your line.
   This click defines one point on the line.
3. Move and click again to define the direction of the line.
   Graphs & Geometry draws the line.

   ![Creating a line](image)

**Note:** If you hold down the *Shift* key while creating the line, you limit its orientation, relative to the x-axis or the horizontal aspect of the screen, by 15° increments.

**Creating a ray**

1. From the Points & Lines menu, select the Ray tool ( ).
2. Click to define the endpoint of the ray.
3. Move the cursor and click again to define the direction of the ray.
   Graphs & Geometry draws the ray.

You can create a ray anywhere in the work area, regardless of the axes’ location.

**Note:** If you hold down the Shift key while creating the ray, you limit its orientation, relative to the x-axis or the horizontal aspect of the screen, by 15° increments.

**Creating a line segment**

1. From the Points & Lines menu, select the Segment tool ( ).
2. Click to define the first endpoint of the segment.
3. Move the cursor and click again to define the second endpoint of the segment.
   Graphs & Geometry draws the segment on the page.

**Note:** If you hold down the Shift key while creating the segment, you limit its orientation, relative to the x-axis or the horizontal aspect of the screen, by 15° increments.
Creating a line segment with defined midpoint

With the Midpoint tool ( ), you can define a midpoint:

- on an existing line segment,
- between two specified points on a line,
- between two points on a page as you create the points. The midpoint is located and identified between the points. When the second point is selected, the midpoint is also created on the page.

1. From the Construction menu, select the Midpoint tool ( ).
2. Click at the location to start the segment.
   
   As you move the cursor on the work area, a second end point appears. In between the starting point and this end point, you will see the midpoint.
3. You can move the segment in any direction until you click on the work area a second time.
   
   With the second click, the segment is anchored and the midpoint remains identified.

4. If you are defining the midpoint of a segment or a segment on a line, click at the first endpoint of the segment.
5. As you move the cursor along the segment or line, a second endpoint and the midpoint appears.
6. Click at the second endpoint to define the segment and anchor the midpoint.
Repositioning segments with midpoints

1. To reposition the segment after placing it on the work area, click the Pointer tool ( )

2. Select the segment and drag it to a new location without changing its orientation or length, or select one endpoint and drag it to a new location.

   If just an endpoint is moved and if the length of the segment changes, then the midpoint is repositioned to remain at the middle of the segment.

Creating a parallel line

You can create a parallel line with respect to any existing line on the work area including the axes, and the side of any triangle, square, rectangle and polygon.

1. From the Construction menu, select the Parallel tool ( )

2. On the work area, click once on an existing line, segment, or axis.

   This click identifies the reference line for the new parallel line you are creating.

3. Move the cursor away from the reference line, axis, or segment.

   Notice that a dotted line displays, representing the parallel line.

4. When the dotted line is in the desired position, click again to anchor it on the work area.
Creating a perpendicular line

You can create a perpendicular line with respect to any existing line or segment in the work area including the axes, and the side of any triangle, square, rectangle or polygon.

1. From the Construction menu, select the Perpendicular tool (\(\text{\textbullet}\)).
2. Move the cursor onto the work area and click a point through which the perpendicular line should run. A dotted line shows the position for the perpendicular line.
3. Click again to anchor the perpendicular line. The dotted line changes to a solid line.

**Note:** You can also click first on the work area and then select the reference line to create the parallel line.
Note: Alternatively, you can double-click the line or segment to create at the point where you want the perpendicular line to intersect.

4. To move the perpendicular line to a different location on the reference line, select the Pointer tool ( ).

5. Click the intersection point and drag the point and perpendicular line to the new location.

Creating a vector

1. From the Points & Lines menu, select the Vector tool ( ).
2. On the work area, click the spot from which the vector originates.
3. Move the cursor in the direction of the vector.
   A dotted line follows the cursor as you move about the area.

4. When the vector is in the correct position, click to anchor the vector on the work area.
The dotted line changes to a solid line.

**Note:** If you hold down the **Shift** key while creating the vector, you limit its orientation, relative to the x-axis or the horizontal aspect of the screen, by 15° increments.

![Vector anchored to page](image)

**Moving a vector**

1. Select the Pointer tool (]
2. Click on any point other than the endpoint and drag the vector to the desired location.

**Resizing a vector**

- Select the end point and drag it to the new location.

**Note:** If the endpoint is located on an axis, you can only move the endpoint of the vector along the axis.

**Creating a tangent**

You can create a tangent by identifying a specific point on an existing object or function. To create a tangent line:

1. From the Points & Lines menu, select the Tangent tool (■).
2. On the work area, select the point at which you want the tangent drawn.
   
   A dotted tangent line blinks on the work area.
3. Click or press **Enter** to anchor the tangent on the work area.
Creating and working with objects (shapes)

With Graphs & Geometry, you can draw:

- Circles
- Triangles
- Rectangles
- Polygons
- Regular Polygons

Creating a circle

1. From the Shapes menu, select the Circle tool (⊙).
2. On the work area, click once to establish the center of the circle.
   - Move the cursor away from this point.
   - You will see a circle with a dotted circumference line emerge as you move the cursor.
3. When the circle has the radius you desire, click again.

The dotted circumference changes to a solid circumference in the work area.

This second click does not define a point on the circumference; instead, it completes the circle construction.

Note: If you hold down the Shift key when creating the circle, the radius is limited in length to integers.

Moving a circle

You can move the circle to a different location without resizing it,

1. Select the Pointer tool (⿴)
2. Select the circle’s center point.
3. Drag the circle to the new location.

Resizing a circle

1. Select a point on the circumference.
   The circle blinks.
2. Drag the circle inward or outward to increase or decrease the circumference.

3. Release the mouse button to anchor the circle in the work area.

**Creating a circle with the Compass tool**

You can also create a circle with the Compass tool.

1. From the Construction menu, select the Compass tool ( ).

2. Move the cursor to the page and
   - select the segment to use as the circle’s radius or
   - define two points.
   
   The distance between these points will become the radius length for the circle.

3. When you select the segment, a circle displays with the center point positioned under the cursor.

4. Move the circle to the desired location.

5. Click to change the circumference from a dotted line to a solid line and anchor the circle on the page.
You can use a measured length for the radius of a circle.

1. Select a segment or the side of a triangle or rectangle.
2. Measure the length, and display the length value on the page.

3. Select the Compass tool ( )
4. Click the length value.

A circle with the radius of the selected length automatically appears.

**Note:** To use an expression or stored variable as the radius of a circle, use the Text tool on the Actions menu. For example, create a text box, type 2+3, press Enter. Select the Compass tool, click on the text box. A circle with radius 5 is displayed.

5. Move to the desired location for the circle (it will follow as you move), and click to anchor it on the page.

   The circumference line changes from dotted to solid.
Creating a triangle

1. From the Shapes menu, select the Triangle tool (△).
2. On the work area, click once to establish the first vertex of the triangle.
3. Move the cursor to the location for the second vertex and click again.
   Notice that the side of the triangle is shown as a dotted line.
4. Move the cursor to the location of the last vertex.
   As you move the cursor, all sides of the triangle are shown as dotted lines.
5. Click again to create the final vertex and anchor the triangle on the work area.
   The sides are defined by solid lines.

Moving a triangle

You can move the triangle to a different location without resizing it.

1. Select the Pointer tool (►)
2. Select one side of the triangle.
3. Drag it to the new location.

**Reshaping a triangle**
1. Click one of the three vertices.
2. Move the selected point until the triangle is the correct size.

**Creating a rectangle**
1. From the Shapes menu, select the Rectangle tool ( ).
2. Click once to establish the first corner of the rectangle.
3. Move the cursor to the location for the second corner, and click again.
   One side of the rectangle is defined.
4. Move the cursor away perpendicularly from the side to the line.
   The outline of the rectangle appears on the screen.
5. When the rectangle is of the correct size, click again to anchor the rectangle to the work area.
Creating a polygon
You can create a polygon by defining three or more connected points. While you can create a triangle using the Polygon tool ( ), using the Triangle tool ( ) reduces keystrokes. To construct a polygon:

1. From the Shapes menu, select the Polygon tool ( ).
2. On the work area, click once to establish the first point of the polygon.
3. Move the cursor to the location for the second point and click again. Notice that the side of the polygon is shown as a dotted line.
4. Move the cursor to the location of the next point. As you move the cursor, the polygon's sides display as dotted lines. Continue to move the cursor and click to create as many sides as needed.
5. To complete the polygon and anchor it on the work area, do one of the following:
   – double click the final point,
   – click on the initial point, or
   – press Enter.

   The sides are defined by solid lines.

**Note:** If you create a polygon with all defined points colinear, then the construction is defined as a segment.

**Moving a polygon**
1. Select the Pointer tool ( ).
2. Select one side of the polygon.
3. Drag it to the new location.

**Reshaping a polygon**
1. Select one of the vertices.
2. Drag it to a new location.
3. Click to re-anchor it on the work area.

**Creating a regular polygon**

1. From the Shapes menu, select the Regular Polygon tool (▃▃).
2. Click once on the work area to establish the center point of the regular polygon.
3. Move the cursor away from the center point and click on the work area again to establish the first vertex and radius.

A 16-sided regular polygon is formed. The number of sides displays near the center point in brackets; e.g., {16}.

   - To reduce the number of sides, select a vertex and move the pointer in a clockwise motion around the perimeter of the polygon.
   - To increase the number, select a vertex and move the pointer in a counter-clockwise motion.

**Note:** The number of sides of the polygon displays as you move the pointer.

4. When the desired number of sides displays, click to anchor the polygon on the work area.
Transferring Measurements

You can duplicate (transfer) a specific length to a new object using the Measurement Transfer tool ( ).

The objects you can transfer a length to are:

- a circle - the length transferred becomes the radius of the circle. You can also transfer a measurement onto a circle to define an arc.
- a ray - the length transferred starts at the endpoint and defines a second point on the ray
- a vector - the length transferred starts at the endpoint and defines a second point on the vector

You can also transfer a numeric text value to an axis.

Transferring a measurement

1. Measure and display the length or area that you want to transfer. If you want to transfer the measurement to a ray or vector, create these objects if they do not already exist on the work area.

2. From the Construction menu, select the Measurement Transfer tool ( ).

3. On the work area, select the measurement value you want to transfer to a new object.
a) To create a circle, select the Circle tool \( \bigcirc \). When you move to the work area, the circle immediately appears. Its radius is the transferred measurement.

b) Click to anchor the circle on the work area.

4. If you are transferring a measurement to a line, ray or vector, click on the object.

The distance between the two defined points is the transferred measurement.

**Note:** If you adjust the length of the initial measurement, all objects you create with that measurement are adjusted automatically to reflect the change.

**Transferring a numerical text entry to an axis**

1. Using the Text tool \( \overline{\text{Ab}} \), create the number on the work area.
2. From the Construction menu, select the Measurement Transfer tool (\text{Measurement Transfer tool}).

3. Select the created number, then click on the desired axis.

   The value is marked by the addition of a point on the axis. In the example below, this point is labeled to show its value.

Transferring a measurement onto a circle

1. Either enter a value using the Text tool (\text{Text tool}), or display a measurement on the work area.

   Create a circle using the Circle tool if one does not already exist on the work area.

2. Select the Measurement Transfer tool (\text{Measurement Transfer tool}).

3. Select the value and the circle.

4. Click on the circle a second time to define the starting point for the transferred measurement.
The measurement is transferred in a counter-clockwise direction, and the starting and ending points of the value are marked by points. The arc defined on the circle has the same measure as the transferred value.

![Diagram](image)

The segment length was transferred onto the circle. The two points on the circle define this length. The hand cursor shows the starting point for the transfer.

**Note:** If you measure the distance between the two points on the circle, the value will be less than the transferred measurement. The straight line between the points is measured, not the arc formed between the two points. The arc's length is the transferred measurement.

**Measuring graphs and objects**

You can obtain various measurements from the functions you graph and the objects you draw. These measurements include finding areas, perimeters, lengths, angles, and slopes. The metric system is the default for units of measurement.

**Note:** Document settings are available under the **File** menu.

**Identifying equations for circles and lines**

You can display the equation of any Analytic object (constructed in the Graphing View, or within the Analytic Window of the Plane Geometry View) and label it on the screen. To do this:

1. On the Graph work area view, create a circle or line.
2. From the Actions menu, select the Coordinates and Equations tool (yalg).
3. Click or press **Enter** to select the circle or line.
   - The equation for the circle or line displays and the object blinks on the screen.
4. Click or press **Enter** to anchor the equation on the screen.
**Note:** If you approach a defined point on the line or the center point of a circle, the coordinates for that point display instead of the equation. Move the cursor away from the defined point to obtain the equation of the object.

**Measuring length**

You can measure the length of a segment, vector, distance between two points, distance from a point to a line/ray/segment/vector, and distance from a point to a circle.

**Note:** Measurements made on Graph view objects and lines have generic units, u. Measurements made on Plane Geometry view objects and lines have the unit value you create. The default unit value is cm.

1. From the Measurement menu, select the Length tool ( ).

2. To measure a segment or vector:
   a) Click or press **Enter** to select the object.
      
      The target segment or vector blinks.
   
   b) Click or press **Enter** to anchor the measurement on the work area.
      
      Note that a line segment can be part of a triangle, rectangle, or polygon.
3. To measure the distance between two points, between a point and a line, or between a point and a circle:
   a) Select the first point.
   b) Select the second point or a point on the line or circle. The selected length blinks.
   c) Click or press **Enter** to anchor the value on the work area.

4. To measure the length of one side of a triangle, rectangle, or polygon:
   a) Select each endpoint of the segment.
   b) Click or press **Enter** to anchor the value on the work area.

   **Note:** The value that displays when you initially approach the object (before selecting the endpoints of the side) is the perimeter of the object, not the length of the one side.

The measurement remains visible and close to the measured objects even if you move one or both of the objects or measurement points. If you move an object or point, the measurement updates to reflect the new distance.
Finding the area of a circular disc, polygon, rectangle or triangle

1. From the Measurement menu, select the Area tool ( ).
2. On the work area, click or press Enter to select the object.
3. To anchor the value on the work area, click or press Enter.

The measurement remains visible and close to the object even if you change the size of the object. If you alter an object, the measurement updates to reflect the new area value.

Finding the perimeter of a circular disc, polygon, rectangle or triangle

1. From the Measurement menu, select the Length tool ( ).
2. On the work area, click or press Enter to select the object.
3. To anchor the perimeter value on the work area, click or press Enter.
The measurement remains visible and close to the object even if you change the size of the object. If you alter an object, the measurement updates to reflect the new perimeter value.

**Finding the measure of an angle**

1. From the Measurement menu, select the Angle tool (\[\text{[\text{Angle}]\text{]}\]).
2. If the angle you want to measure exists on this space, click once on one side of the angle.
3. Click on the vertex.
4. Click once on the second side of the angle.
   The measure of the angle you defined appears near it.
5. Click or press **Enter** to anchor the value on the work area.

**Defining an angle with three points**

You can define and measure an angle by selecting three points on the work area.

1. From the Measurement menu, select the Angle tool (\[\text{[\text{Angle}]\text{]}\]).
2. Click once on the work area.
The first click represents one side of the angle.

3. Click a second time on the work area.
   The second click represents the vertex.

4. Click a third time on the work area.
   The third click represents the second side of the angle. The measure of this angle appears on the work area.

5. Click or press **Enter** to anchor the value.
   The measurement remains visible and close to the angle even if you change the size of the angle. If you alter the angle, the measurement updates to reflect the new value.

**Notes:**

- The value of any angle will always be between $0^\circ$ and $180^\circ$ in degree mode or between $0^\circ$ and $\pi$ in radian mode.
- The default angle measure is in radians. To change it to degrees or gradians, change the document settings.
- You can increase the precision of the angle measurement by placing the pointer on top of the measurement and then pressing + or - to increase or decrease the number of displayed digits.

**Repositioning a measured value**

1. Select the Pointer tool ( ).

2. Select and drag the measurement to the desired location.

**Finding the slope of a line, ray, segment or vector**

1. From the Measurement menu, select the Slope tool ( ).

2. On the work area, click or press **Enter** to select the object.
3. Click or press **Enter** to anchor the value on the work area.

![Graph with slope value -0.9]

The slope remains visible and close to the object even if you alter the slope. Note that the value changes as the object is moved.

**Note:** If the object is vertical, the slope value is $-\infty$ or $+\infty$. If the object is horizontal, the slope value is 0.

**Adding text to the work area**

You may want to add your own text to a page or enter a numerical value to use on the work space. Graphs & Geometry enables you to do this using the Text tool ($\text{Text}$).

1. From the Actions menu, select the Text tool ($\text{Text}$).
2. On the work area, select the location to add text, and click.
   
   A blinking cursor appears at the spot you selected.
3. Type your text.

![Text on the work area]

You are limited to typing the text that will display on the page.
If you use the Text tool (\text{Text tool}) to enter numerical values, these are interpreted as numbers by Graphs & Geometry and can be used for computing or specifying measurements.

4. Click again or press *Enter* to anchor the text on the work area.

To exit this mode, select another tool or save your work.

**Moving text**

1. Select the text with the Pointer tool (\text{Pointer tool}).
2. Drag it to the new location.
3. Click the text to anchor it in the new position.

**Using the Calculate tool**

The Calculate tool (\text{Calculate tool}) enables you to perform arithmetic calculations using measured and entered values. An example best shows how this tool is used.

1. Create an object and display measurements for it. In this example, a triangle is constructed and its angles are measured.

![Diagram of a triangle with angles and measurements]

2. Use the Text tool (\text{Text tool}) to write the desired formula. Here, the angle measurements are added.

![Diagram with the formula a+b+c]

3. Select the Calculate tool (\text{Calculate tool}).
Select the formula just created, then select each angle measurement.

4. When all variables in the formula have values, the answer displays on the work area.

5. Click to anchor the value.

**Exploring functions, graphs, and objects**

Once you create graphs and objects, you can use other tools to explore various relationships among and between them.
Finding points of interest: zeroes, minima, maxima

When you create a graph, you can use the Point On tool ( ) to locate the zeros, minima, and maxima if these are applicable for objects on the work area. (They may not display if their location on the graph not visible on your screen.) Both local and global points of interest display.

Note: Global points of interest display only when they are also local. For example, inverse sine reaches its (global) maximum at x=1, but the tooltip 'M' does not display there since it is not a local maximum.

To find them, just move the point along the object or graphed line, and when you are near a point of interest, the coordinates display along with one of the following identifiers:

- Zeroes: z (Coordinates)
- Minimum: m (Coordinates)
- Maximum: M (Coordinates)

Finding the min and max of a function

To find the minimum or maximum of a function or object on the graph:

1. From the Points & Lines menu, select the Point On tool ( ).
2. Select the function graph or object.
3. From the Actions menu, select the Pointer tool ( ).
4. Select the point created in Step 2 and drag it along the function graph or object.

As you approach a point of interest, the one-character identifier along with the point’s coordinates display. The example below shows the m (minimum) identifier along with the value of the minimum for the function graphed on the axes.
5. As you move away from the point of interest, the identifier no longer displays on the page.

**Finding the definite integral of a function**

1. Select the function.

2. From the Measurement menu, select the Integral tool ( ).

3. Define the range for the integral, both the upper and lower limit. Do this by clicking on the function to display a limit boundary line.

4. When the boundary line is in the desired location, click to anchor it on the page.

5. Move the cursor to display the second limit boundary line.

6. When it is correctly located on the page, click to anchor it.
Notice that the integral between the bounds and with respect to the x-axis is shaded on the page.

**Tips:**
- To stop the boundary line at a tic mark on the x-axis, select the tic mark.
- For precise integral boundaries, type a numerical value instead of graphically placing either or both lower and upper boundary lines.

**Finding the derivative of a function at a point (the slope)**
1. Graph a function.
2. Select a point on the graph.
3. From the Points & Lines menu, select the Tangent tool ( ).
4. Construct the tangent at this point.
5. From the Measurement menu, select the Slope tool ( ).
6. Determine the slope at the tangent.
   This is the value of the derived function for the selected value of $x$.
7. Click to anchor the value on the page.

Transformations

You can apply transformations to drawn objects, and some can be applied to functions. When working with functions, the axes are most frequently involved and may be required. Object transformations can occur without the use of axes as a reference point.

The transformations supported by Graphs & Geometry are:
- Symmetry with respect to any point, including the origin
- Reflections with respect to any straight line, including the axes
- Translations along any vector, including vectors on the axes
- Rotations about any point, including the origin, and any angle
- Dilations from any point, including the origin, with any factor

The first step in any transformation is to create an object or the graph of a function.

Exploring symmetry

1. Create an object or graph a function.
2. Create a point of symmetry using the Point tool ( ).
3. From the Transformation menu, select the Symmetry tool (\(\bullet\bullet\)).
4. Select the object, then select the point.
5. The symmetrical image displays.

**Exploring reflection**
1. Create an object.
2. Create a line or segment about which the object will be reflected.
3. From the Transformation menu, select the Reflection tool (\(\downarrow\cdot\)).
4. On the work area, select the reflection line or segment.
5. Select the object.
   The object reflection displays on the page.
6. To anchor the reflection, click on the page or press **Enter**.

**Exploring translation**

1. Create an object to translate (duplicate).
2. You can define the distance and direction of translation by
   - creating a vector, or
   - selecting two points “on the fly”.

   To use a vector, define it before performing the translation. The examples use two points to define translation distance and direction.
3. From the Transformation menu, select the Translate tool ( ).

4. Select:
   - the vector or click on the page to define the translation direction and distance
   - the translation object.

The translated object displays.

Exploring rotation
1. Create an object or graph a function.
2. Create a point about which the object will be rotated.
3. Create three points whose angle defines the angle of rotation, or using the Text tool ( ), type a numeric angle value.
4. Press Enter to anchor the value on the work area.
5. From the Transformation menu, select the Rotation tool ( ).

6. Move to the work area and select
   a) the point about which the object will be rotated, and
   b) the object to rotate, and
   c) the three points that define the angle of rotation or the numeric angle value.

The object is recreated in the rotated position as defined by the rotation point and angle of rotation.

**Exploring dilation**

1. Create an object.

2. Create a point that is the center of the dilation.

3. Create a number using the Text tool ( ) or measure an existing length.

   **Note:** If you type a large number, the dilated object will not display on the work area without panning.
4. From the Transformation menu, select the Dilation tool ( ).

5. Select the value measured or created, the dilation point, and then move toward the object.

The dilation appears on the work area.

In the following example, the polygon from the previous example was retained, but a negative number was entered using the Text tool ([Ab]).
**Other investigations**

You can investigate graphs by

- Bisecting segments
- Bisecting angles
- Finding the Locus

**Bisecting a segment defined on a line**

1. From the Construction menu, select the Perpendicular Bisector tool (\(\text{Perpendicular Bisector}\)).
2. Click on the line to select one end point for this segment.
3. Move to another point on the line and select it.

   The segment is now defined, and the perpendicular bisector is drawn.
Bisecting a segment

1. From the Construction menu, select the Perpendicular Bisector tool \( \square \).
2. Click the segment.
   
   The perpendicular bisector displays.
3. Click once more to anchor the bisector on the work area.

   **Note:** A segment can be one side of a triangle, rectangle, or a polygon.
Bisecting an implied segment

1. From the Construction menu, select the Perpendicular Bisector tool ($\perp$).
   You imply a segment by defining two points.

2. Click once to define one end of the implied segment.
   As you move away from this point, a segment and the bisector appear.
3. Click a second time to define the other end of the implied segment and anchor the segment and bisector.

**Bisecting an angle**

1. From the Construction menu, select the Angle Bisector tool (\(\angle\)).
2. If a triangle or other angle already exists on the work area, click once on one side of the desired angle.
3. Click once on the vertex.
4. Click once on the second side of the angle.
   The bisector is anchored on the work area.
Bisecting an implied angle

1. From the Construction menu, select the Angle Bisector tool ( ). If no angle is present on the work area, you can create one by selecting three different points.

2. Click to define the first side of the angle.

3. Click to define the vertex of the angle.

4. Click to define the second side of the angle.

   The bisector line appears and is anchored on the work area when you select the third point.
Note: If you select the Pointer tool ( ) and move one point of the created angle, the angle bisector moves so that it always bisects the angle.

Creating a locus

The Locus tool ( ) enables you to explore the range of motion of one object with respect to another object as constrained by a shared point.

To create a locus:
1. Create a segment, line, or circle.
2. Create a point on the segment, line or circle.
3. Create another object that uses the defined point created in the previous step.
4. From the Construction menu, select the Locus tool ( ).

5. On the work area, select the last object.

6. Select the defined point used by both objects.
   The continuous locus picture is displayed.

7. Move the point on the first construction.
   The second construction deforms to follow the locus point.

   Two examples of the radius change of the circle as the locus moves along the line segment. The radius is labeled to better show the change.

You can create and explore a large number of designs using the Locus tool and your imagination. The following are examples of a few structures that you can create.
Animating objects

You can animate a point on a line, ray, axis, vector, graph, segment or circle. In addition, you can also animate points on multiple objects in the work area at one time.

Animating one point on an object

1. From the Points & Lines menu, select the Point On tool ( ).
   Click on the object to identify the point that you want to animate.
2. From the Actions menu, select the Attributes tool ( ).

When the attribute bar displays, select the animation attribute ( ).

3. The default speed is 0. You can type a number from 1 - 9 to set speed or you can use < or > to select a speed from -12 to 12.

The higher the number you type, the faster the animation speed.

4. Select $\rightarrow$ for one-way animation or $\leftrightarrow$ for oscillating animation.

5. Animation begins automatically when you select the speed and direction.

Press $\uparrow$ and $\downarrow$ to increase/decrease the speed of animation incrementally once it is set.

**The animation control panel**

Once a point is animated, a floating control panel displays on the page. You can move this panel by dragging it to a new location.

When animation is active, the panel contains a Reset $\leftarrow$ and a Pause $\rule{1cm}{0.1mm}$ button. When either button is pressed and animation is reset or paused, the Pause button changes to a Start $\rightarrow$ button. These controls affect all animated points on a page.
Changing the animation of a point in motion

To change the speed of a point’s movement or the direction of animation:

1. Reset or pause the animation.
   a) Select the Attributes tool ( ).
   b) Select the point you want to change.
   c) When the attribute bar displays, select the animation attribute ( ).

2. To change the speed, type a new velocity number.

3. To change the direction of animation, press ← or → to select the desired direction.

4. Press the Start ➤ button.
   The point moves at the new speed and/or in the new direction you selected.

Pausing and resuming animation

To pause the animation on a page, select the Pause button.

To restart animation, select the Start button.

Resetting animation

Selecting the Reset button not only pauses animation but also returns the animated point to its initial coordinate position on the object when animation was first started. If multiple points are animated on the page, all are returned to their original locations when you select Reset.

Stopping animation

To stop the animation of an object:

1. Select the Pause or Reset button on the control bar.
2. Display the Animation attribute for the point.
3. Change the speed to 0 (zero).
4. Click an empty area of the screen to apply the change, or press Enter.
5. Select Start to resume animation if other animated points were temporarily stopped.
If no other animated points are on the page, the animation control box does not reappear when the velocity is set to 0.

**Note:** If you have multiple points in motion on one page and want to permanently stop the animation of all objects, when motion is paused or stopped, display the attributes bar for each point and change the velocity to 0.

**Plotting collected data**

In addition to using Graphs & Geometry by itself, you can use it to explore the data collected from scientific instruments or stored in lists. Using data to create plots can be more helpful in understanding and interpreting data than just examining the raw values.

**Creating a scatter plot**

If you do not have an existing set of data points available for plotting, create them on the same page using the Lists & Spreadsheet application.

1. To create the data lists and scatter plot on the same page, select a page configuration with two work areas.
2. Create the data lists on the Lists & Spreadsheet portion of the page.

3. Select the Scatter Plot tool ( ).

4. Select the lists to plot from the drop down list for each axis.

When both entry fields have a data list specified, the scatter plot displays on the Graphs & Geometry work area.
5. To label the points on the scatter plot, select the Point On tool ( ) from the Points & Lines menu.

   a) Select the first point. 
       The coordinates display.
   b) Click to anchor the values on the work area.

   c) To label the remaining points, select them one at a time.
6. Label the axes and significant points, if desired.

**Note:** If you have plotted more than one set of data, notice that each plot has a different point style.

You can use Graphs & Geometry to examine the differences between points in one data set or between two or more sets by determining the slope between points, comparing min and max points, and/or calculating overall change over elapsed time.
Using Data & Statistics

The Data & Statistics application provides tools to:

- visualize sets of data in different types of plots.
- directly manipulate data sets to explore and visualize data relationships. Data changes in one application are dynamically applied to all linked applications.
- explore central tendency and other statistical summary techniques.
- fit functions to data.
- create regression lines for scatter plots.
- graph hypothesis tests and results (z- and t-tests) based on summary statistics definitions or data.

**Note:** In the following example, Lists & Spreadsheet is shown along with Data & Statistics. This represents a typical page set-up.

1. Data & Statistics tool menu (displays when a Data & Statistics work area is active)
2. Sample Data & Statistics work area
3. Problem/Page number counter
The Tool menu

The Data & Statistics tool menu provides tools to graph and explore data, modify data representations by using different plots, as well as perform and plot statistical analyses.

The following tables describe what each tool does in the Data & Statistics work area.

Tool Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Overview of Tool Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot type</td>
<td>Provides access to the different plot types available in the Data &amp; Statistics application.</td>
</tr>
<tr>
<td>Plot properties</td>
<td>Allows you to specify how the plot displays</td>
</tr>
<tr>
<td>Actions</td>
<td>Lets you add/remove items to your work area. This includes movable lines for manually fitting data, regression curves and functions.</td>
</tr>
<tr>
<td>Window/Zoom</td>
<td>Lets you specify a zoom factor for the window, or determine min and max values for the horizontal and vertical axes.</td>
</tr>
</tbody>
</table>

Plot Types Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dot Plot</td>
<td>Depicts data in a dot plot. This is the default plot type for a single variable of the data set.</td>
</tr>
<tr>
<td>Box Plot</td>
<td>Displays data in a box plot.</td>
</tr>
<tr>
<td>Histogram</td>
<td>Displays data in a histogram.</td>
</tr>
<tr>
<td>Normal Probability Plot</td>
<td>Displays data in a normal probability plot. Data is grouped against the z-value that corresponds to its quartile/normal score. This plot type is useful for checking for normality and determining the appropriateness of a normal model.</td>
</tr>
<tr>
<td>Scatter Plot</td>
<td>Displays data in scatter plot form. This is the default plot type for two variables of the data set.</td>
</tr>
</tbody>
</table>
### Tool name | Tool function
---|---
| X-Y Line Plot | Displays data as an x-y line plot.

**Plot Properties Menu Tools**

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
</table>
| Connect Data Points | Draws a line between each point on a scatter plot. Lines are connected in the order of data entry in the horizontal axis data set. This is the same as the X-Y Line plot type.
| Histogram Properties | Determines how histogram data displays in the work area.
| Count | Displays data in the histogram by occurrence in the data set.
| Percent | Displays data in the histogram by each bin’s percent value of the whole data set.
| Density | Displays data in the histogram by data density.
| Bins | Displays a dialog for setting the histogram values for bin width and alignment.
| Extend Box Plot Whiskers/ Show Box Plot Outliers | Extend Box Plot Whiskers extends the whiskers to the min and max of the data. Show Box Plot Outliers stops at 1.5 * Interquartile Range and shows outliers as individual dots. Note: If there are no points outside of 1.5 * Interquartile Range, there may appear to be no whisker change.
| Add X Variable | Adds a variable to the horizontal axis when no variable is assigned.
| Remove X Variable | Removes the display of the variable assigned to the horizontal axis without changing the vertical axis.
| Add Y Variable | Adds a variable to the vertical axis to support the plotting of multiple variables.
## Tool name | Tool function
--- | ---
Remove Y Variable | Toggles the display of the variable assigned to the vertical axis without changing the horizontal axis.

### Actions Tool menu

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select all Points" /></td>
<td>Selects all points in the work area.</td>
</tr>
<tr>
<td><img src="image" alt="Add Movable Line" /></td>
<td>Adds a line you can position and reposition in the work area. This can be used for manual fit.</td>
</tr>
<tr>
<td><img src="image" alt="Remove Selected" /></td>
<td>Removes the selected object. Changes to Remove Movable Line, Remove Regression, Remove Plotted Value, Remove Plotted Function, depending on what is selected.</td>
</tr>
<tr>
<td><img src="image" alt="Lock Intercept at Zero/ Unlock Movable Line Intercept" /></td>
<td>Locks the intercept of the movable line at zero. <strong>Note</strong>: This tool is only available when a movable line or regression line is present in the work area.</td>
</tr>
<tr>
<td><img src="image" alt="Regression" /></td>
<td>The regression tools perform the selected regression calculation and then plot the regression model. Regressions are only available on Scatter plots of X-Y line plots.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Linear (mx+b)" /></td>
<td>Calculates and displays the linear regression line in the format, ( mx+b ), for the plotted data.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Linear (a+bx)" /></td>
<td>Calculates and displays the linear regression line in the format, ( a+bx ), for the plotted data.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Median-Median" /></td>
<td>Calculates and displays the Median-Median regression line for the plotted data.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Quadratic" /></td>
<td>Calculates and displays the Quadratic regression model for the plotted data.</td>
</tr>
</tbody>
</table>
### Tool name | Tool function
--- | ---
Show/Hide Cubic | Calculates and displays the Cubic regression model for the plotted data.
Show/Hide Quartic | Calculates and displays the Quartic regression model for the plotted data.
Show/Hide Power | Calculates and displays the Power regression model for the plotted data.
Show/Hide Exponential | Calculates and displays the Exponential regression model for the plotted data.
Show/Hide Logarithmic | Calculates and displays the Logarithmic regression model for the plotted data.
Show/Hide Sinusoidal | Calculates and displays the Sinusoidal regression model for the plotted data.
Show/Hide Logistic (d=0) | Calculates and displays the Logistic regression model where D=0, for the plotted data.
Show/Hide Logistic (d≠0) | Calculates and displays the Logistic regression model where D≠0, for the plotted data.
Show/Hide Residual Squares | Displays the squares of residuals. **Note:** This tool is only available when a regression line or movable line is present in the work area.
Plot Value | Lets you graph a statistical value on the axis. Examples of values that can be plotted are mean, median, standard deviation.
Plot Function | Lets you graph a function in the work area.
Shade Under Function | Lets you select and shade a region under a function or distribution curve.
Start Over | Erases the content on the page without saving any work. This enables you to start your work again.
## Window/Zoom Menu Tools

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Tool function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Settings</td>
<td>Displays a Window Settings dialog that enables you to enter values that define the work area window. Values you can set include the x-min, x-max, y-min, and y-max values for the axes.</td>
</tr>
<tr>
<td>Zoom - Data</td>
<td>Adjusts the zoom factor so that all plotted data appears in the work area.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Enables you to zoom in on a plot based upon the selection of a center point. The Zoom In factor is approximately 2.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Enables you to zoom out on a plot based upon the selection of a center point. The Zoom Out factor is approximately 2.</td>
</tr>
</tbody>
</table>
Getting started with Data & Statistics

The Data & Statistics application is designed as a place to explore and visualize data and graph inferential statistics. It is, therefore, best used in conjunction with a numerical application like Calculator or Lists & Spreadsheet.

Creating plots from spreadsheet data

The Quick Graph feature of Lists and Spreadsheet is the easiest way to plot data using the columns in a spreadsheet.

Plotting data from Lists & Spreadsheet

1. Create or display data to be plotted in Lists & Spreadsheet. You can plot one or two columns of data.

   The example below illustrates two named columns, height and weight.

<table>
<thead>
<tr>
<th>A</th>
<th>height</th>
<th>B</th>
<th>weight</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>65</td>
<td>127</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>63</td>
<td>138</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>61</td>
<td>125</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>68</td>
<td>167</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>59</td>
<td>110</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>63</td>
<td>132</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>62</td>
<td>143</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>60</td>
<td>115</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>61</td>
<td>134</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>63</td>
<td>160</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>65</td>
<td>154</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>65</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>61</td>
<td>149</td>
<td></td>
</tr>
</tbody>
</table>

   Important: You must name each column of data in Lists & Spreadsheet in order to plot the data in Data & Statistics.

2. Highlight at least one column of data in Lists & Spreadsheet.
3. From the Lists & Spreadsheet Data menu, select the Quick Graph tool.

The data plot displays in the Data & Statistics work area.

The example below illustrates the plot of two columns of data, which display as a scatter plot. The leftmost column of data in the spreadsheet becomes the horizontal axis values, and that column name becomes the horizontal axis label.
The data plot functions as follows:

- If you select only one column of data, it displays as a dot plot on the horizontal axis. The column name appears as the horizontal axis label.

- If spreadsheets in the problem contain multiple named lists, you can view the names of lists in the problem by positioning the mouse over an axis and clicking Click To Add Variable. Remove the plotted variable and click on the name of any list to replace the data plotted on the axis with the data in the selected list.

- If there are less than four work areas on the page, TI-Nspire adds a new work area with Data & Statistics active on it.

- If four work areas are already defined on the page, TI-Nspire adds a new page to the problem with Data & Statistics active on it.

**Note:** If a list is defined with a formula in Lists & Spreadsheet, the points in Data & Statistics may not move, due to the formula’s restriction. The dots in Data & Statistics will only move in directions allowed by their definition, so if they are just data they will move freely. If the points are y=x, they will move along the line.
Creating a split page with Data & Statistics and Lists & Spreadsheet

1. Add the Lists & Spreadsheet or Calculator application to a new page or problem.

2. Click and select Layout 2, to split the page into two work areas.

3. Click to add the Data & Statistics Application to the right side of the work area.

Plotting the contents of linked variables

You can also plot data quickly by using the contents of variables. Data is linked and shared between Data & Statistics and all other TI-Nspire applications within the same problem. When data sets are named, the set is stored as a variable. Selecting the variable name is the method of entering data into the Data & Statistics application. See the Working with Documents chapter for details about storing data as variables.

When you name columns in Lists and Spreadsheet (as in the previous example), the contents of the column are saved as a list in a variable. The named columns in this example are saved as variables **height** and **weight**.
1. Insert a new page, and create a split page layout with Lists & Spreadsheets and Data & Statistics.

2. On the Data & Statistics work area, click Click To Add Variable and select the name of the data set you want to plot on the horizontal axis.

<table>
<thead>
<tr>
<th>A</th>
<th>height</th>
<th>B</th>
<th>weight</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>65</td>
<td>127</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>63</td>
<td>138</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>61</td>
<td>125</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>68</td>
<td>167</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>59</td>
<td>110</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>63</td>
<td>132</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>62</td>
<td>143</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>60</td>
<td>115</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>61</td>
<td>134</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>63</td>
<td>160</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>65</td>
<td>154</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>65</td>
<td>130</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The example below illustrates the value of the column named **height** plotted on the horizontal axis of the Data & Statistics work area.
To create a scatter plot, hover in the middle of the vertical axis until a + appears. Click the label area of the vertical axis and select a second data set name.
The contents of the columns **height** and **weight** are plotted as a scatter plot.

### Plot types

Plots let you visualize your data set in a variety of ways. Visualizing the data points allows you to observe the shape and spread of the data, and can help you determine the best method of statistically evaluating data.

Use Data & Statistics to create the following types of plots:

- Dot
- Box
- Histogram
- Normal Probability
- Scatter
- X-Y Line

### Dot plots

Dot plots, also known as dot-frequency plots, represent one variable data. Dot plots are the default plot type in Data & Statistics.
When one data set is plotted, the value of each cell is represented as one dot, and the dots are stacked at the point on the axis that corresponds to the cell value. By default, the horizontal axis is selected. The column name is used as the axis label.

**Creating a dot plot**

1. Create and name a list of data in a column in Lists & Spreadsheet or Calculator.

2. To create a dot plot, do one of the following:
   - Select the column of data in Lists & Spreadsheet by clicking the grey area next to the column name.
     In the Lists & Spreadsheet work area, select Quick Graph from the Data tool menu to automatically graph the selected data.
   - OR
   - Click in the horizontal axis label in the Data & Statistics work area, click and select the name of the variable containing the data you want to see represented on the horizontal axis.

3. The data graphs in the Data & Statistics work area.

Click on any dot to display its value, or click and drag to change its value. To deselect, click any area of the plot that does not include a dot.
**Box plots**

The default boxplot created by the Boxplot Tool is a modified boxplot. It plots one-variable data. "Whiskers" extend from each end of the box, either 1.5 times the interquartile range or to the end of the data, whichever comes first. Points that are 1.5 * Interquartile Range beyond the quartiles are plotted individually beyond the whisker. (The Interquartile Range is defined as the difference between the third quartile, Q3, and the first quartile, Q1.) These points are called potential outliers.

When no outliers exist, x-min and x-max are the prompts for the end of each whisker (the prompts will be y-min and y-max if you choose to create a vertical box plot). Q1, Med (median), and Q3 define the box.

Box plots are plotted with respect to x-min and x-max, but ignore y-min and y-max.

Boxplots are useful in comparing two or more sets of data. Note that these must use the same scale. If a data set is large, a boxplot can also be useful in exploring data distribution.

**Creating a boxplot**

1. If two data sets are plotted in the work area, select Remove Y Variable from the Plot Properties tool menu.
2. From the Plot Types menu, select the Box Plot tool.
3. The modified box plot displays.

```
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>65</td>
</tr>
<tr>
<td>2</td>
<td>12</td>
<td>70</td>
</tr>
<tr>
<td>3</td>
<td>15</td>
<td>110</td>
</tr>
<tr>
<td>4</td>
<td>17</td>
<td>115</td>
</tr>
<tr>
<td>5</td>
<td>20</td>
<td>120</td>
</tr>
<tr>
<td>6</td>
<td>22</td>
<td>124</td>
</tr>
<tr>
<td>7</td>
<td>22</td>
<td>128</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>138</td>
</tr>
</tbody>
</table>
```

Initial boxplot display- Modified Boxplot

4. Click on a box or whisker to display the points that make up that portion of the plot and display the range of the data in that portion of the plot.

---

**Using Data & Statistics**
Creating a standard boxplot

You create a standard boxplot by modifying the whiskers of the default (modified) boxplot. In a standard boxplot, the whiskers are plotted using the minimum and maximum points in the data set. No attempt is made to identify outliers. The whiskers on the plot extend from the minimum data point in the set (x-min) to the first quartile (Q1) and from the third quartile (Q3) to the maximum point (x-max). The box is defined by Q1, Med (median), and Q3. See the Definitions section at the end of this chapter for a definition of Quartile.

To change the boxplot from modified to standard

1. Create a boxplot for one variable by selecting the Boxplot tool from the Plot Types menu.
2. Right-click to display the context menu, and select Extend Box Plot Whiskers.

The box plot is redrawn to display the whiskers you selected.

To return the boxplot to its original display, right-click to display the context menu and select Show Box Plot Outliers.

Extending Box Plot Whiskers

You can select Extend Box Plot Whiskers from the Plot Properties tool menu to extend the whiskers to the min and max of the data. You can also right-click and select Extend Box Plot Whiskers from the context menu, as shown in the example below.
The whiskers extend to the min and max of the data.
Showing Box Plot Outliers

Select Show Box Plot Outliers from the Plot Properties tool menu to stop whiskers at 1.5 * Interquartile Range and show outliers as individual dots. You can also right-click and select Show BoxPlot Outliers from the context menu.

Points beyond 1.5 * Interquartile Range display in the work area.
Note: If there are no points outside of 1.5 * Interquartile Range, there may appear to be no change in the whisker display.

Histograms

A histogram plots one-variable data. Histograms depict the distribution of data.

The number of bins displayed depends upon the number of data points and the distribution of these points. You can adjust the bins’ width and number by dragging the side of one bin in the work area.

A value that occurs on the edge of a bin is counted in the bin to the right. Each bin width can be adjusted by clicking and dragging the side of the bin.

Creating a histogram

1. Select the data you want to plot as a histogram.

2. From the Plot Types menu, select the Histogram tool.

3. The histogram plots on the Data & Statistics work area.
4. Click on any bin to select it or display its information.

**Adjusting the bins interactively**

1. Click the right side of the bin.

   The cursor changes to $\oplus$.
2. Drag the bin to the desired location and release it.

Adjusting bins numerically

1. From the Plot Properties menu ( ), select Histogram Properties ( ).
3. Type values to set width and alignment of the bins that represent histogram data:
   - To specify bin width, type a value in Width.
   - To specify bin placement, type a value in Alignment.

The bins of the histogram are redrawn using the values set. Both the data represented by the bins and the value you type for the alignment affect the placement of bins on the scale.
For example, when a histogram with a bin width of 1 is centered over the tic marks on the axis with the default alignment of 57.5, changing the alignment to 58 right aligns all bins on the axis scale. All bins are shifted right by .5; the offset for positioning bins on the axis is based on the starting position for the data and the value you specify for alignment.

**Changing the properties of a histogram:**

Use the histogram properties tools to change the data representation format in a histogram. The options for properties are:

- **Count** - displays data based upon the number of values that occur within each bar (interval or bin) on the histogram. This is the default data representation when you create a histogram.
- **Percent** - displays data in the histogram by each group's percent value of the whole data set.

- **Density** - displays data based upon the density of each value within the data set.
• **Bin Settings** - displays a dialog box that lets you set the width and alignment for bins by typing numeric values.

Setting the bin width and alignment requires consideration of both the number of bins and the number of data points included in the range represented by a bin. Avoid misrepresentation by accepting the default bin width or experimenting to identify appropriate bin settings.

**To change the scale:**
1. Create a histogram.
2. Right-click to select Scale from the context menu.
3. From the histogram Scale menu, select Percent or Density. The histogram is redrawn to the scale you select.

   **Note:** The Count tool is not available because it is the scale currently used in the display.

Click on a bin to display the values that are contained in the bin.

**Plotting a value**
You can plot a value on an existing plot. It displays as a line, perpendicular to the axis, in the work area.
1. From the Actions tool menu, select Plot Value. A data entry box opens in the work area.

2. Type the value you want to plot, and press Enter. In this example, the value is v1:= mean(cost).

3. The line is drawn at that value, perpendicular to the axis. Click on the line to display the value.

**Note:** The value line cannot be moved in the work area.
Plot value can be a single number or any expression that evaluates to a number. If the value is dependent on the data, like mean, when you drag a point or make changes in Lists & Spreadsheet, the line updates to reflect the change, allowing for investigation of the influence of points on the calculation.

**Removing a plotted value**

To remove a plotted value from the work area, click on the line to select it, and then select Remove Plotted Value from the Actions tool menu.

**Normal probability plots**

A normal probability plot shows one set of data against the corresponding quantile ($z$) of the standard normal distribution. You can use normal probability plots to judge the appropriateness of the normal model for your data.

**Creating a normal probability plot**

1. Select the data you want to use for a normal probability plot. Use a named list from Lists & Spreadsheets or Calculator.
2. Plot the data in one of the following ways:
   - Create a dot plot by selecting a column and choosing Quick Graph.
   - Add a Data & Statistics work area and assign the data list name as the variable for an axis.
3. From the Plot Types menu, select the Normal Probability plot tool. You can also right-click to select Normal Probability Plot from the context menu.
4. The data graphs in the Data & Statistics work area.
   You can examine the graph to compare the normal variable against the quartile. Click on a dot to display its value.

**Scatter Plots**

A scatter plot shows the relationship between two variables of the data or two sets of data.

You can plot bivariate data in either of two ways.
From the Lists & Spreadsheet work area:

1. Select two columns of data listed in Lists & Spreadsheet by clicking letter above the column.

2. Select Quick Graph tool from the Data tool menu to automatically graph the selected data.

   **Note:** If you choose not to use the Quick Graph tool, you can select Scatter Plot from the Plot Type menu.

3. The data graphs on the Data & Statistics work area.

![Graph of temperature vs. time](image)

From the Data & Statistics work area:

1. In the Data & Statistics work area, click in the horizontal axis label box, and select the variable that contains the data you want to see represented on the horizontal axis.

2. Click the vertical axis label area, and select the variable that contains the data you want to see represented on the vertical axis.

   The data graphs in the Data & Statistics work area.
3. Click on any point to display its value.
**X-Y line plots**

An X-Y line plot is a scatter plot in which the data points are plotted and connected in order of appearance in the two data sets. Like scatter plots, these plots depict the relationship between two sets of data.

By convention, the left-most column of data is represented on the horizontal axis.

1. Select two columns of data on the Lists & Spreadsheet work area.
2. Click the Data & Statistics work area, and from the Plot Types menu, select the XY Line Plot tool.
3. The data points within each set are connected to each other by a line.

![X-Y line plot example](image)

**Multiple Plots**

You can plot multiple data lists for the y-axis. Multiple plots are useful for time-series analysis.

1. From a Lists & Spreadsheets work area, create a scatter plot using two columns of data.
   When both the x-axis and the y-axis have variables plotted on the Data & Statistics work area, the Multiple Plot tool displays at the top of the work area.
2. Click the Multiple Plot tool to choose additional data lists to plot on the y-axis.
   A menu displays the names of data lists available within the problem.
3. Click the name of the list that you want to plot in addition to data previously plotted on the y-axis.

After you select a second variable for plotting, a legend displays at the top of the work area.

The legend shows each shape used to distinguish between the different variables used in a multiple plot. You can change the plot of multiple lists in the following ways:

- Use the context menu to show or hide the legend of shapes that distinguish plots
- Click the variable names on the y-axis and click Remove Y Variable to remove the last variables plotted.

**Exploring data**

You can manipulate and explore plotted data in the following ways:

- selecting and moving points or data bins.
- changing the type of plot.
- rescaling the graph.
- adding a movable line.
- showing regression lines.
- showing residual squares

**Moving points or bins of data**

1. Click on and hold the desired point or bin.
   
   The cursor changes to 

   ![Cursor](image)

2. Drag the point or bar to the new location and release it.
If you are working with data from Lists & Spreadsheet, the data that corresponds to the original point or bar automatically updates in the original column(s) in Lists & Spreadsheet as you move the point.
You can also move points or bins by changing the numbers in Lists & Spreadsheet or Calculator. Data will update in all of the representations.

**Selecting multiple points**

1. Position the cursor over each point you want to select. The cursor changes to \( \text{\textsuperscript{\textcircled{\textbullet}}} \).
2. Once you have selected the desired points, click one of the points. The cursor changes to \( \square \), and you can move the points around in the work area.
Selecting a range of points

1. Select a range of points by clicking and dragging the box to contain the points you want to select.
When you release the mouse button, the points are selected.

2. Once you have selected the desired points, click one of the points. The cursor changes to $\Box$, and you can move the points around in the work area.
Note: When a list is defined in Lists & Spreadsheet as a formula, the movement of points is restricted to only points that satisfy that formula.

Changing plot type
You can change the plot type, to view different representations of data.

- Display the Plot Types menu, and select the new plot type. The data representation changes to the new plot format.

Note: Options are greyed out on the menu if your data cannot be represented by the plot type. For example, if a scatter plot is displayed in the work area, you cannot create a box plot without first removing the Y component of the plot.
Rescaling a graph

You can change the scale of the axes in a few ways.

**Translation**

A translation slides a set of axes a fixed distance in a given direction. The original axes have the same shape and size.

1. Position the cursor over a tic mark or label. The cursor changes to $\leftrightarrow$. 
2. Click to grab. The cursor changes to ☞. Drag the cursor to the desired position and release.
**Dilation**

Dilation retains the shape of the axes, but enlarges or reduces the size.

1. Position the cursor over a tic mark or label near the ends of the axis. The cursor changes to $\times$ on the vertical axis or $\div$ if you are on the horizontal axis.

2. Click to grab. The cursor changes to $\infty$. Drag the cursor to the desired position and release.
Adding a movable line

You can add a movable line to a plot. This line can be moved and rotated on the plot area. The label of the line updates to reflect its position and the model.

- Select Add movable line from the Actions menu.
Rotating a movable line

1. Click and grab on either end of the line.
   The cursor changes to \( \vec{\mathbf{}} \).
   
2. Drag to rotate and change the slope of the line.
**Changing the intercept**

1. Click in the middle of the line.  
   The cursor changes to ⊥.  
2. Drag to change the intercept.
**Locking intercept at zero**

You can lock the intercept of the movable line at zero.

- Select **Lock intercept at zero** from the Actions menu.

**Note:** This tool is only available when a regression or movable line is present in the work area.

To unlock the intercept:

- Select **Unlock Movable Line Intercept** from the Actions menu.

**Showing regression lines**

- Select **Regression** from the Actions menu, and click to select the regression line you would like to display on the plot.
The corresponding regression line for your data displays in the work area.
**Showing residual squares**

You can display residual squares on a plot. Residual squares can help you assess the appropriateness of the model for your data.

- Select Show Residual Squares \( \square \) from the Actions menu \( \square \).

**Note:** This tool is only available when a regression or movable line is present in the work area.
Using Window/Zoom tools

Use the Window/Zoom tools to redefine the graph to better view points of interest. The Window/Zoom tools include:

- **Window Settings**: displays a Window Settings dialog that lets you enter the $x$-min, $x$-max, $y$-min, and $y$-max values for the axes.

- **Zoom - Data**: adjusts the zoom factor to display all plotted data.

- **Zoom - In**: lets you define the center point of the zoom in location. The Zoom In factor is approximately 2.

- **Zoom - Out**: lets you define the center point of the zoom out location. The Zoom Out factor is approximately 2.

**Using Window Settings**

1. Click the Window/Zoom tool, and select Window Settings.
2. The Window Settings dialog opens. The current values for $x$-min, $x$-max, $y$-min, and $y$-max display in the fields.

![Window Settings dialog](image)

Note: Only the appropriate boxes are editable, depending on whether there are one or two axes in the work area.

3. Type the new values over the old values.
4. Select **OK** to apply the changes and redraw the plot.

**Using Zoom Data**

1. Click the Window/Zoom tool [ ], and select Zoom Data [ ].
2. The work area rescales to display all plotted data.

**Using Zoom In**

1. Click the Window/Zoom tool [ ], and select Zoom In [ ].
2. In the work area, click the center point of the area of interest. This will be the center of the zoom in action.
3. The plot redraws to focus and enlarge the portion of the plot centered about the point you selected in the previous step.

**Using Zoom Out**

1. Click the Window/Zoom tool [ ], and select Zoom Out [ ].
2. In the work area, click the center point of the area of interest. This will be the center of the zoom out action.

3. The plot redraws to display a larger portion of the plot, centered about the point you selected in the previous step.

**Graphing Functions**

You can graph functions with Data & Statistics, or you can graph functions from other applications.

To graph a function, enter it in one of the following ways:

- From Data & Statistics: select the Plot Function tool from the Actions menu.

**Graphing multiple functions using the Plot Function tool**

Use the Plot Function tool to plot multiple functions in the work area. Once plotted, click on the function graph to display the function’s equation.

To use the Plot Function tool:

1. Ensure that your work area contains both a horizontal axis and a vertical axis scale.

2. From the Actions menu, select the Plot Function tool.

3. A function entry field displays in the work area.
Note: The function graphed in Data & Statistics cannot be manipulated or moved about the work area. To do that, use Graphs & Geometry.

4. Type the function in the entry field, and press Enter.

Note: You can rename the function by typing over f1(x): with another name, if you choose.

5. The function graphs in the work area and is saved as a variable for use in other applications.

Enter functions from other applications
You can enter a function that has been defined as a variable in another application, such as Lists & Spreadsheet, Graphs & Geometry or Calculator.
1. Ensure that your work area contains both a horizontal axis and a vertical axis scale.

2. From the Actions menu, select the Plot Function tool. A function entry field displays in the work area.

3. Click on the tool bar to open the Variables menu. A list of variables contained in the problem displays.

4. Click to select the variable containing the function you want to plot.
In the example below, the variable \( a \) contains the function \( f(x)=x^2 \).

5. Press Enter.

The function plots in the work area.
**Editing a functions**

You can edit a function and update it on the work area.

1. You can edit a function in either of the following ways:
   - Click on the curve to select it and drag to adjust the plotted data.
   - Double-click the equation and edit it as required to change the plotted data.
2. Press Enter after making all changes and the curve will update.

**Using Data & Statistics functions in other applications**

Data & Statistics functions are stored as variables, and may be used in other applications, in the same manner as any other variable.

**Note:** Function numbers increment by next available. If you have defined f1(x) and f2(x) in Graphs & Geometry, the first function you create in Data & Statistics will be f3(x).

**Supported function types**

The following function types are supported in Data & Statistics:

- Linear function; f(x)=b
• Linear function; \( f(x) = ax + b \)
• Quadratic function; \( f(x) = a(x-b)^2 + c \)
• Exponential function; \( f(x) = \exp(ax+b) + c \)
• Exponential function; \( f(x) = b \exp(ax) + c \)
• Exponential function; \( f(x) = d \exp(ax+b) + c \)
• Logarithmic function; \( f(x) = a \ln(cx+b) + d \)
• Sinusoidal function; \( f(x) = a \sin(cx+b) + d \)
• Cosinusoidal function; \( f(x) = a \cos(cx+b) + d \)

**Using Show Normal PDF**

You can approximate data plotted in the Data & Statistics work area against the normal probability density function.

To show the normal probability density function for plotted data:

1. Select plotted data in the Data & Statistics work area and display it in a histogram format.

2. Select Show Normal PDF ( ) on the Actions menu ( ).

   The normal PDF for the graph plots in the work area. The expression used to calculate the PDF displays when selected.

   Select Hide Normal PDF on the Actions menu to remove the PDF.

**Note:** Show Normal PDF is available only when histogram is the plot type.
Using Shade Under Function

Use Shade Under Function to find the area of a selected region under a function graphed in the work area.

1. Select any function graphed in the Data & Statistics work area. For example, select a previously graphed normal PDF.

2. Select Shade Under Function ( ) on the Actions menu ( ).

The cursor becomes a dotted vertical line and the boundary +/- ∞ displays when you position the mouse near the boundary on the left or right. You can click when ∞ displays to set it as a boundary.
3. Select a point on the curve and click to indicate where to start shading under the function. The direction in which you move next determines whether the region shaded is on the left, right, or center of the curve.

4. Select a point on the curve and click to indicate the end boundary of the shaded area. A region under the function is shaded based on the points you selected.

You can work with Shade Under Function in the following ways:

- Select the region to display the shaded area.
- Select Shade Under Function again to shade multiple areas.
- Select Remove Shaded region on the context menu to remove shading.
- When a boundary for shading is set to a plotted value, you can change the plotted value to update the shading.
- Edit a shaded region by clicking and dragging the starting or ending boundary.
Using Statistical Tools

Once you have plotted one or more data sets in Data & Statistics, you can manipulate and explore the data using calculations, data fitting techniques, hypothesis testing tools, and distributions. These functions are available in the Lists & Spreadsheet application. Refer to that chapter for further information.
Using Lists & Spreadsheet

Getting started with tables

The Lists & Spreadsheet application gives you a place to work with tabular data. You can use Lists & Spreadsheet to:

- Store numeric data, text, or math expressions.
- Define a table cell in terms of the contents of other cells.
- Define an entire column in terms of another column.
- Work with variables created in the Graphs & Geometry and Calculator applications.
- Collect tables of real-world data from sensors.
- Generate columns of data based on other columns or sequences that you define.
- Share individual cells with other TI-Nspire™ math and science learning technology applications as variables, and share columns of data as lists.
- Plot table data using the Data & Statistics application.
- Generate function tables from functions defined in Calculator or Graphs & Geometry.
- Copy and paste table data between Lists & Spreadsheet and other computer applications, such as TI Connect™ software and Microsoft® Excel® spreadsheet software.
- Perform statistical analysis on lists of data.
1. Lists & Spreadsheet menu (available when a Lists & Spreadsheet work area is active)

2. Sample Lists & Spreadsheet work area

3. Lists & Spreadsheet data shared with another TI-Nspire™ application
The Lists & Spreadsheet tool menu

The Lists & Spreadsheet tool menu lets you modify your display and enter and evaluate a variety of math expressions.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Actions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Move Column</td>
<td>Lets you reposition the current column.</td>
</tr>
<tr>
<td></td>
<td>Resize</td>
<td>Lets you set a column to the maximum or minimum width. You can set a custom row height or column width by positioning the column edge at the size you want and clicking.</td>
</tr>
<tr>
<td></td>
<td>Select</td>
<td>Selects an entire row or column, or helps you insert a range of cells into a cell formula.</td>
</tr>
<tr>
<td></td>
<td>Go To (Ctrl G)</td>
<td>Jumps to the specified cell, such as d16 or g20.</td>
</tr>
<tr>
<td></td>
<td>Recalculate (Ctrl R)</td>
<td>Recalculates results of all cell formulas.</td>
</tr>
<tr>
<td></td>
<td>Sort</td>
<td>Lets you sort the selected columns of the spreadsheet based on the contents of a single column.</td>
</tr>
<tr>
<td><strong>Insert</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Insert Cell</td>
<td>Inserts a cell.</td>
</tr>
<tr>
<td></td>
<td>Insert Row</td>
<td>Inserts a row above the current row.</td>
</tr>
<tr>
<td></td>
<td>Insert Column</td>
<td>Inserts a column before the current column.</td>
</tr>
<tr>
<td><strong>Data</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Generate Sequence</td>
<td>Displays a dialog box for creating a sequence.</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Menu Option</td>
<td>Function</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data Capture</td>
<td>Allows manual or automatic capture of variable data from Graphs &amp; Geometry, Calculator, Data &amp; Statistics, or within Lists &amp; Spreadsheets. Use Ctrl . (period) to trigger each manual capture.</td>
<td></td>
</tr>
<tr>
<td>Fill Down</td>
<td>Lets you duplicate the contents of a selected cell or group of cells within a column.</td>
<td></td>
</tr>
<tr>
<td>Quick Graph</td>
<td>Uses the Data &amp; Statistics application to graph one or two selected columns of data as a dot plot or scatter plot.</td>
<td></td>
</tr>
</tbody>
</table>

**Statistics**

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stat Calculations</td>
<td>Lets you select from several statistics calculations, such as one-variable analysis, two-variable analysis, and regressions.</td>
<td></td>
</tr>
<tr>
<td>Distributions</td>
<td>Lets you calculate and plot several distributions, such as Normal Pdf, Binomial Cdf, and Inverse F.</td>
<td></td>
</tr>
<tr>
<td>Confidence Intervals</td>
<td>Lets you calculate several confidence intervals, such as t interval and z interval.</td>
<td></td>
</tr>
<tr>
<td>Stat Tests</td>
<td>Lets you perform and plot several hypothesis tests such as t test, z test, and ANOVA.</td>
<td></td>
</tr>
</tbody>
</table>

**Function Table**

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch to Function Table</td>
<td>Toggles the function table view.</td>
<td></td>
</tr>
<tr>
<td>(Ctrl T)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select Function</td>
<td>Lets you select a different function for the current column.</td>
<td></td>
</tr>
</tbody>
</table>

Using Lists & Spreadsheet
Before you begin

- Open the TI-Nspire™ computer software, and add the Lists & Spreadsheet application to a document.

Navigating in a spreadsheet

You can select any cell to view or edit its contents. When a spreadsheet is larger than the Lists & Spreadsheet work area, you can view different parts of the spreadsheet by:

- Pressing ‹, ‹, ‹, and ‹ to move through the spreadsheet. This moves the selection from cell to cell and scrolls as necessary to keep the selected cell in view. You can also use the Page up, Page Dn, Home, and End keys.
- Using the Go To command on the Actions menu to select a specific cell. Type the cell’s column letter and row number (such as G16).
- Dragging the slider in the scroll bar. This scrolls vertically without changing which cell or block of cells is selected.

A column letter appears at the top of each column, and a row number appears in the left cell of each row. The top two rows and the left column of the spreadsheet remain in place as you scroll so you can more easily determine your location.
Inserting a cell range into a formula

The Select Range feature lets you insert a cell range (such as a1:b3) into a formula by selecting the range instead of typing cell addresses into an argument.

Suppose you want to calculate the mean of a range of cells.

1. Type “=mean(“ in the cell that will contain the result.
2. On the **Actions** menu, choose **Select**, and then choose **Select Range**. A dotted selection rectangle appears around the cell.

3. Use the arrow keys along with the **Shift** key to select the range of values whose mean you want to calculate. The formula is updated as you select.
4. Press **Enter** to complete the formula and evaluate the formula and display the result.

**Methods of entering data**

The method you use to enter spreadsheet data depends on the type of data and your personal preferences. You can use different methods in combination.

- For numbers and text, type the data on your computer keyboard. You can type numbers and letters in the cell, or use the entry line to type characters in the selected cell.
• For numbers, text, and simple math expressions and formulas such as \( =a3 \times \text{length}^2 \), press the corresponding keys on the virtual keypad. In this example, press \( = \ A \ 3 \ \text{length}^2 \).

**Note:** To display the virtual keypad, select \( \text{ } \).  
• To distinguish a string, enclose it in quotes.

• For more complex math expressions such as \( \sum_{n=1}^{5} \frac{1}{n} \) click \( \text{ } \) on the tool menu to display the complete Catalog of system functions and commands, symbols, and expression templates.

• To display only the templates, click \( \text{ } \) on the tool menu.

• To display only the symbols, click \( \text{ } \) on the tool menu.

**Entering a math expression, text, or spreadsheet formula**
1. Select the cell in which you want to enter data. Double-click or press **Enter** to edit the cell.

2. Use your computer keyboard, the virtual keypad, or the Lists & Spreadsheet toolbar to enter the data. You will see the text or formula in the cell and on the entry line simultaneously.

3. Press **Enter** to complete the entry and move down to the next cell.

   – or –

   Press **Tab** to complete the entry and move right to the next cell.

Lists & Spreadsheet automatically recalculates any cells that are dependent on the cell you entered. If you have shared the cell, and other TI-Nspire™ math and science learning technology applications are linked to the cell, the other applications are also updated.

For details on entering math expressions, refer to the Calculator section.
Working with individual cells

Creating absolute and relative cell references

Cell references let you enter formulas that refer to spreadsheet data instead of having to duplicate it and remember to update it. When you change the contents of a referenced cell, all references to the data are updated automatically in the spreadsheet.

Anytime you want to update all references and formula results in the spreadsheet, you can select Recalculate from the Actions menu (or press Ctrl R ).

Note: Using Recalculate from the Actions menu (Ctrl R ) is also handy for getting new random numbers from the rand function. Pressing Ctrl R works only when the Lists & Spreadsheets work space is active.

Cell formulas begin with the = symbol. You refer to a cell by using its column letter and row number. Entering =3*C4 as a formula, for example, creates an expression that is 3 * the contents of the cell at column C, row 4.

You can refer to a rectangular block of cells in a formula by entering the location of the upper-left cell and the lower-right cell, separated by a colon.
For example, \( \text{mean(B1:C5)} \times 1 \) creates a result that is the mean of all cells in the block bounded by columns B through C and rows 1 through 5. (To force the results of an expression to a decimal approximation, you multiply by “1.”)

References such as C4 and C4:E11 are relative references. These references describe where a cell is in relation to other cells of the spreadsheet. Lists & Spreadsheet keeps track of relative cell references. It adjusts each reference automatically when you copy or move the cell containing the reference to another location in the spreadsheet.

If you need a reference that always refers to a cell in a specific location in the spreadsheet, use an absolute reference. To create an absolute cell reference, type a $ symbol before the column letter and row number.

For example, type $C$4 to create an absolute reference to the cell in column C, row 4. Lists & Spreadsheet does not adjust absolute references in a formula when you copy or move the cell containing the reference.

**Inserting items from the Catalog**

You can use the Catalog to insert system functions and commands, symbols, and expression templates into a cell formula.

1. Select the cell and type “=” to begin the formula.
2. Click to open the Catalog.
Note: Some functions have a wizard that prompts you for each argument. If you prefer to enter the argument values directly in the cell, you may need to disable the wizard.

3. Click the tab for the category of the item.
4. Click to select the item that you want to insert.

- contains all commands and functions, in alphabetical order
- contains all math functions
- provides a symbol palette for adding special characters.
- contains math templates for creating two dimensional objects, including product, sum, square root and integral.
- shows Public library (LibPub) objects.

5. Press Enter to insert the item into the entry line.

Deleting the contents of a cell or block of cells
1. Click the cell to select it, or drag to select a rectangular block of cells.
2. Press **Delete** or **Backspace**.

   The selected cell contents are deleted.

   **Note:** If other cells contain formulas that refer to the cell's previous contents, those cells show an error.

**Copying a cell or block of cells**

When you copy cells, the formulas (if any) in the original cells are copied to the destination cells, replacing the previous contents of those cells.

1. Click the cell to select it, or drag to select a rectangular block of cells.
2. Press **Ctrl C**.

   The selected cell contents are copied to the Clipboard.

3. Select the cell where you want to duplicate the copied cell. If you are copying a block of data, select the cell that will become the upper left corner of the copied block.

4. Press **Ctrl V**.

   ![Spreadsheet diagram]

   **Note:** Paste copied data into a cell that is in the same mode as the cell from which the data was originally copied. Otherwise, a formula could paste as a string enclosed in quotes instead of a formula.

**Filling adjacent cells**

You can repeat a cell’s formula or value throughout adjacent cells. This gives you a quick way to fill cells with the same value or create a series of cells that contain the same formula. You can fill down within a column.
1. Select the cell whose value or formula you want to repeat.
2. On the Data menu, select Fill Down.
3. Press ▼ repeatedly to move down, selecting the range of cells that will hold the repetitions.
4. Press Enter.
   The selected cell is duplicated throughout the selected range.

Notes
- In step 1, you can select more than one cell to be repeated. If you do, make sure that you select enough destination cells to hold the repeated copies.
- If you select multiple cells in step 1 and the cells contain a simple sequence (such as 1,2,3 or 5,10,15,20), the sequence is continued in the filled area.

Sharing a cell value as a variable
You can share the value of a cell with other TI-Nspire™ applications by storing it as a variable. When you define or refer to a shared cell in Lists & Spreadsheet, the name is preceded with an apostrophe (').

1. Select the cell that you want to share.
2. Click on the toolbar, and click Store Var.
   A formula is inserted into the cell with var as a placeholder for a variable name.
3. Replace the letters “var” with a name for the variable, and press Enter.
   The value is now available as a variable to other TI-Nspire™ math and science learning technology applications.

Note: If a variable with the name you specified already exists in the current problem, Lists & Spreadsheet displays an error message.

Linking a cell to a variable
When you link a cell to a variable, Lists & Spreadsheet keeps the cell value updated to reflect the current value of the variable. The variable can be any variable in the current problem and can be defined in Graphs & Geometry, Calculator, Data & Statistics, or any instance of Lists & Spreadsheet.
**Note:** Use caution if you link to a system variable. Linking could prevent the variable from being updated by the system. System variables include statistics results (such as `Stat.RegEqn`, `Stat.dfError`, and `Stat.Resid`) and finance-solver variables (such as `tvm.n`, `tvm.pmt`, and `tvm.fv`).

1. Select the cell that you want to link to the variable.

2. Select `var` from the toolbar.
   
   The VarLink menu displays.

   ![VarLink Menu](image)

3. Under **Link To**, press `▲`, and `▼` to scroll to the name of the variable.

4. Press **Enter**.
   
   The cell shows the value of the variable.

**Preventing name conflicts**

A TI-Nspire™ shared variable can have the same name as a spreadsheet cell or column letter. For best results, choose variable names that do not use the same name format as spreadsheet cells (like A1) and columns (A). To help prevent name conflicts in spreadsheet formulas, Lists & Spreadsheet asks for clarification when you enter a name that could conflict.

![Spreadsheet Image](image)

You can also use the following syntax rules.
To refer to a variable whose name could conflict with the name of a cell (such as A1), precede the variable name with an apostrophe (‘A1). Or, you can avoid choosing names that are similar in format to cell and column names (such as A and A1).

To refer to a column (such as A) without conflicting with a single-letter variable name $A$, follow the column letter with a pair of brackets (A[]).

<table>
<thead>
<tr>
<th>To refer to:</th>
<th>Use this syntax:</th>
<th>Remarks:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The shared variable $A_1$.</td>
<td>‘A1</td>
<td>The apostrophe avoids a possible conflict with spreadsheet cell A1.</td>
</tr>
<tr>
<td>The spreadsheet cell at column A,</td>
<td>A[1]</td>
<td>This syntax always refers to a spreadsheet cell, avoiding a possible</td>
</tr>
<tr>
<td>row 1.</td>
<td></td>
<td>conflict with variable $A_1$.</td>
</tr>
<tr>
<td>Column A of the current</td>
<td>A[]</td>
<td>Brackets avoid a possible conflict with variable $A$.</td>
</tr>
<tr>
<td>spreadsheet.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The shared variable myvar.</td>
<td>myvar</td>
<td>No special syntax needed, because this name does not conflict with a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cell or column reference.</td>
</tr>
</tbody>
</table>

**Note:** In certain examples, Lists & Spreadsheet may not display the Conflict Detected dialog box to notify you of a possible variable-name conflict. Also, the dialog box may appear even when you have used the apostrophe or brackets to prevent a conflict. Name variables using two or more characters to prevent this conflict.

**Working with rows and columns of data**

**Selecting a row or column**

- Move to the top of the column, and then press $\uparrow$. (You can also click the column reference letter.)
  - or -
  Move to the leftmost cell of the row, and then press $\downarrow$. (You can also click the row reference number.)

**Resizing a row or column**

1. Point to the boundary of the row or column that you want to resize.
   The pointer changes to a double-headed arrow.
2. Drag to reposition the boundary or resize a row or column by clicking Resize on the Actions menu. Select Resize Column Width or Resize Row Height to position the size with the mouse. Click to complete sizing and set a custom column width or row height.

Inserting an empty row or column
1. Select the column or row where you want to insert the new data.
2. On the Insert menu, select either Row or Column.
   – If you are inserting a row, the remaining rows shift down to create space for the new row.
   – If you are inserting a column, the remaining columns shift right to create space.

Note: If other cells contain formulas with relative references to a displaced row or column, those references adjust accordingly.

Deleting entire rows or columns
You can delete a row, column, group of rows, or group of columns. When you delete a row or column, the remaining rows or columns move up or left to fill the gap.
1. Select the column or row that you want to delete.
2. If you are deleting more than one row or column, drag to select the additional items.

3. Press **Delete** or **Backspace**.

   The selected rows or columns are deleted.

**Note:** If other cells contain formulas that refer to the deleted row or column, those cells show an error. Relative references to cells whose positions have changed because of a deletion adjust accordingly.

**Copying rows or columns**

1. Select the column or row that you want to copy.
2. If you are copying more than one row or column, drag to select the additional items.
   – or –
   Hold down **Shift**, and press **↑, ↓, ‹, or ›** to select the additional items.

3. Press **Ctrl C** to copy the selected items.
   The selected rows or columns are copied to the Clipboard.

4. Move to any cell in the row or column where you want to place the copied items.

5. Press **Ctrl V** to paste the selection.
   The copied row or column is pasted in place, replacing the previous contents.

**Moving a column**

1. Select the column that you want to move.

2. On the **Actions** menu, select **Move Column**. An insertion bar appears.

3. Press **‹** or **›** or move the mouse pointer to place the insertion bar at the column’s new position, and then press **Enter**.
Using Lists & Spreadsheet

**Note:** Relative references to any cell whose position is affected by the move adjust accordingly.

**Sorting data**

You can sort a selected area of the spreadsheet in ascending or descending order. You select which column in the selected area will be used as the key for the sort. When the sort moves data up or down in the key column, the corresponding data in the other selected columns is also moved up or down. This preserves the integrity of each row.

**Note:** Sorting is based on numeric values. If you select a key column that contains text, you could get unexpected results.

**Sorting a range of cells in a column**

1. Select the range of cells.

2. On the **Actions** menu, select **Sort**.
3. Select **Descending** as the sort method for this example, and then select **OK**.

### Sorting a rectangular region

1. Select the region of cells.

2. On the **Actions** menu, select **Sort** to display the Sort dialog box.
3. Select column a as the column on which the sort will be based for this example. You can select from columns within the selected region only.

4. Select Descending as the sort method for this example, and then select OK.

**Sorting entire columns**

1. Select the range of columns to sort.
Using Lists & Spreadsheet

2. On the **Actions** menu, select **Sort**.

3. Select column **a** as the column on which the sort will be based for this example.

4. Select **Descending** as the sort method for this example, and then select **OK**.

---

**Generating columns of data**

You can create a column of values based on another column. You can also create a column based on any of several types of sequential data.

Entering a formula in the header row of the column tells the Lists & Spreadsheet application that you want to apply the formula to all the cells in the column, not just to a single cell.
Column formulas based on other columns

Column formula that generates a sequence

Notes

- If you generate data in a column that already contains one or more cell values, Lists & Spreadsheet asks for confirmation before replacing the existing values. Proceeding removes all of the existing values in the column.

- If you edit a cell manually in a column of generated data, Lists & Spreadsheet asks for confirmation before replacing the generated data. Proceeding removes the generated data for the entire column.

Creating column values based on another column

1. Select the header cell (second cell from the top) of the column where you want to enter a column formula.

2. Type = followed by the expression, and then press Enter. Use brackets ([]) after any column letter you include in the formula. For example, type =A[]^2 to create a column of values in which each cell is the square of the corresponding cell of column A.

Lists & Spreadsheet shows the formula in the header cell and fills the column with the results.
Generating a list of random numbers
1. Select the header of the column in which you want to generate the list of random numbers.
2. Type = followed by the expression for generating the random numbers. You can use the catalog to insert an expression instead of typing characters.
   \[ \text{Rand Int (1, 6, 20)} \]
   This example places 20 random integers in the column. Use Ctrl R (Recalculate) to generate a new set of random numbers.

Generating a numerical sequence
1. Select any cell in the column in which you want to generate the sequence.
2. On the Data menu, select Generate Sequence.
   Lists & Spreadsheet displays a dialog for defining the sequence.
3. Type the formula that will be applied to the column values to generate the sequence. Type any starting numbers required by the sequence. \( u_0 \) is the first number in the sequence, \( u_1 \) is the second, and \( u_2 \) is the third.
4. Type a maximum value for the sequence, if you want to specify a maximum.

5. Type a maximum number of values to be generated, if you want to specify a maximum.

6. Select **OK**.

Lists & Spreadsheet shows the formula in the header cell and fills the column with the results.

![Sequence Dialog Box](image)

**Note:** If you prefer, you can enter a formula for the sequence directly into the header cell of the column.

For example, enter `=seqn(u(n-1)+u(n-2),{2,5},7,100)` to generate a Fibonacci series that uses 2 and 5 as the first two numbers. This sequence stops at a maximum value of 100 or a maximum of 7 values, whichever occurs first.

7. Type the formula in the header cell, and then press **Enter**. For example, enter `=seqn(u(n-1)+u(n-2),{2,5})` to use 2 and 5 as the first two numbers.
Creating and sharing spreadsheet data as lists

You can define a column as a named list of elements of the same type of data. After defining a list, you can link to it from Graphs & Geometry, Calculator, Data & Statistics, and other instances of Lists & Spreadsheet within the current problem.

**Note:** Lists & Spreadsheet can display a maximum of 2500 elements in a list.

Sharing a spreadsheet column as a list variable

You share a column of data by naming it as a list variable.

**Note:** Avoid defining variables that use the same names as those used for statistical analysis. In some cases, an error condition could occur.

Variable names used for statistical analysis are listed in the *TI-Nspire Reference Guide*, under the `stat.results` entry.

**Method 1**

1. Click the name cell (the white cell at the top) of the column that you want to share.
2. Type a name for the shared list. for example, type \texttt{width}.
3. Press \texttt{Enter}.

\textbf{Method 2}

1. Click the header cell (the second cell from the top) of the column that you want to share.

2. Click \texttt{var} on the toolbar, and click \texttt{Store Var}.

An expression is inserted into the formula cell with \texttt{var} as a placeholder for the list name.
3. Replace the letters “var” with a name for the shared list. For example, type width.

The header cell now contains an expression similar to `width:=`.

4. Add the formula at the end of the expression. For example, `width:=E[*]*3`.

5. Press Enter.

The column is now available as a list variable to other TI-Nspire™ applications.

**Notes:**

- If a variable with the name you specified already exists in the current problem, Lists & Spreadsheet displays an error message.
- Because a list cannot contain empty elements, any empty cells are automatically given a value of zero.
You can refer to a specific element in a named list from the Calculator application. Use the list name and the element’s position within the list. In a list named Heights, for example, refer to the first element as Heights[1]. The expression Heights[2] refers to the second element, and so on.

**Linking to an existing list variable**

Linking a Lists & Spreadsheet column to an existing list variable lets you easily view and edit the values in the list. The list can be any shared list in the current problem and can be defined in Graphs & Geometry, Calculator, or any instance of Lists & Spreadsheet.

After you link a column to a list, Lists & Spreadsheet automatically shows any changes that you make to the list with other TI-Nspire™ applications.

1. Click the header cell (the second cell from the top) of the column that you want to link to the variable.

2. Click \( \text{var} \) on the toolbar, and click **Store Var**.

3. Type \( \text{=} \) followed by an apostrophe and the name of the list. For example, type \( \text{=width} \).

**Note:** Use caution if you link to a system variable. Doing so could prevent the variable from being updated by the system. System variables include \( \text{ans} \) and statistics results (such as \( \text{stat.results} \), \( \text{stat.ReqEgn} \), and \( \text{stat.Resid} \)).

4. Press **Enter**.

   The column shows the list elements.

**Inserting an element in a list**

When you insert an element in a list, the remaining elements shift downward to create space. For example, if you insert an element at position L1[2], the element that was previously L1[2] shifts down to become L1[3], and so on to the end of the list.

The downward shift affects only the column defined as a list. No other columns are affected.

1. On the **Insert** menu, select **Insert Cell**.

**Deleting an element from a list**

When you delete an element, the remaining list elements shift upward to close the gap. For Example, if you delete element L1[3], the element that was previously L1[4] shifts up to become L1[3], and so forth to the end of the list.

The upward shift affects only the selected column.
1. Right-click the cell to display the context menu.
2. Select **Delete Cell**.

**Note:** If you press Delete or Backspace to clear the contents of the cell instead of deleting the list element, the element is assigned a value of 0 (zero). The remaining list elements do not shift.

**Graphing spreadsheet data**

You can easily create a dot plot of the data in one column or a scatterplot of two adjacent columns by using the Quick Graph feature. This feature displays the graphed data using the Data & Statistics application.

To create a scatterplot:

1. Name both of the two columns to declare them as lists.
2. Select both columns.

![Spreadsheet Table](image)

<table>
<thead>
<tr>
<th>A xlist</th>
<th>B ylist</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*B5 | 32
3. On the **Data** menu, select **Quick Graph**.

A Data & Statistics work space is added to the page and shows the plotted data. The leftmost of the two lists is plotted on the x axis, and the other list is plotted on the y axis.

4. (Optional) Use the Data & Statistics features to analyze or visually enhance the graph.

**Note:** Refer to Using Data and Statistics for information about analyzing and exploring graphs.
Capturing data from Graphs & Geometry

You can use Lists & Spreadsheet to capture information about objects from Graphs & Geometry. For example, you might want to track changes in the area of a triangle as you change the length of a side.

You can select manual or automatic capture:

- With manual capture, you trigger the capture of each data element by pressing a specific key combination (Ctrl . (period)).
- With automatic capture, the capture of each data value is triggered automatically when you move or animate the target in Graphs & Geometry.

Capturing data manually

1. Select any cell in the column in which you want to capture the values.

   **Note:** Captured values will replace values in the column.

2. On the **Data** menu, select **Data Capture**, and then select **Manual Data Capture**.

   A capture expression is inserted into the header cell with \texttt{var} as a placeholder for the name of the variable you are capturing.
3. Replace the letters “var” with the name of the variable to capture from Graphs & Geometry. For example, type `area`.

The header cell now contains an expression similar to 
`=capture(area,0)`.

Note: The argument “0” tells Lists & Spreadsheet that you want to trigger each capture manually.

4. Press **Enter**.

5. Using Graphs & Geometry, change the object whose attribute (area in this example) you are capturing.

6. Each time you are ready to capture the current value of `area`, hold down **Ctrl** and press . (the period key). On keyboards with an **Alt Gr** key, you can hold down **Alt Gr** and press the **Tab** key.

   The current `area` value is added to the end of the list as a list element.
Capturing data automatically

1. Select any cell in the column in which you want to capture the values.

   **Note:** Captured values will replace values in the column.

2. On the **Data** menu, select **Data Capture**, and then select **Automated Data Capture**.

   A capture expression is inserted into the header cell with \textit{var} as a placeholder for the name of the variable you are capturing.

   \[
   =\text{capture}(\text{var}, 1)
   \]

3. Replace the letters \textit{“var”} with the name of the variable to capture. For example, type \texttt{objpathX}. Alternatively, you can select the variable name from the Variables menu or from the VarLink menu.

   The header cell now contains an expression similar to
   \[
   =\text{capture}('\texttt{objpathX}, 1)\).
   \]
Using Lists & Spreadsheet

The argument “1” tells Lists & Spreadsheet that you want the captures to be triggered by the variable change.

4. Press **Enter**.

5. When you are ready to begin capturing the values of `objpathX`, begin moving the object or start the animation that affects it in Graphs & Geometry.

Each captured value is added to the end of the list in Lists & Spreadsheet as a list element.

**Creating function tables**

The Lists & Spreadsheet application lets you create a table of function values for any defined function in the current problem. You can set the parameters for the table and even edit a function definition without leaving Lists & Spreadsheet.
Showing and Hiding function tables

Anytime Lists & Spreadsheet is the active application, you can alternate between the standard Lists & Spreadsheet view and the function table view.

- Press **Ctrl T** to toggle the view.

1. Lists & Spreadsheet view

2. Function table view
Generating a function table

1. Make sure you have defined at least one function in Graphs & Geometry, Calculator, or Data & Statistics. Refer to Using Graphs & Geometry for more information.

2. In Lists & Spreadsheet, press Ctrl T to toggle to the function table view.

   The function table view appears with a small box listing available functions.

   ![Function Table View]

   **Note:** If a previous function is displayed, press ▶ to move to an empty column.

3. Select the function for which you want to create a table.

   By default, the table is generated using a start value of 0, a step value of 1, and the automatic setting for the independent and dependent variables.
Adding a function table from Graphs & Geometry

Adding a function table from Graphs & Geometry automatically creates an instance of Lists & Spreadsheet if none already exists on the current page. It also shows the function table view and automatically generates a table for the active Graphs & Geometry functions.

1. In Graphs & Geometry, select the functions for which you want to create a table.

2. On the View menu, select Add Function Table.

Viewing values in a function table

- Press ▲ or ▼ to view the values in the table.
As you move through the table, Lists & Spreadsheet generates the function values based on the independent variable (shown in the leftmost column). Scrolling upward from 0 displays negative values of the independent variable.

<table>
<thead>
<tr>
<th>x</th>
<th>f2(x):...</th>
<th>f1(x):...</th>
</tr>
</thead>
<tbody>
<tr>
<td>x-2</td>
<td>x^2+3</td>
<td></td>
</tr>
<tr>
<td>-3</td>
<td>-5</td>
<td>12</td>
</tr>
<tr>
<td>-2</td>
<td>-4</td>
<td>7</td>
</tr>
<tr>
<td>-1</td>
<td>-3</td>
<td>4</td>
</tr>
<tr>
<td>0</td>
<td>-2</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>-1</td>
<td>4</td>
</tr>
<tr>
<td>-3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Editing a function**

Besides using the other applications, such as Calculator and Graphs & Geometry, you can edit a function definition in the function table. Changes that you make are reflected in the other applications automatically.

1. Double-click the function's expression.
2. A cursor appears in the expression.
3. Edit the expression, and then press Enter.
4. The table for the function is updated, and the Graphs & Geometry graph of the function is also updated.

**Changing the settings for a function table**

Each function table uses initial settings that make it easy to scroll through values. If you prefer, you can set the Table Start and Table Step values manually, and you can choose to enter values manually for the independent and/or dependent variable.

1. On the Function Table menu, select Edit Function Table Settings.
2. Type a value or click the independent or dependent variable boxes to change a setting.

If you select **Ask** instead of **Auto** for a variable, you can enter a value manually when you select a cell. **Auto** populates the table starting at table start and displays and independent and dependent value for each step.

**Deleting a column in the function table**

1. Click the function name or expression (in the top two rows).
2. Press **Delete** or **Backspace**.

**Using table data for statistical analysis**

Lists & Spreadsheet uses wizards to help you perform statistical analyses on data in table columns. You specify the location of the data, and Lists & Spreadsheet stores the results in two columns: one for the result names, and one for the corresponding values.

**Plotting statistical data**

On some statistics wizards, there is a check box for Draw. By default, the box is not checked. Checking this box creates a Data & Statistics work area on the page, and displays the calculated results in Lists & Spreadsheet and draws the results of the statistical analysis in the Data & Statistics work area.

**Note**: The check box is displayed only if you select a header cell (second cell from the top) before beginning the analysis.
Draw check box in the z Test wizard.
Statistical calculations

Performing a statistical calculation
Suppose you want to fit a $y=mx+b$ linear regression model to the following two lists:

1. Select the header/formula cell (second cell from the top) in column A.

1. Select the header/formula cell (second cell from the top) in column A.
2. On the **Statistics** menu, select **Stat Calculation**, and select **Linear Regression (mx+b)** to choose the regression model.

A wizard opens, giving you a labeled box to type each argument. Because you selected a cell in advance, the column for **X List** is already filled in.

3. Press **Tab** to move to the **Y List** box, or click the drop-down arrow to select a named list.

4. Type `b[]` to specify the values in column B as **Y List**.

5. If you want to store the regression equation in a specified variable, press **Tab**, and then replace **Save RegEqn To** with the name of the variable.

6. Press **Tab** as necessary to move to the **1st Result** box.

7. Type `c[]` as the column letter for the first result column.

8. Select **OK**.
Lists & Spreadsheet inserts two columns: one containing the names of the results, and one containing the corresponding values.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>7</td>
<td>Title</td>
<td>Linear Regressio...</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>12</td>
<td>RegEqn</td>
<td>m\times x+b</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>17</td>
<td>m</td>
<td>5.</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>22</td>
<td>b</td>
<td>2.</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>27</td>
<td>(r^2)</td>
<td>1.</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td>r</td>
<td>1.</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td>Resid</td>
<td>{0.,0.,0..0.,0.}</td>
</tr>
</tbody>
</table>

**Note:** The results are linked to the source data. For example, you can change a value in column A, and the regression equation is updated automatically.

You can access statistical analysis results as variables from other TI-Nspire™ applications by using the **Var** menu. The variables are stored in the form `stat.nnn`, where `nnn` is the result name (for example, `stat.RegEqn` and `stat.Resid`).

### Supported Statistical Calculations

The Stat Calculations menu lets you select from the calculations described below. For a complete description of inputs and outputs, refer to the *TI-Nspire Reference Guide* details for the function name that is in parentheses.

#### One-Variable Statistics (OneVar)

The One-Variable Statistics calculation analyzes data with one measured variable. The statistical data returned for a data set using this analysis technique are:

- sample mean, \( \bar{x} \)
- sum of the data, \( \sum x \)
- sum of the squared data, \( \sum x^2 \)
- sample standard deviation, \( s_x \)
• population standard deviation, $\sigma_X$
• sample size, $n$
• $X$-min
• first quartile, $Q_1$
• median
• third quartile, $Q_3$
• $X$-max
• sum of squared deviations, $SS_x = \Sigma (x - \bar{x})^2$

Each element in `freqlist` is the frequency of occurrence for each corresponding data point in `Xlistname`. `freqlist` elements must be integers $> 0$.

**Two-Variable Statistics (TwoVar)**

The **Two-Variable Statistics** calculation analyzes paired data. `List 1` is the independent variable. `List 2` is the dependent variable. The statistical data returned for the data sets using this analysis technique are:

For each list:

• sample mean, $\bar{x}$ or $\bar{y}$
• sum of the data, $\Sigma x \text{ or } \Sigma y$
• sum of the squared data, $\Sigma x^2 \text{ or } \Sigma y^2$
• sample standard deviation, $sx = s_{n-1}x \text{ or } sy = s_{n-1}y$
• population standard deviation, $\sigma x = \sigma_{n}x \text{ or } \sigma y = \sigma_{n}y$
• $X$-min or $Y$-min
• first quartile, $Q_1X \text{ or } Q_1Y$
• median
• third quartile, $Q_3X \text{ or } Q_3Y$
• $X$-max or $Y$-max
• sum of squared deviations, $SS_x = \Sigma (x - \bar{x})^2 \text{ or } SS_y = \Sigma (y - \bar{y})^2$

Additional data:

• sample size for each data set, $n$
• $\Sigma xy$
Each element in \textit{freqlist} is the frequency of occurrence for each data pair (\textit{List1, List2}).

\textbf{Linear Regression (mx+b) (LinRegMx)}

The Linear Regression (mx+b) fits the model equation \(y=ax+b\) to the data using a least-squares fit. It displays values for \(m\) (slope) and \(b\) (y-intercept).

\textbf{Linear Regression (a+bx) (LinRegBx)}

The Linear Regression (a+bx) fits the model equation \(y=a+bx\) to the data using a least-squares fit. It displays values for \(a\) (y-intercept), \(b\) (slope), \(r^2\), and \(r\).

\textbf{Median-Median Line Regression (MedMed)}

The Median-Median Line regression fits the model equation \(y=ax+b\) to the data using the median-median line (resistant line) technique, calculating the summary points \(x_1, y_1, x_2, y_2, x_3,\) and \(y_3\). Median-Median Line displays values for \(a\) (slope) and \(b\) (y-intercept).

\textbf{Quadratic Regression (QuadReg)}

The QuadReg (quadratic regression) fits the second-degree polynomial \(y=ax^2+bx+c\) to the data. It displays values for \(a, b, c,\) and \(R^2\). For three data points, the equation is a polynomial fit; for four or more, it is a polynomial regression. At least three data points are required.

\textbf{Cubic Regression (CubicReg)}

The CubicRegression fits the third-degree polynomial \(y=ax^3+bx^2+cx+d\) to the data. It displays values for \(a, b, c, d,\) and \(R^2\). For four points, the equation is a polynomial fit; for five or more, it is a polynomial regression. At least four points are required.

\textbf{Quartic Regression (QuartReg)}

The Quartic Regression fits the fourth-degree polynomial \(y=ax^4+bx^3+cx^2+dx+e\) to the data. It displays values for \(a, b, c, d, e,\) and \(R^2\). For five points, the equation is a polynomial fit; for six or more, it is a polynomial regression. At least five points are required.

\textbf{Power Regression (PwrReg)}

The Power Regression fits the model equation \(y=ax^b\) to the data using a least-squares fit and transformed values ln(x) and ln(y). It displays values for \(a, b, r^2,\) and \(r.\)
**Exponential Regression (ExpReg)**

The **Exponential Regression** fits the model equation \( y = ab^x \) to the data using a least-squares fit and transformed values \( x \) and \( \ln(y) \). It displays values for \( a, b, r^2, \) and \( r \).

**Logarithmic Regression (LogReg)**

The **Logarithmic Regression** fits the model equation \( y = a + b \ln(x) \) to the data using a least-squares fit and transformed values \( \ln(x) \) and \( y \). It displays values for \( a, b, r^2, \) and \( r \).

**Sinusoidal Regression (SinReg)**

The **Sinusoidal Regression** fits the model equation \( y = a \sin(bx+c)+d \) to the data using an iterative least-squares fit. It displays values for \( a, b, c, \) and \( d \). At least four data points are required. At least two data points per cycle are required in order to avoid aliased frequency estimates.

**Note:** The output of **SinReg** is always in radians, regardless of the Radian/Degree mode setting.

**Logistic Regression (d=0) (Logistic)**

The **Logistic Regression (d=0)** fits the model equation \( y = c/(1+a \cdot e^{bx}) \) to the data using an iterative least-squares fit. It displays values for \( a, b, c \).

**Logistic Regression (d≠0) (LogisticD)**

The **Logistic (d≠0)** regression fits the model equation \( y = c/(1+a \cdot e^{bx})+d \) to the data using an iterative least-squares fit. It displays values for \( a, b, c, \) and \( d \).

**Multiple Linear Regression (MultReg)**

The **Multiple Linear Regression** calculates multiple linear regression of list \( Y \) on lists \( X_1, X_2, \ldots, X_{10} \).

**Note:** There is no draw option for multiple linear regression.
Distributions

A B
1
2
3
4
5
6
7
8
9
10
11
12
13

Click To Add Variable

Using Lists & Spreadsheet
Calculating distributions

Suppose you want to fit the Normal Pdf distribution model to the following two lists:

1. Select the header/formula cell (second cell from the top) in column A.
2. On the Statistics menu, select Distributions, and select Normal Pdf to choose the Distribution model.
A wizard opens, giving you a labeled box to type each argument. You can type values, or select them from the drop down selection list.

3. **Press Tab** as necessary to complete each argument.
4. Click the Draw check box, to see the distribution plotted in Data & Statistics.
   
   **Note:** The Draw option is not available for all distributions.
5. Select OK.

Lists & Spreadsheet inserts two columns: one containing the names of the results, and one containing the corresponding values. The results are plotted in Data & Statistics.
Note: The results are linked to the source data. For example, you can change a value in column A, and the equation updates automatically.

Supported Distribution functions
You can include distribution functions in cells using the same method for entering characters, or include a distribution in a formula cell. When you specify a distribution function in a formula cell, you are required to specify a list (column) that contains the x-values. For each x-value in the list, the distribution returns a corresponding result.

Note: For distribution functions that support the draw option (normPDF, t PDF, χ^2 Pdf, and F Pdf), the option is available only if you enter the distribution function in a formula cell.

The following distributions are available from the Lists & Spreadsheets application. For complete information regarding these functions, refer to the TI-Nspire Reference Guide details for the function name that is in parentheses.

Normal Pdf (normPdf)
Normal Pdf computes the probability density function (pdf) for the normal distribution at a specified x value. The defaults are mean μ=0 and standard deviation σ=1. The probability density function (pdf) is:
This distribution is used to determine the probability of the occurrence of a certain value in a normal distribution. The draw option is available when Normal PDF is invoked from a formula cell.

When you access distributions from the formula cell, you must select a valid list from the pull-down to avoid unexpected results. If accessed from a formula cell, you must specify a number for the x-value. The distribution returns the probability that the value you specify will occur.

**Normal Cdf (normCdf)**

**Normal Cdf** computes the cumulative density function of a probability distribution between lowerbound and upperbound for the specified mean, \( \mu \), and standard deviation, \( \sigma \). The defaults are \( \mu=0 \) and \( \sigma=1 \).

This distribution is useful in determining the probability of an occurrence of any value between the lower and upper bounds in the normal distribution. It is equivalent to finding the area under the specified normal curve between the bounds.

**Inverse Normal (invNorm)**

**Inverse Normal** computes the inverse cumulative normal distribution function for a given area under the normal distribution curve specified by mean, \( \mu \), and standard deviation, \( \sigma \).

This distribution is useful in determining the x-value of data in the area from 0 to x<1 when the percentile is known.

**t Pdf() (tPdf())**

**t Pdf** computes the probability density function (pdf) for the t-distribution at a specified x value. \( df \) (degrees of freedom) must be > 0. The probability density function (pdf) is:

\[
f(x) = \frac{\Gamma[((df+1)/2)]}{\Gamma(df/2)} \frac{(1 + x^2/df)^{-(df+1)/2}}{\sqrt{\pi df}}
\]

This distribution is useful in determining the probability of the occurrence of a value when the population standard deviation is not known and the sample size is small. The draw option is available when t Pdf is invoked from a formula cell.
\textbf{t Cdf (tCdf())}

t Cdf computes the t-distribution probability between \textit{lowerbound} and \textit{upperbound} for the specified \textit{df} (degrees of freedom), which must be $> 0$.

This distribution is useful in determining the probability of the occurrence of a value within an interval defined by the lower and upper bound for a normally distributed population when the population standard deviation is not known.

\textbf{Inverse t (invt())}

Inverse t computes the inverse cumulative t-distribution probability function specified by Degrees of Freedom, \textit{df}, for a given area under the curve.

This distribution is useful in determining the probability of an occurrence of data in the area from 0 to $x<1$. This function is used when the population mean and/or population standard deviation is not known.

\textbf{$\chi^2$ Pdf}

$\chi^2$ Pdf computes the probability density function (pdf) for the $\chi^2$ (chi-square) distribution at a specified $x$ value. \textit{df} (degrees of freedom) must be an integer $> 0$. The probability density function (pdf) is:

$$f(x) = \frac{1}{\Gamma(df/2)} (1/2)^{df/2} x^{df/2 - 1} e^{-x/2}, x \geq 0$$

This distribution is useful in determining the probability of the occurrence of a given value from a population with a $\chi^2$ distribution. The draw option is available when $\chi^2$ Pdf is invoked from a formula cell.

\textbf{$\chi^2$ Cdf}

$\chi^2$ Cdf computes the $\chi^2$ (chi-square) distribution probability between \textit{lowerbound} and \textit{upperbound} for the specified \textit{df} (degrees of freedom), which must be an integer $> 0$.

This distribution is useful in determining the probability of the occurrence of value within given boundaries of a population with a $\chi^2$ distribution.

\textbf{F Pdf}

F Pdf computes the probability density function (pdf) for the F distribution at a specified $x$ value. \textit{numerator df} (degrees of freedom) and \textit{denominator df} must be integers $> 0$. The probability density function (pdf) is:
Using Lists & Spreadsheet

This distribution is useful in determining the probability that two samples have the same variance. F Pdf The draw option is available when F Pdf is invoked from a formula cell.

**F Cdf**

F Cdf( computes the F distribution probability between lowerbound and upperbound for the specified numerator df (degrees of freedom) and denominator df. numerator df and denominator df must be integers > 0.

This distribution is useful in determining the probability that a single observation falls within the range between lowerbound and upperbound.

**Binomial Pdf (binomPdf())**

Binomial Pdf computes a probability at x for the discrete binomial distribution with the specified numtrials and probability of success (p) on each trial. x can be an integer or a list of integers. 0≤p≤1 must be true. numtrials must be an integer > 0. If you do not specify x, a list of probabilities from 0 to numtrials is returned. The probability density function (pdf) is:

\[
f(x) = \binom{n}{x} p^x (1 - p)^{n-x}, x = 0, 1, \ldots, n
\]

where \( n = \text{numtrials} \)

This distribution is useful in determining the probability of success in a success/failure trial, at trial n. For example, you could use this distribution to predict the probability of getting heads in a coin toss on the 5th toss.

**Binomial Cdf (binomCdf())**

Binomial Cdf computes a cumulative probability at x for the discrete binomial distribution with the specified numtrials and probability of success (p) on each trial. x can be a real number or a list of real numbers. 0≤p≤1 must be true. numtrials must be an integer > 0. If you do not specify x, a list of cumulative probabilities is returned.

\[
f(x) = \frac{\Gamma\left(\frac{n + d}{2}\right)}{\Gamma\left(n/2\right)\Gamma\left(d/2\right)} \left(\frac{n}{d}\right)^{n/2 - 1} \left(1 + nx/d\right)^{-\left(n + d\right)/2}, x \geq 0
\]

where \( n = \text{numerator degrees of freedom} \)

\( d = \text{denominator degrees of freedom} \)
This distribution is useful in determining the probability of a success on one trial before all trials are completed. For example, if heads is a successful coin toss and you plan to toss the coin 10 times, this distribution would predict the chance of obtaining heads at least once in the 10 tosses.

**Poisson Pdf (poissPdf())**

Poisson Pdf computes a probability at x for the discrete Poisson distribution with the specified mean, \( \mu \), which must be a real number > 0. \( x \) can be an integer or a list of integers. The probability density function (pdf) is:

\[
f(x) = e^{-\mu} \frac{\mu^x}{x!}, x = 0,1,2,\ldots
\]

This distribution is useful in determining the probability of obtaining a certain number of successes before a trial begins. For example, you could use this calculation to predict the number of heads that would occur in 8 tosses of a coin.

**poissoncdf (poissCdf())**

poissoncdf( computes a cumulative probability at \( x \) for the discrete Poisson distribution with the specified mean, \( \mu \), which must be a real number > 0. \( x \) can be a real number or a list of real numbers.

This distribution is useful in determining the probability that a certain number of successes occur between the upper and lower bounds of a trial. For example, you could use this calculation to predict the number of heads displayed between coin toss #3 and toss #8.

**geometpdf (geomPdf())**

geometpdf( computes a probability at \( x \), the number of the trial on which the first success occurs, for the discrete geometric distribution with the specified probability of success \( p \). \( 0 \leq p \leq 1 \) must be true. \( x \) can be an integer or a list of integers. The probability density function (pdf) is:

\[
f(x) = p(1-p)^{x-1}, x = 1,2,\ldots
\]

This distribution is useful in determining the likeliest number of trials before a success is obtained. For example, you could use this calculation to predict the number of coin tosses that would be made before a heads resulted.
**geometcdf (geomCdf())**

**geometcdf** computes a cumulative probability at \( x \), the number of the trial on which the first success occurs, for the discrete geometric distribution with the specified probability of success \( p \). \( 0 \leq p \leq 1 \) must be true. \( x \) can be a real number or a list of real numbers.

This distribution is useful in determining the probability associated with the first success occurring during trials 1 through \( n \). For example, you could use this calculation to determine the probability that heads display on toss \( #1, #2, #3, \ldots, #n \).
**Confidence Intervals**

The following confidence intervals are available from the Lists & Spreadsheets application. For complete information regarding these functions, refer to the *TI-Nspire Reference Guide* details for the function name that is in parentheses.

**z Interval (zInterval)**

*z Interval* (one-sample z confidence interval) computes a confidence interval for an unknown population mean, \( \mu \), when the population standard deviation, \( \sigma \), is known. The computed confidence interval depends on the user-specified confidence level.

This test is useful in determining how far from a population mean a sample mean can get before indicating a significant deviation.

**t Interval (tInterval)**

*t Interval* (one-sample t confidence interval) computes a confidence interval for an unknown population mean, \( \mu \), when the population standard deviation, \( \sigma \), is unknown. The computed confidence interval depends on the user-specified confidence level.
This test is useful in examining whether the confidence interval associated with a confidence level contains the value assumed in the hypothesis. Like the z Interval, this test helps you determine how far from a population mean a sample mean can get before indicating a significant deviation when the population mean is unknown.

**2-Sample z Interval (zInterval_2Samp)**

2-Sample z Interval (two-sample z confidence interval) computes a confidence interval for the difference between two population means (\(\mu_1 - \mu_2\)) when both population standard deviations (\(\sigma_1\) and \(\sigma_2\)) are known. The computed confidence interval depends on the user-specified confidence level.

This test is useful in determining if there is statistical significance between the means of two samples from the same population. For example, this test could determine whether there is significance between the mean SAT score of female students and the mean of SAT score of male students at the same school.

**2-Sample t Interval (tInterval_2Samp)**

2-Sample t Interval (two-sample t confidence interval) computes a confidence interval for the difference between two population means (\(\mu_1 - \mu_2\)) when both population standard deviations (\(\sigma_1\) and \(\sigma_2\)) are unknown. The computed confidence interval depends on the user-specified confidence level.

This test useful in determining if there is statistical significance between the means of two samples from the same population. It is used instead of the 2-sample z confidence interval in situations where the population is too large to measure in order to determine the standard deviation.

**1-Prop z Interval (zInterval_1Prop)**

1-Prop z Interval (one-proportion z confidence interval) computes a confidence interval for an unknown proportion of successes. It takes as input the count of successes in the sample \(x\) and the count of observations in the sample \(n\). The computed confidence interval depends on the user-specified confidence level.

This test is useful in determining the probability of a given number of successes that can be expected for a given number of trials. For instance, casino examiners would use this test to determine if observed payouts for one slot machine demonstrate a consistent pay out rate.
**2-Prop z Interval (zInterval_2Prop)**

2-Prop z Interval (two-proportion $z$ confidence interval) computes a confidence interval for the difference between the proportion of successes in two populations ($p_1 - p_2$). It takes as input the count of successes in each sample ($x_1$ and $x_2$) and the count of observations in each sample ($n_1$ and $n_2$). The computed confidence interval depends on the user-specified confidence level.

This test is useful in determining if two rates of success differ because of something other than sampling error and standard deviation. For example, a bettor could use this test to determine if there is an advantage in the long run by playing one game or machine versus playing another game or machine.

**Linear Reg t Intervals (LinRegtIntervals)**

Linear Reg t Intervals computes a linear regression $t$ confidence interval for the slope coefficient $b$. If the confidence interval contains 0, this is insufficient evidence to indicate that the data exhibits a linear relationship.

**Multiple Reg Intervals (MultRegIntervals)**

Computes multiple regression prediction confidence interval for the calculated $y$ and a confidence for $y$. 

---

*Using Lists & Spreadsheet*
**supported statistical tests**

the following hypothesis tests are available from the lists & spreadsheets application. for complete information regarding these functions, refer to the *ti-nspire reference guide* details for the function name that is in parentheses.

**z-test (zTest)**

*z-test* (one-sample *z* test) performs a hypothesis test for a single unknown population mean, \( \mu \), when the population standard deviation, \( \sigma \), is known. it tests the null hypothesis \( H_0: \mu = \mu_0 \) against one of the alternatives below.

- \( H_a: \mu \neq \mu_0 \) (\( \mu: \neq \mu_0 \))
- \( H_a: \mu < \mu_0 \) (\( \mu: < \mu_0 \))
- \( H_a: \mu > \mu_0 \) (\( \mu: > \mu_0 \))

this test is used for large populations that are normally distributed. the standard deviation must be known.
This test is useful in determining if the difference between a sample mean and a population mean is statistically significant when you know the true deviation for a population.

**t-test (tTest)**

**t-Test** (one-sample t test) performs a hypothesis test for a single unknown population mean, \( \mu \), when the population standard deviation, \( \sigma \), is unknown. It tests the null hypothesis \( H_0: \mu = \mu_0 \) against one of the alternatives below.

- \( H_a: \mu \neq \mu_0 \) (\( \mu: \neq \mu_0 \))
- \( H_a: \mu < \mu_0 \) (\( \mu:< \mu_0 \))
- \( H_a: \mu > \mu_0 \) (\( \mu: > \mu_0 \))

This test is similar to a z-test, but is used when the population is small and normally distributed. This test is used more frequently than is the z-test because small sample populations are more frequently encountered in statistics than are large populations.

This test is useful in determining if two normally distributed populations have equal means, or when you need to determine if a sample mean differs from a population mean significantly and the population standard deviation is unknown.

**2-SampZTest (zTest_2Samp)**

**2-SampZTest** (two-sample z test) tests the equality of the means of two populations (\( \mu_1 \) and \( \mu_2 \)) based on independent samples when both population standard deviations (\( \sigma_1 \) and \( \sigma_2 \)) are known. The null hypothesis \( H_0: \mu_1 = \mu_2 \) is tested against one of the alternatives below.

- \( H_a: \mu_1 \neq \mu_2 \) (\( \mu_1: \neq \mu_2 \))
- \( H_a: \mu_1 < \mu_2 \) (\( \mu_1:< \mu_2 \))
- \( H_a: \mu_1 > \mu_2 \) (\( \mu_1: > \mu_2 \))

**2-SamptTest (tTest_2Samp)**

**2-SamptTest** (two-sample t test) tests the equality of the means of two populations (\( \mu_1 \) and \( \mu_2 \)) based on independent samples when neither population standard deviation (\( \sigma_1 \) or \( \sigma_2 \)) is known. The null hypothesis \( H_0: \mu_1 = \mu_2 \) is tested against one of the alternatives below.

- \( H_a: \mu_1 \neq \mu_2 \) (\( \mu_1: \neq \mu_2 \))
- \( H_a: \mu_1 < \mu_2 \) (\( \mu_1:< \mu_2 \))
- \( H_a: \mu_1 > \mu_2 \) (\( \mu_1: > \mu_2 \))
**1-PropZTest (zTest_1Prop)**

1-PropZTest (one-proportion z test) computes a test for an unknown proportion of successes (prop). It takes as input the count of successes in the sample \( x \) and the count of observations in the sample \( n \). **1-PropZTest** tests the null hypothesis \( H_0: \text{prop} = p_0 \) against one of the alternatives below.

- \( H_a: \text{prop} \neq p_0 \) (prop:\neq p0)
- \( H_a: \text{prop} < p_0 \) (prop:<p0)
- \( H_a: \text{prop} > p_0 \) (prop:>p0)

This test is useful in determining if the probability of the success seen in a sample is significantly different from the probability of the population or if it is due to sampling error, deviation, or other factors.

**2-PropZTest (zTest_2Prop)**

2-PropZTest (two-proportion z test) computes a test to compare the proportion of successes (\( p_1 \) and \( p_2 \)) from two populations. It takes as input the count of successes in each sample (\( x_1 \) and \( x_2 \)) and the count of observations in each sample (\( n_1 \) and \( n_2 \)). **2-PropZTest** tests the null hypothesis \( H_0: \text{p}_1 = \text{p}_2 \) (using the pooled sample proportion \( \hat{p} \)) against one of the alternatives below.

- \( H_a: \text{p}_1 \neq \text{p}_2 \) (p1:\neq p2)
- \( H_a: \text{p}_1 < \text{p}_2 \) (p1:<p2)
- \( H_a: \text{p}_1 > \text{p}_2 \) (p1:>p2)

This test is useful in determining if the probability of success seen in two samples is equal.

**\( \chi^2 \)GOF-Test**

\( \chi^2 \)GOF-Test (Chi Square Goodness of Fit) performs a test to confirm that sample data is from a population that conforms to a specified distribution. For example, \( \chi^2 \) GOF can confirm that the sample data came from a normal distribution.

**\( \chi^2 \)-Test**

\( \chi^2 \)-Test (chi-square test) computes a chi-square test for association on the two-way table of counts in the specified \textit{Observed} matrix. The null hypothesis \( H_0 \) for a two-way table is: no association exists between row variables and column variables. The alternative hypothesis is: the variables are related.
**2-SampFTest**

**2-SampFTest** (two-sample F-test) computes an F-test to compare two normal population standard deviations ($\sigma_1$ and $\sigma_2$). The population means and standard deviations are all unknown. **2-SampFTest**, which uses the ratio of sample variances $Sx1^2/Sx2^2$, tests the null hypothesis $H_0: \sigma_1 = \sigma_2$ against one of the alternatives below.

- $H_a: \sigma_1 \neq \sigma_2$ ($\sigma_1 \neq \sigma_2$)
- $H_a: \sigma_1 < \sigma_2$ ($\sigma_1 < \sigma_2$)
- $H_a: \sigma_1 > \sigma_2$ ($\sigma_1 > \sigma_2$)

Below is the definition for the **2-SampFTest**.

$$Sx1, Sx2 = \text{Sample standard deviations having } n_1-1 \text{ and } n_2-1 \text{ degrees of freedom } df, \text{ respectively.}$$

$$F = \text{F-statistic} = \left(\frac{Sx1}{Sx2}\right)^2$$

$$df(x, n_1-1, n_2-1) = \text{Fpdf( ) with degrees of freedom } df, n_1-1, \text{ and } n_2-1$$

$$p = \text{reported } p \text{ value}$$

**2-SampFTest** for the alternative hypothesis $\sigma_1 > \sigma_2$.

$$p = \int_{\frac{\alpha}{F}}^\infty f(x, n_1-1, n_2-1)dx$$

**2-SampFTest** for the alternative hypothesis $\sigma_1 < \sigma_2$.

$$p = \int_0^\infty f(x, n_1-1, n_2-1)dx$$

**2-SampFTest** for the alternative hypothesis $\sigma_1 \neq \sigma_2$. Limits must satisfy the following:

$$\frac{p}{2} = \int_0^{L_{\text{bnd}}} f(x, n_1-1, n_2-1)dx = \int_{U_{\text{bnd}}}^{\infty} f(x, n_1-1, n_2-1)dx$$
where: \([Lbnd,Ubnd] = \) lower and upper limits

The \(F\)-statistic is used as the bound producing the smallest integral. The remaining bound is selected to achieve the preceding integral’s equality relationship.

**LinRegTTest**

LinRegTTest (linear regression \(t\) test) computes a linear regression on the given data and a \(t\) test on the value of slope \(\beta\) and the correlation coefficient \(\rho\) for the equation \(y=\alpha+\beta x\). It tests the null hypothesis \(H_0: \beta=0\) (equivalently, \(\rho=0\)) against one of the alternatives below.

- \(H_a: \beta \neq 0\) and \(\rho \neq 0\) (\(\beta \& \rho: \neq 0\))
- \(H_a: \beta < 0\) and \(\rho < 0\) (\(\beta \& \rho: < 0\))
- \(H_a: \beta > 0\) and \(\rho > 0\) (\(\beta \& \rho: > 0\))

**Multiple Reg Tests (MultRegTest)**

Multiple linear regression \(t\) test computes a linear regression on the given data, and provides the \(F\) test statistic for linearity.

Refer to the *TI-Nspire Reference Guide* for information about MultRegTests.

**ANOVA**

ANOVA (one-way ANalysis Of VAriance) computes a one-way analysis of variance for comparing the means of two to 20 populations. The ANOVA procedure for comparing these means involves analysis of the variation in the sample data. The null hypothesis \(H_0: \mu_1=\mu_2=...=\mu_k\) is tested against the alternative \(H_a: \) not all \(\mu_1...\mu_k\) are equal.

The ANOVA test is a method of determining if there is a significant difference between the groups as compared to the difference occurring within each group.

This test is useful in determining if the variation of data from sample-to-sample shows a statistically significant influence of some factor other than the variation within the data sets themselves. For example, a box buyer for a shipping firm wants to evaluate three different box manufacturers. He obtains sample boxes from all three suppliers. ANOVA can help him determine if the differences between each sample group are significant as compared to the differences within each sample group.

**ANOVA 2-way (ANOVA2way)**

ANOVA 2-way computes a two-way analysis of variance for comparing the means of two to 20 populations. A summary of results is stored in the `stat.results` variable.
The two-way **ANOVA** analysis of variance examines the effects of two independent variables and helps to determine if these interact with respect to the dependent variable. (In other words, if the two independent variables do interact, their combined effect can be greater than or less than the impact of either independent variable additively.)

This test is useful in evaluating differences similar to the **ANOVA** analysis but with the addition of another potential influence. To continue with the **ANOVA** box example, the two-way **ANOVA** might examine the influence of box material on the differences seen.

**Selecting an Alternative Hypothesis (≠ < >)**

Most of the inferential stat editors for the hypothesis tests prompt you to select one of three alternative hypotheses.

- The first is a ≠ alternative hypothesis, such as \( m \neq m_0 \) for the **Z-Test**.
- The second is a < alternative hypothesis, such as \( m_1 < m_2 \) for the **2-SampTTest**.
- The third is a > alternative hypothesis, such as \( p_1 > p_2 \) for the **2-PropZTest**.

To select an alternative hypothesis, move the cursor to the appropriate alternative, and then press \( \text{enter} \).

**Draw Option**

Draw determines whether the test results are graphed. If you enable the check box, the page is split and the test curve and shading are graphed.

**Selecting the Pooled Option**

**Pooled** (**2-SampTTest** and **2-SampTInt** only) specifies whether the variances are to be pooled for the calculation.

- Select **No** if you do not want the variances pooled. Population variances can be unequal.
- Select **Yes** if you want the variances pooled. Population variances are assumed to be equal.

To select the **Pooled** option, select **Yes** from the drop down box.
### Statistics Input Descriptions

The following table describes the different inputs used in List & Spreadsheet wizards.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\mu_0$</td>
<td>Hypothesized value of the population mean that you are testing.</td>
</tr>
<tr>
<td>$\sigma$</td>
<td>The known population standard deviation; must be a real number &gt; 0.</td>
</tr>
<tr>
<td>List</td>
<td>The name of the list containing the data you are testing.</td>
</tr>
<tr>
<td>Frequency List</td>
<td>The name of the list containing the frequency values for the data in List. Default=1. All elements must be integers ≥ 0. The frequency values can also be typed as a list, in the format {1, 1, 3, 2}.</td>
</tr>
<tr>
<td>$\bar{x}$, $S_x$, $n$</td>
<td>Summary statistics (mean, standard deviation, and sample size) for the one-sample tests and intervals.</td>
</tr>
<tr>
<td>$\sigma_1$</td>
<td>The known population standard deviation from the first population for the two-sample tests and intervals. Must be a real number &gt; 0.</td>
</tr>
<tr>
<td>$\sigma_2$</td>
<td>The known population standard deviation from the second population for the two-sample tests and intervals. Must be a real number &gt; 0.</td>
</tr>
<tr>
<td>List 1, List 2</td>
<td>The names of the lists containing the data you are testing for the two-sample tests and intervals.</td>
</tr>
<tr>
<td>Frequency 1, Frequency 2</td>
<td>The names of the lists containing the frequencies for the data in List 1 and List 2 for the two-sample tests and intervals. Defaults=1. All elements must be integers ≥ 0.</td>
</tr>
<tr>
<td>$\bar{x}<em>1$, $S</em>{x1}$, $n_1$, $\bar{x}<em>2$, $S</em>{x2}$, $n_2$</td>
<td>Summary statistics (mean, standard deviation, and sample size) for sample one and sample two in two-sample tests and intervals.</td>
</tr>
<tr>
<td>Pooled</td>
<td>Specifies whether variances are to be pooled for 2-SampTTest and 2-SampTInt. No instructs the TI-Nspire not to pool the variances. Yes instructs the TI-Nspire to pool the variances.</td>
</tr>
<tr>
<td>$p_0$</td>
<td>The expected sample proportion for 1-PropZTest. Must be a real number, such that $0 &lt; p_0 &lt; 1$.</td>
</tr>
</tbody>
</table>
Exchanging data with other computer software

You can copy table data to and from software outside the TI-Nspire™ applications, such as TI DataEditor (in the TI Connect™ software) and Microsoft® Excel® spreadsheet software.

For example, you can copy:

- The values of individual cells, a range of cells, or an entire list from TI DataEditor.
- The values (not the underlying formulas) of individual cells, a range of cells, or an entire column from a Microsoft® Excel® spreadsheet.
- A number from TI DataEditor.
- The value of a matrix from TI DataEditor.
Example - copying data from TI DataEditor

1. Open the TI Connect™ software.
2. Display the TI DataEditor.
3. If necessary, open the file containing the number, list, or matrix that you want to copy.

```
<table>
<thead>
<tr>
<th></th>
<th>L₀</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.5567</td>
</tr>
<tr>
<td>2</td>
<td>2.2256</td>
</tr>
<tr>
<td>3</td>
<td>3.987</td>
</tr>
<tr>
<td>4</td>
<td>7.5326</td>
</tr>
<tr>
<td>5</td>
<td>13.33</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>
```

4. Drag to select the values that you want to copy. To copy an entire list, click the top cell in the list.

```
<table>
<thead>
<tr>
<th></th>
<th>L₀</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.5567</td>
</tr>
<tr>
<td>2</td>
<td>2.2256</td>
</tr>
<tr>
<td>3</td>
<td>3.987</td>
</tr>
<tr>
<td>4</td>
<td>7.5326</td>
</tr>
<tr>
<td>5</td>
<td>13.33</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>
```

5. Click **Edit > Copy**.
6. In Lists & Spreadsheet, click the cell where you want the data to be pasted.
If you have copied a range of cells, they will be pasted so that the upper-left corner of the range is positioned at the selected cell. Any data in those cells will be overwritten.

7. Click **Edit > Paste**.

Example - copying cells from an Excel® spreadsheet

You can copy as many as 26 columns and 2500 rows from an Excel® spreadsheet.

1. Open the Excel® spreadsheet.
2. Drag to select the values that you want to copy. To copy an entire column, click the column identifier at the top of the column.

**Note:** If you select non-contiguous columns in Excel, they will be pasted as contiguous columns in Lists & Spreadsheet.

3. Click **Edit > Copy**.

4. In Lists & Spreadsheet, click the cell where you want the data to be pasted.
If you have copied a range of cells, they will be pasted so that the upper-left corner of the range is positioned at the selected cell. Any data in those cells in will be overwritten.

5. Click **Edit > Paste**.
Using Notes

**Getting started with the Notes application**

The Notes application provides text editing functions that allow you to create and share documents with others using the TI-Nspire™ handheld and computer software.

You can use the Notes application as a tool to create study notes to reinforce your understanding of classroom concepts and to review for exams. The Notes application allows you to assign different roles to individuals using your document, so that any edits appear in a different text format, making it easy to edit collaboratively.

1. **Notes tool menu** – This menu is available anytime you are in the Notes work area.
2. **Notes work area** -- The area where you enter and format text.

Question

What is the circumference of

Answer

\[ \pi \cdot 12 \]
The Notes tool menu

The Notes tool menu lets you select a Notes template, format text, and evaluate expressions. The table below describes the menu items and their functions.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Templates</td>
<td>Q&amp;A</td>
<td>Creates a template to enter question and answer text.</td>
</tr>
<tr>
<td></td>
<td>Proof</td>
<td>Creates a template to enter statement and reason text.</td>
</tr>
<tr>
<td></td>
<td>Default</td>
<td>Lets you enter freeform text.</td>
</tr>
<tr>
<td>Insert</td>
<td>Expression Box</td>
<td>Lets you insert a math expression.</td>
</tr>
<tr>
<td></td>
<td>Shape</td>
<td>Marks the selected text as an angle, triangle, circle, line, segment, ray, or vector.</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>Lets you enter text that is italicized and prefaced with Teacher or Reviewer.</td>
</tr>
<tr>
<td>Format</td>
<td>Keyword</td>
<td>Toggles the selected text between bold and not bold, and removes all other formatting.</td>
</tr>
<tr>
<td></td>
<td>Title</td>
<td>Toggles the selected text between underlined and not underlined, and removes all other formatting.</td>
</tr>
<tr>
<td></td>
<td>Sub-heading</td>
<td>Toggles the selected text between italic and not italic, and removes all other formatting.</td>
</tr>
</tbody>
</table>
Open the computer software, and add the Notes application to a document.

### The Notes work area

The Notes work area is where you enter and format text.

<table>
<thead>
<tr>
<th>Question</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the circumference of</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Answer</th>
</tr>
</thead>
</table>

### Notes templates

The Notes application provides templates for creating three types of notes:

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A&lt;sub&gt;1&lt;/sub&gt; Subscript</td>
<td>Toggles the selected text between subscripted and not subscripted, and removes all other formatting.</td>
</tr>
<tr>
<td>A&lt;sup&gt;1&lt;/sup&gt; Superscript</td>
<td>Toggles the selected text between superscripted and not superscripted, and removes all other formatting.</td>
</tr>
<tr>
<td>Actions</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluate selection</td>
<td>Replaces the selected math expression with the result of the expression.</td>
</tr>
<tr>
<td>Show or Hide Answer</td>
<td>Shows or hides the answer in a Q&amp;A template.</td>
</tr>
</tbody>
</table>
• **Q&A** for questions and answers, with the answer shown or hidden
• **Proof** for an outline structure containing statements and reasons
• **Default** for open-formatted text entry

**Applying a Notes template**
1. On the **Templates** menu, select the specific template to apply.

**Using the Q&A Template**
Use the Q&A template to create questions and answers. You have the option to show or hide the answer, so you can create questions for review and hide the answers. When you use the document as a study aid, you can verify that your answers are correct.

Press **tab** to move the text cursor between the **Question** and **Answer** areas of the template.

<table>
<thead>
<tr>
<th>Question</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the circumference of</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Using the Proof Template**
The proof template provides an outline structure for statements and corresponding reasons.

Press **tab** to move the text cursor between the **Statements** and **Reasons** areas of the template.
You can insert Teacher or Reviewer comments into a Notes application. Comments are easily identifiable and easy to distinguish from the original text.

1. On the **Insert** menu, select **Comment**, and then select **Teacher** or **Reviewer**.

2. Enter your text.
   
   Text that you enter appears in italics.

### Inserting comments

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the atomic weight of Hydrogen?</td>
<td>[Teacher: <em>This is a good question.</em>]</td>
</tr>
</tbody>
</table>

---

**Using Notes**

305
**Formatting Notes text**

Notes allows you to format text to add context to your documents. Use the tools on the Text options menu to specify text as a keyword, title or subheading, or to format text as subscript or superscript.

**Selecting text**

- Drag from the starting point to the ending point to select the text.

**Applying a text format**

1. Select the text in the Notes work area.
2. On the **Format menu**, select the name of the format to apply.

<table>
<thead>
<tr>
<th>Formatting examples:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>There is a <strong>Keyword</strong> in this line.</td>
</tr>
<tr>
<td>This line contains a <em>Sub</em>script.</td>
</tr>
<tr>
<td>This line contains a <strong>Super</strong>script.</td>
</tr>
</tbody>
</table>

**Note:** You can restore the text to normal by reapplying the same format.

**Inserting geometric shape symbols**

You can use geometric shape symbols to designate selected text as geometric objects, such as an angle, circle, or line segment.

1. Position the cursor where you want to insert a shape symbol.
2. On the **Insert** menu, select **Shapes**, and then select the shape to apply.
**Entering and evaluating expressions**

You can include math expressions in Notes text, using the same tools as in other TI-Nspire™ applications. You can also evaluate an expression and display the result.

**Entering an expression**

1. In the Notes work area, place the cursor where you want the expression.
2. On the **Insert** menu, select **Expression Box**.
3. Type the expression. You can use the Catalog, if necessary, to insert a function, command, symbol, or expression template.

**Evaluating an expression**

**Note:** The result of the expression will replace the expression. If you need both the expression and its result, make a copy of the expression and then evaluate the copy.

1. Select the entire expression.
2. On the **Actions** menu, select **Evaluate Expression**.
   - The result replaces the expression.
**Working with TI-Nspire™ libraries**

**What is a library?**

A library is a TI-Nspire™ document that contains a collection of variables, functions, and/or programs that have been defined as library objects.

Unlike ordinary variables, functions, and programs, which can be used only within a single problem (the problem in which they are defined), library objects are accessible from any document. You can even create public library objects that appear in the TI-Nspire™ Catalog.

For example, suppose you have created library document `matrix` containing public library function `trace` and a private library function `errmsg`.

Function `trace` calculates a rank of a square matrix. If its input is not a square matrix, `trace` calls function `errmsg`, which should then return an appropriate error string.

```plaintext
Define LibPub trace(m)=
  Func
  © trace(mat): trace of a matrix
  If rowDim(m)≠colDim(m) Then
    Return errmsg("not_square")
  EndIf
  rowDim(m)
  Return Σ (m[i,i])
  EndFunc

Define LibPriv errmsg[msgcode]=
  Func
  © Private library function errmsg[msgcode]
  ... 
  If msgcode="not_square" Then
    "Error: this is not a square matrix"
  EndIf
  ... 
  EndFunc
```

---

*Working with TI-Nspire™ libraries* 309
You could then use the following syntax to calculate trace of a matrix \( m \) defined in the current problem:

\[
\text{matrix}\text{\textbackslash trace}(m).
\]

**Creating libraries and library objects**

A document is regarded as a library when it is saved or copied to the designated library folder `My Documents\TI-Nspire\MyLib`. If the `My Documents\TI-Nspire\MyLib` folder has been inadvertently deleted, you must create it before attempting to use libraries.

You can define library objects using either the Program Editor or the Calculator application. Library objects must be defined with a **Define** command and must reside in the first problem of a library document.

**Note:** If you use the Program Editor to define a library function or program, you must store the object and also save the document. Saving the document does not automatically store the object. For more information, see the “Programming” section of the documentation.

Naming restrictions apply to library documents and library objects.

- A library document name must be a valid TI-Nspire™ variable name between 1 and 16 characters long, and it must not contain a period or begin with an underscore.

- A library object name must be a valid TI-Nspire™ variable name between 1 and 15 characters long. It must not contain a period and must not begin with an underscore.

**Private and Public library objects**

When you define a library object, you designate it as private (LibPriv) or public (LibPub).

Define \( a = 5 \) \( a \) is not a library object.

Define LibPriv \( b = \{1,2,3\} \) \( b \) is a private library object.

Define LibPub func1(x) = \( x^2 - 1 \) \( \text{func1} \) is a public library object.
A **Private** library object does not appear in the Catalog, but you can access it by typing its name. Private objects serve well as building blocks that perform basic, low-level tasks. Typically, private library objects are called upon by the public functions and programs.

A **Public** library object appears in the Catalog’s library tab after you refresh the libraries. You can access a public library object through the Catalog or by typing its name.

**Note:** In library programs and functions defined as public, a comment line (©) immediately following the **Prgm** or **Func** line is automatically displayed as help in the Catalog. You could, for example, show a syntax reminder there.

**Using short and long names**

Anytime you are in the same problem where an object is defined, you can access it by entering its short name (the name given in the object’s **Define** command). This is the case for all defined objects, including private, public, and non-library objects.

You can access a library object from any document by typing the object’s long name. A long name consists of the name of the object’s library document followed by a backslash “\” followed by the name of the object. For example, the long name of the object defined as **func1** in the library document **lib1** is **lib1\func1**.

**Note:** If you cannot remember the exact name or the order of arguments required for a private library object, you can open the library document or use the Program Editor to view the object. You also can use **getVarInfo** to view a list of objects in a library.

**Using library objects**

Before using a library variable, function, or program, make sure that these steps have been followed:

- The object has been defined with the **Define** command, and the command specifies either the LibPriv or LibPub attribute.

- The object resides in the first problem of a library document. The document must reside in the designated library folder (**My Documents\TI-Nspire\MyLib**) and must meet the naming requirements.

- If you defined the object using the Program Editor, it has been stored using **Check Syntax & Store** from the Program Editor menu.
• The libraries have been refreshed (click **Refresh Libraries** on the main toolbar).

**Using a public library object**

1. Click **Refresh Libraries** on the main toolbar to refresh all libraries.
2. Open the TI-Nspire™ application in which you want to use the variable, function or program.
   
   **Note:** All TI-Nspire™ applications can evaluate functions, but only the Calculator application can run programs.

3. Open the Catalog and use the library tab to find and insert the object.

   - or -

   Type the name of the object, such as `lib1\func1()`. In case of a function or program, always follow the name with parentheses.

4. If arguments are required, type them inside the parentheses.

**Using a private library object**

1. Click **Refresh Libraries** on the main toolbar to refresh all libraries.
2. Open the TI-Nspire™ application in which you want to use the variable, function or program.

   **Note:** All TI-Nspire™ applications can evaluate functions, but only the Calculator application can run programs.

3. Type the name of the object, such as `lib1\func1()`. In case of a function or program, always follow the name with parentheses.

4. If arguments are required, type them inside the parentheses.

**Included libraries**

To help you get started with libraries, TI-Nspire™ includes a library document with useful Linear Algebra functions. The library is named `linalg` and is located in the designated library folder **MyLib**.
Programming

You can create user-defined functions or programs by typing definition statements on the Calculator entry line or by using the Program Editor. The Program Editor offers some advantages, and it is covered in this section. For information on defining programs and functions in Calculator, see the “Calculator” chapter.

Overview of the Program Editor

The TI-Nspire™ Program Editor helps you define, edit, and manage user-defined functions and programs.

- The editor has programming templates and dialog boxes to help you define functions and programs using correct syntax.
- The editor lets you enter multiple-line programming statements without requiring a special key sequence to add each line.
- You can easily create private and public library objects (variables, functions, and programs). For details, see the “Libraries” chapter.
- The editor is accessible from the main Insert menu as well as from the Calculator’s Functions & Programs menu.

![Diagram of the Program Editor interface]

1. **Insert** menu
2. **Functions & Programs** menu
3. Example of defining a function: `cube(x)`
1 Program Editor menu – This menu is available anytime you are in the Program Editor work area.

2 Program Editor work area

3 Status line shows line number information and the name of the function or program being edited. An asterisk (*) indicates that this function is “dirty,” which means that it has changed since the last time its syntax has been checked and it has been stored.

The Program Editor menu

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td>New</td>
<td>Displays a dialog box for defining a new function or program.</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Lets you open an existing library function or program for editing.</td>
</tr>
<tr>
<td></td>
<td>Import</td>
<td>Imports a program or function from a library.</td>
</tr>
<tr>
<td></td>
<td>View</td>
<td>Lets you view (and optionally, edit) an existing library function or program.</td>
</tr>
<tr>
<td></td>
<td>Create Copy</td>
<td>Lets you copy the current function or program.</td>
</tr>
<tr>
<td></td>
<td>Rename</td>
<td>Lets you rename the current function or program.</td>
</tr>
<tr>
<td></td>
<td>Change Library Access</td>
<td>Lets you change the access level of a library object to private (LibPriv), public (LibPub), or none.</td>
</tr>
<tr>
<td></td>
<td>Insert Comment</td>
<td>Inserts a comment (©) at the cursor position.</td>
</tr>
<tr>
<td></td>
<td>Find</td>
<td>Displays a dialog box for text search.</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Menu Option</td>
<td>Function</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>Go Back</td>
<td>Lets you easily return from the Program Editor to the Calculator. Useful if you invoked the Program Editor from Calculator or from a runtime error that occurred in the Calculator.</td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current function or program.</td>
<td></td>
</tr>
</tbody>
</table>

### Check Syntax & Store

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Syntax &amp; Store</td>
<td>Finds syntax errors and tries to put the cursor near the first error. If no errors, stores current function or program.</td>
</tr>
<tr>
<td>Check Syntax</td>
<td>Finds syntax errors and tries to put the cursor near the first error.</td>
</tr>
</tbody>
</table>

### Define Variables

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td>Inserts <strong>Local</strong>.</td>
</tr>
<tr>
<td>Define</td>
<td>Inserts <strong>Define</strong>.</td>
</tr>
<tr>
<td>Delete Variable</td>
<td>Inserts <strong>DelVar</strong>.</td>
</tr>
<tr>
<td>Func...EndFunc</td>
<td>Inserts <strong>Func...EndFunc</strong> template.</td>
</tr>
<tr>
<td>Prgm...EndPrgm</td>
<td>Inserts <strong>Prgm...EndPrgm</strong> template.</td>
</tr>
</tbody>
</table>

### Control

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>If</td>
<td>Inserts <strong>If</strong> statement.</td>
</tr>
<tr>
<td>If...Then...EndIf</td>
<td>Inserts <strong>If...Then...EndIf</strong> template.</td>
</tr>
<tr>
<td>If...Then...Else...EndIf</td>
<td>Inserts <strong>If...Then...Else...EndIf</strong> template.</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Menu Option</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td>ElsIf...Then</td>
</tr>
<tr>
<td></td>
<td>For...EndFor</td>
</tr>
<tr>
<td></td>
<td>While...EndWhile</td>
</tr>
<tr>
<td></td>
<td>Loop...EndLoop</td>
</tr>
<tr>
<td></td>
<td>Try...Else...EndTry</td>
</tr>
<tr>
<td></td>
<td>ClrErr</td>
</tr>
<tr>
<td></td>
<td>PassErr</td>
</tr>
<tr>
<td><img src="image.png" alt="Transfer" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Return</td>
</tr>
<tr>
<td></td>
<td>Cycle</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
</tr>
<tr>
<td></td>
<td>Lbl</td>
</tr>
<tr>
<td></td>
<td>Go to Lbl</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
</tr>
<tr>
<td><img src="image.png" alt="Input/Output" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disp</td>
</tr>
<tr>
<td><img src="image.png" alt="Mode" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display Digits</td>
</tr>
<tr>
<td></td>
<td>Angle</td>
</tr>
<tr>
<td></td>
<td>Exponential Format</td>
</tr>
</tbody>
</table>
Defining a program or function

Starting a new Program Editor
1. If you are not on a Calculator page, click the Insert menu, and then click Program Editor > New.

- or -

If you are on a Calculator page, click Functions & Programs, and then click Program Editor > New.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real or Complex</td>
<td></td>
<td>Lets you select Real, Rectangular, or Polar.</td>
</tr>
<tr>
<td>Auto or Approx</td>
<td></td>
<td>Lets you select Auto or Approximate results.</td>
</tr>
<tr>
<td>Vector Format</td>
<td></td>
<td>Lets you select Rectangular, Cylindrical, or Spherical.</td>
</tr>
<tr>
<td>Base</td>
<td></td>
<td>Lets you select Decimal, Hex, or Binary.</td>
</tr>
<tr>
<td>GetMode</td>
<td></td>
<td>Inserts <code>getMode()</code></td>
</tr>
</tbody>
</table>

2. Type a name for the function or program you are defining.
3. Select the Type (Program or Function).
4. Set the Library Access:
   - If you want to use the function or program only from the current document and problem, select None.
– If you want the function or program to be accessible from any document but not visible in the Catalog, select **LibPriv**.

– If you want the function or program to be accessible from any document and also visible in the Catalog, select **LibPub (Show in Catalog)**. For details, see the “Libraries” chapter.

5. Click **OK**.

A new instance of the Program Editor opens, with a template matching the selections you made.

![Image of Program Editor](image)

**Entering lines into a function or program**

The Program Editor does not execute the commands or evaluate expressions as you enter them. They are executed only when you evaluate the function or run the program.

1. If your function or program will require the user to supply arguments, type parameter names in the parentheses that follow the name. Separate parameters with a comma.

![Image of Function Editor](image)

2. Between the Func and EndFunc (or Prgm and EndPrgm) lines, enter the lines of statements that make up your function or program.
– You can either type the names of functions and commands or insert them from the Catalog.

– A line can be longer than the width of the screen; if so, you might have to scroll to view the entire statement.

– After typing each line, press Enter. This inserts a new blank line and lets you continue entering another line.

– Use the <, >, ↑, and ↓ arrow keys to scroll through the function or program for entering or editing commands.

**Inserting comments**

A comment symbol (©) lets you enter a remark. Comments can be useful to someone viewing or editing the program. Comments do not display when the program runs, and they have no effect on program flow.

```
Define LibPub volcyl(h,t,r) =
Prgm
©volcyl(ht,r) => volume of cylinder ①
  Disp “Volume =”, approx(π • r² • h)
©This is another comment.
```

① Comment showing required syntax. Because this library object is public and this comment is the first line in a Func or Prgm block, the comment displays in the Catalog as help. For details, see the “Libraries” chapter.

To insert a comment:

1. Position the cursor at the end of the line where you want to insert a comment.

2. On the Program Editor’s Actions menu, select Insert Comment.

3. Type the text of the comment after the © symbol.
Checking syntax
The Program Editor lets you check the function or program for correct syntax.

- On the Program Editor’s **Check Syntax & Store** menu, select **Check Syntax**.

If the syntax checker finds any syntax errors, it displays an error message and tries to position the cursor near the first error so you can correct it.

```
* prgm1
```

```
Define prgm1(a,b)=
Prgm
    Disp "a=":a
EndPrgm
```

Storing the function or program
You must store your function or program to make it accessible. The Program Editor automatically checks the syntax before storing.

An asterisk (*) is displayed in the upper left corner of the Program Editor to indicate that the function or program has not been stored.

- On the Program Editor’s **Check Syntax & Store** menu, select **Check Syntax & Store**.
  - If the syntax checker finds any syntax errors, it displays an error message and tries to position the cursor near the first error.
  - If no syntax errors are found, the asterisk (*) at the upper left corner of the Program Editor is removed to show that the function or program has been stored.

**Note:** If the function or program is defined as a library object, you must also save the document in the designated library folder and refresh libraries to make the object accessible to other documents. For details, see the “Libraries” chapter.

Viewing an existing program or function
1. On the Program Editor’s **Actions** menu, select **View**.

   The View dialog box displays.
2. If the function or program is a library object, select its library from the **Location** list.

3. Select the function or program name from the **Name** list.

   The function or program displays in a viewer.

4. Use the arrow keys to view the function or program.

5. When finished viewing, click **Edit** to open the function or program in the Program Editor, or press **Esc** or click **Cancel** to close the viewer.

   **Note:** The **Edit** selection is available only for functions and programs defined in the current problem. To edit a library object, you must first open its library document.

---

**Opening an existing function or program**

You can open a function or program from the current problem only.

1. On the Program Editor’s **Actions** menu, select **Open**.

   A list of available functions and programs displays.
2. Select the item to open.

**Importing a program from a library**

You can import a function or program defined as a library object into a Program Editor within the current problem.

1. On the Program Editor’s *Actions* menu, select *Import*.
   
The Import dialog box displays.

   ![Import dialog box](image)

   - **Library Name**: tmp3
   - **Name**: volcy12
   - **Import As**: volcy12

2. Select the **Library Name**.
3. Select the **Name** of the object.
4. If you want the imported object to have a different name, type the name under **Import As**.

**Creating a copy of a function or program**

When creating a new function or program, you might find it easier to start with a copy of the current one.

1. On the Program Editor’s *Actions* menu, select *Create Copy*.
   
The Create Copy dialog box displays.

2. Type a new name, or click **OK** to accept the proposed name.
3. If you want to change the access level, select **Library Access**, and select a new level.
Renaming a program or function

You can rename and (optionally) change the access level of the current function or program.

1. On the Program Editor’s **Actions** menu, select **Rename**.
   
   A dialog box displays, with a proposed name.

   ![Rename Dialog Box]

   - Name: func1
   - Rename As: func2
   - Library Access: None

2. Type a new name, or click **OK** to accept the proposed name.
3. If you want to change the access level, select **Library Access**, and select a new level.

Changing the library access level

1. On the Program Editor’s **Actions** menu, select **Change Library Access**.

   ![Change Library Access Dialog Box]

   - Library Access: None

2. Select the **Library Access**:
   
   - If you want to use the function or program only from the current Calculator problem, select **None**.
   - If you want the function or program to be accessible from any document but not visible in the Catalog, select **LibPriv**.
   - If you want the function or program to be accessible from any document and also visible in the Catalog, select **LibPub**.
**Finding text**

1. On the Program Editor’s **Actions** menu, select **Find**.

![Find dialog box]

2. Type the text that you want to find, and click **OK**.
   - If the text is found, it is highlighted in the program.
   - If the text is not found, an notification message displays.

**Closing the current function or program**

1. On the Program Editor’s **Actions** menu, select **Close**.
2. If the function or program has unstored changes, you are prompted to check syntax and store before closing.

**Running programs and evaluating functions**

After defining and storing a function or program, you can use it from an application. All TI-Nspire™ applications can evaluate functions, but only the Calculator application can run programs.

The program statements are executed in sequential order (although some commands alter the program flow). The output, if any, is displayed in the application’s work area.

- Program execution continues until it reaches the last statement or a **Stop** command.
- Function execution continues until it reaches a **Return** command.

**Using short and long names**

Anytime you are in the same problem where an object is defined, you can access it by entering its short name (the name given in the object’s **Define** command). This is the case for all defined objects, including private, public, and non-library objects.

You can access a library object from any document by typing the object’s long name. A long name consists of the name of the object’s library document followed by a backslash “\” followed by the name of the object. For example, the long name of the object defined as **func1** in the library document **lib1** is **lib1\func1**.
Note: If you cannot remember the exact name or the order of arguments required for a private library object, you can open the library document or use the Program Editor to view the object. You also can use `getVarInfo` to view a list of objects in a library.

**Using a Public library function or program**

1. Make sure you have defined the object in the document’s first problem, stored the object, saved the library document in the MyLib folder, and refreshed the libraries.

2. Open the TI-Nspire™ application in which you want to use the function or program.

   Note: All TI-Nspire™ applications can evaluate functions, but only the Calculator application can run programs.

3. Open the Catalog and use the library tab to find and insert the object.

   - or -

   Type the name of the object. In the case of a function or program, always follow the name with parentheses.

   ```plaintext
   libs2\func1()
   ```

4. If the program requires you to supply one or more arguments, type the values or variable names inside the parentheses.

   ```plaintext
   libs2\func1(34,power)
   ```

5. Press Enter.

**Using a Private library function or program**

To use a Private library object, you must know its long name. For example, the long name of the object defined as `func1` in the library document `lib1` is `lib1\func1`.

Note: If you cannot remember the exact name or the order of arguments required for a private library object, you can open the library document or use the Program Editor to view the object.

1. Make sure you have defined the object in the document’s first problem, stored the object, saved the library document in the MyLib folder, and refreshed the libraries.
2. Open the TI-Nspire™ application in which you want to use the function or program.

**Note:** All TI-Nspire™ applications can evaluate functions, but only the Calculator application can run programs.

3. Type the name of the object. In the case of a function or program, always follow the name with parentheses.

   ```plaintext
   libs2\func1()
   ```

4. If the object requires you to supply one or more arguments, type the values or variable names inside the parentheses.

   ```plaintext
   libs2\func1(34,power)
   ```

5. Press **Enter**.

### Running a non-library program or function

1. Make sure you are in the same problem in which the function or program is defined.

2. Type the name of the function or program on the entry line, or click **var** on the toolbar to select the name from a list.

   You must always include a set of parentheses after the name.

   ```plaintext
   prog1()
   ```

   If the function or program requires you to supply one or more arguments, type the values or variable names inside the parentheses.

   ```plaintext
   prog1(34,power)
   ```

3. Press **Enter**.

### Getting values into a program

To input values into a function or program, you can:

- Require users to store values to specific variables beforehand. The object can then refer to these variables
Embed the values directly in the object itself.

```
Define calculatearea()=
Prgm
  wt:=3
  ht:=23
  area:=wt*ht
EndPrgm
```

Use parameters in the definition. This lets users pass one or more values as arguments to the object when they use it.

```
Define calculatearea(wt,ht)=
Prgm
  area:=wt*ht
EndPrgm
```

**Example of passing values to a program**

The following program, `volcyl`, calculates the volume of a cylinder. Two values must be passed to the program. The first value must be the height, and the second value must be the radius.

When you define the program in the Program Editor, you specify in parentheses the parameters that will be used to store the passed values. The parameters are placeholders, so their order is important. The names you choose should be names that remind you which information to supply.

1. Define the `volcyl` program.

```
Define volcyl(height,radius) =
Prgm
  Disp “Volume =”, approx(π•radius²•height)
EndPrgm
```
2. Run the program to display the volume of a cylinder with a height of 34 mm and a radius of 5 mm.

| volcyl(34,5) | Volume = 534.071 |

**Note:** You do not have to use the parameter names when you run the `volcyl` program, but you must supply two arguments (as values, variables, or expressions). The first must represent the height, and the second must represent the radius.

**Displaying information**

A running function or program does not display intermediate calculated results unless you include a `Disp` command. This is an important difference between performing a calculation on the entry line and performing it in a function or program.

These calculations do not display a result in a function or program (although they do from the entry line).

\[
\begin{align*}
\cos(\pi/4) \\
\text{Disp } 12\,\cdot\,6 \\
\text{Disp "Result:"}, \cos(\pi/4)
\end{align*}
\]

The `Disp` command displays calculation result or text in a function or program.

Displaying a result does not store that result. If you expect to refer later to a result calculated in a program, store the result to a global variable.

\[
\begin{align*}
\cos(\pi/4) &\rightarrow \text{maximum} \\
\text{Disp maximum}
\end{align*}
\]

**Using local variables**

A local variable is a temporary variable that exists only while a user-defined function is being evaluated or a user-defined program is running.

**Example of a local variable**

The following program segment shows a `For...EndFor` loop (which is discussed later in this module). The variable `i` is the loop counter. In most cases, the variable `i` is used only while the program is running.
Local i ①
For i,0,5,1
   Disp i
EndFor

① Declares variable i as local.

**Note:** When possible, declare as local any variable that is used only within the program and does not need to be available after the program stops.

**What causes an undefined variable error message?**

An **Undefined** variable error message displays when you evaluate a user-defined function or run a user-defined program that references a local variable that is not initialized (assigned a value).

For example:

```
Define fact(n)=Func
   Local m ①
   While n>1
      n*m→m: n–1→n
   EndWhile
```

① Local variable m is not assigned an initial value.

**You must initialize local variables**

All local variables must be assigned an initial value before they are referenced.

```
Define fact(n)=Func
   Local m: 1→m ①
   While n>1
      n*m→m: n–1→n
   EndWhile
```

① 1 is stored as the initial value for m.

**Differences between functions and programs**

A function defined in the Program Editor is very similar to the functions built into the TI-Nspire™ software.
• Functions must return a result, which can be graphed or entered in a table. Programs cannot return a result.

• You can use a function (but not a program) within an expression. For example: \(3 \cdot \text{func1}(3)\) is valid, but not \(3 \cdot \text{prog1}(3)\).

• You can run programs from Calculator only. However, you can evaluate functions in Calculator, Notes, Lists & Spreadsheet, Graphs & Geometry, and Data & Statistics.

• A function can refer to any variable; however, it can store a value to a local variable only. Programs can store to local and global variables.

  **Note:** Arguments used to pass values to a function are treated as local variables automatically. If you want to store to any other variables, you must declare them as **Local** from within the function.

• A function cannot call a program as a subroutine, but it can call another user-defined function.

• You cannot define a program within a function.

• A function cannot define a global function, but it can define a local function.

**Calling one program from another**

One program can call another program as a subroutine. The subroutine can be external (a separate program) or internal (included in the main program). Subroutines are useful when a program needs to repeat the same group of commands at several different places.

**Calling a separate program**

To call a separate program, use the same syntax that you use to run the program from the entry line.

```
Define subtest1()=
Prgm
  For i,1,4,1
    subtest2(i,i\cdot1000)
  EndFor
EndPrgm

Define subtest2(x,y)=
Prgm
  Disp x,y
EndPrgm
```

**Defining and calling an internal subroutine**

To define an internal subroutine, use the **Define** command with **Prgm...EndPrgm**. Because a subroutine must be defined before it can be called, it is a good practice to define subroutines at the beginning of the main program.
An internal subroutine is called and executed in the same way as a separate program.

```
Define subtest1() =
    Prgm
    local subtest2 ①
    Define subtest2(x,y) = ②
    Prgm
        Disp x,y
    EndPrgm
©Beginning of main program
For i,1,4,1
    subtest2(i,I*1000) ③
```

① Declares the subroutine as a local variable.
② Defines the subroutine.
③ Calls the subroutine.

**Note:** Use the Program Editor’s **Var** menu to enter the **Define** and **Prgm...EndPrgm** commands.

**Notes about using subroutines**

At the end of a subroutine, execution returns to the calling program. To exit a subroutine at any other time, use **Return** with no argument.

A subroutine cannot access local variables declared in the calling program. Likewise, the calling program cannot access local variables declared in a subroutine.

**Lbl** commands are local to the programs in which they are located. Therefore, a **Goto** command in the calling program cannot branch to a label in a subroutine or vice versa.

**Avoiding circular-definition errors**

When evaluating a user-defined function or running a program, you can specify an argument that includes the same variable that was used to define the function or create the program. However, to avoid circular-definition errors, you must assign a value for variables that are used in evaluating the function or running the program. For example:

```
x+1→x ①
```
Causes a Circular definition error message if x or i does not have a value. The error does not occur if x or i has already been assigned a value.

**Controlling the flow of a function or program**

When you run a program or evaluate a function, the program lines are executed in sequential order. However, some commands alter the program flow. For example:

- Control structures such as `If...EndIf` commands use a conditional test to decide which part of a program to execute.
- Loop commands such as `For...EndFor` repeat a group of commands.

**Using If, Lbl, and Goto to control program flow**

The `If` command and several `If...EndIf` structures let you execute a statement or block of statements conditionally, that is, based on the result of a test (such as `x>5`). `Lbl` (label) and `Goto` commands let you branch, or jump, from one place to another in a function or program.

The `If` command and several `If...EndIf` structures reside on the Program Editor’s `Control` menu.

When you insert a structure such as `If...Then...EndIf`, a template is inserted at the cursor location. The cursor is positioned so that you can enter a conditional test.

**If Command**

To execute a single command when a conditional test is true, use the general form:

```
If x>5
  Disp "x is greater than 5"  ①  
Disp x   ②
EndIf
```

① Executed only if x>5; otherwise, skipped.
② Always displays the value of x.
In this example, you must store a value to x before executing the If command.

**If...Then...EndIf structures**

To execute one group of commands if a conditional test is true, use the structure:

```plaintext
If x>5 Then
    Disp "x is greater than 5" ①
    2*x→x ①
EndIf
Disp x ②
```

① Executed only if x>5.
② Displays the value of:
   2x if x>5
   x if x≤5

**Note:** EndIf marks the end of the Then block that is executed if the condition is true.

**If...Then...Else... EndIf structures**

To execute one group of commands if a conditional test is true and a different group if the condition is false, use this structure:

```plaintext
If x>5 Then
    Disp "x is greater than 5" ①
    2*x→x ①
Else
    Disp "x is less than or equal to 5" ②
    5*x→x ②
EndIf
Disp x ③
```

① Executed only if x>5.
② Executed only if x≤5.
③ Displays value of:
   2x if x>5
   5x if x≤5
If...Then...ElseIf... EndIf structures

A more complex form of the If command lets you test for multiple conditions. Suppose you want a program to test a user-supplied argument that signifies one of four options.

To test for each option (If Choice=1, If Choice=2, and so on), use the If...Then...ElseIf...EndIf structure.

Lbl and Goto commands

You can also control the flow by using Lbl (label) and Goto commands. These commands reside on the Program Editor’s Transfers menu.

Use the Lbl command to label (assign a name to) a particular location in the function or program.

```
Lbl  labelName
```  

(name to assign to this location (use the same naming convention as a variable name)

You can then use the Goto command at any point in the function or program to branch to the location that corresponds to the specified label.

```
Goto  labelName
```  

(specifies which Lbl command to branch to)

Because a Goto command is unconditional (it always branches to the specified label), it is often used with an If command so that you can specify a conditional test. For example:

```
If  x>5
  Goto  GT5  ①
Disp  x
-------
-------  ②
Lbl  GT5
Disp  “The number was > 5”
```

① If x>5, branches directly to label GT5.

② For this example, the program must include commands (such as Stop) that prevent Lbl GT5 from being executed if x≤5.
**Using loops to repeat a group of commands**

To repeat the same group of commands successively, use one of the loop structures. Several types of loops are available. Each type gives you a different way to exit the loop, based on a conditional test.

Loop and loop-related commands reside on the Program Editor’s **Control** and **Transfers** menus.

When you insert one of the loop structures, its template is inserted at the cursor location. You can then begin entering the commands that will be executed within the loop.

**For...EndFor loops**

A **For...EndFor** loop uses a counter to control the number of times the loop is repeated. The syntax of the **For** command is:

Note: The ending value can be less than the beginning value, provided the increment is negative.

```
For variable, begin, end [, increment]
```

1. **Variable** used as a counter
2. Counter value used the first time **For** is executed
3. Exits the loop when **variable** exceeds this value
4. Added to the counter each subsequent time **For** is executed (If this optional value is omitted, the **increment** is 1.)

When **For** is executed, the **variable** value is compared to the **end** value. If **variable** does not exceed **end**, the loop is executed; otherwise, control jumps to the command following **EndFor**.

```
For i, 0, 5, 1
--------
EndFor
```

Note: The **For** command automatically increments the counter variable so that the function or program can exit the loop after a certain number of repetitions.

At the end of the loop (**EndFor**), control jumps back to the **For** command, where variable is incremented and compared to **end**.

For example:
Displays 0, 1, 2, 3, 4, and 5.

Displays 6. When variable increments to 6, the loop is not executed.

Note: You can declare the counter variable as local if it does not need to be saved after the function or program stops.

### While...EndWhile loops

A While...EndWhile loop repeats a block of commands as long as a specified condition is true. The syntax of the While command is:

```
While condition
```

When While is executed, the condition is evaluated. If condition is true, the loop is executed; otherwise, control jumps to the command following EndWhile.

Note: The While command does not automatically change the condition. You must include commands that allow the function or program to exit the loop.

At the end of the loop (EndWhile), control jumps back to the While command, where condition is re-evaluated.

To execute the loop the first time, the condition must initially be true.

- Any variables referenced in the condition must be set before the While command. (You can build the values into the function or program, or you can prompt the user to enter the values.)
- The loop must contain commands that change the values in the condition, eventually causing it to be false. Otherwise, the condition is always true and the function or program cannot exit the loop (called an infinite loop).

For example:

```
Initially sets x.
Displays 0, 1, 2, 3, and 4.
Increments x.
Displays 5. When x increments to 5, the loop is not executed.

Loop...EndLoop loops
A Loop...EndLoop creates an infinite loop, which is repeated endlessly. The Loop command does not have any arguments.

Typically, you insert commands in the loop that let the program exit from the loop. Commonly used commands are: If, Exit, Goto, and Lbl (label).

An If command checks the condition.
Exits the loop and jumps to here when x increments to 6.

Note: The Exit command exits from the current loop.
In this example, the **If** command can be anywhere in the loop.

<table>
<thead>
<tr>
<th>When the If command is:</th>
<th>The loop is:</th>
</tr>
</thead>
<tbody>
<tr>
<td>At the beginning of the loop</td>
<td>Executed only if the condition is true.</td>
</tr>
<tr>
<td>At the end of the loop</td>
<td>Executed at least once and repeated only if the condition is true.</td>
</tr>
</tbody>
</table>

The **If** command could also use a **Goto** command to transfer program control to a specified **Lbl** (label) command.

**Repeating a loop immediately**

The **Cycle** command immediately transfers program control to the next iteration of a loop (before the current iteration is complete). This command works with **For...EndFor**, **While...EndWhile**, and **Loop...EndLoop**.

**Lbl and Goto loops**

Although the **Lbl** (label) and **Goto** commands are not strictly loop commands, they can be used to create an infinite loop. For example:

```
Lbl START
       --
       --
Goto START
       --
```

As with **Loop...EndLoop**, the loop should contain commands that let the function or program exit from the loop.

**Changing mode settings**

Functions and programs can use the **setMode()** function to temporarily set specific calculation or result modes. The Program Editor’s **Mode** menu makes it easy to enter the correct syntax without requiring you to memorize numeric codes.

**Note:** Mode changes made within a function or program definition do not persist outside the function or program.

**Setting a mode**

1. Position the cursor where you want to insert the **setMode** function.
2. On the **Mode** menu, select the mode to display a menu of its valid settings.
3. Select a setting.
The correct syntax is inserted at the cursor location. For example:

```
setMode(1,3)
```

### Debugging programs and handling errors

After you write a function or program, you can use several techniques to find and correct errors. You can also build an error-handling command into the function or program itself.

If your function or program allows the user to select from several options, be sure to run it and test each option.

#### Techniques for debugging

Run-time error messages can locate syntax errors but not errors in program logic. The following techniques may be useful.

- Temporarily insert `Disp` commands to display the values of critical variables.
- To confirm that a loop is executed the correct number of times, use `Disp` to display the counter variable or the values in the conditional test.
- To confirm that a subroutine is executed, use `Disp` to display messages such as “Entering subroutine” and “Exiting subroutine” at the beginning and end of the subroutine.

#### Error-handling commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Try...EndTry</strong></td>
<td>Defines a block that lets a function or program execute a command and, if necessary, recover from an error generated by that command.</td>
</tr>
<tr>
<td><strong>ClrErr</strong></td>
<td>Clears the error status and sets the error number in system variable Errornum to zero.</td>
</tr>
<tr>
<td><strong>PassErr</strong></td>
<td>Passes an error to the next level of the Try...EndTry block.</td>
</tr>
</tbody>
</table>
Data Collection

The Data Collection tool enables you to collect experimental information from a sensor and automatically display it in a table and/or graph for analysis. It works with both the Lists & Spreadsheet and Graphs & Geometry applications. Refer to these application chapters to learn more about using both Graphs & Geometry and Lists & Spreadsheet.

Compatible sensors

Data Collection is capable of interacting with the following sensors:

- Vernier EasyTemp®
- Texas Instruments CBR2™ Motion Detector
- Vernier Go!®Temp
- Vernier Go!®Motion

Experimental data

The Data Collection tool collects distance or temperature data points at regular intervals over time. The units of measure, degrees Celsius, seconds, and meters, cannot be changed.

The table below shows the number of samples and sampling interval for the sensors currently supported.

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Number of Samples</th>
<th>Sampling Interval</th>
<th>Test Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vernier EasyTemp®</td>
<td>180</td>
<td>1 second</td>
<td>180 seconds</td>
</tr>
<tr>
<td>Texas Instruments CBR2™ Motion Detector</td>
<td>100</td>
<td>0.05 second</td>
<td>5 seconds</td>
</tr>
<tr>
<td>Vernier Go!®Temp</td>
<td>180</td>
<td>1 second</td>
<td>180 seconds</td>
</tr>
<tr>
<td>Vernier Go!®Motion</td>
<td>100</td>
<td>0.05 second</td>
<td>5 seconds</td>
</tr>
</tbody>
</table>
**Starting the Data Collection tool**

The Data Collection tool can be started automatically or manually.

**Automatic start mode**

An automatic start occurs when a sensor is connected to either a TI-Nspire™ handheld or a computer running TI-Nspire™ computer software. The connected sensor is configured to work with the Data Collection tool in an open Graphs & Geometry page, or if there is no available Graphs & Geometry on the active page, a new page opens and the page displays Graphs & Geometry and Lists & Spreadsheet. If more than one document is open (on a computer), you are asked to select which document to use.

The Data Collection tool:

- determines the type of sensor you have connected.
- labels the Graphs & Geometry axes with the appropriate experiment labels and adds labels to the Lists & Spreadsheet columns if Lists & Spreadsheet is on the same page.

Data Collection is ready to monitor and collect experimental data samples.

The following example shows a Data Collection page ready to collect data. This page contains a default template for collecting EasyTemp experimental data.

**Note:** The columns were manually widened to show headings.

*Data Collection page ready for temperature versus time experiment*
Manually starting the Data Collection tool

When you choose to add the Data Collection tool to a Graphs & Geometry application page, it is strongly recommended that you also add Lists & Spreadsheet to the page as well. This is not required, but if you want to store data from multiple experiments, you will need the Lists & Spreadsheet application on the page.

When you add the Data Collection tool, it attempts to configure itself to the first available sensor. Any sensor that is already being controlled by another Data Collection tool is considered unavailable. To make an unavailable sensor available again, close its Data Collection tool.

To set up a page for Data Collection:

1. Add a new page to your current document or open a new document.
   - Apply a new page layout template using the button to define two work areas.
2. Add Graphs & Geometry to one area of the new page, and add Lists & Spreadsheet to the second area.
3. Add the Data Collection tool to the page containing Graphs & Geometry. To do this, select the Data Collection tool from the Tools menu.
4. Data Collection scans for an attached sensor. When one is found, Data Collection determines the appropriate labels for Graphs & Geometry axes and adds them to the graph. Graphs & Geometry labels include the numeric ranges on the axes as well as the text labels. The columns in Lists & Spreadsheet are also labeled.

**Data Collection controls**

The specific controls available for use with the Data Collection tool are listed in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Control Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Start Data Collection</td>
<td>Initiates data collection.</td>
</tr>
<tr>
<td>🔴</td>
<td>Stop Data Collection</td>
<td>Stops data collection. The graph of existing data points is shown, and for motion experiments, velocity and acceleration data for the points are also available.</td>
</tr>
<tr>
<td>✗</td>
<td>Close</td>
<td>Close button. Completely closes the control box. If this button is selected when data collection is in progress, all data collection stops. The plot is erased. If Lists &amp; Spreadsheet is on the page, the data points collected are shown in the columns. For motion experiments, velocity and acceleration data is not provided.</td>
</tr>
</tbody>
</table>
Running an experiment and collecting data

1. When the desired sensor is connected and the Data Collection page is set up as desired, press the Start icon (▶).

2. If Lists & Spreadsheet is on your page, you see each sample collected populate the rows in the table. The sampling data points are plotted on the graph.

3. The experiment is completed when all data points have been collected. Data Collection automatically stops.

   If desired, you can press Stop (■) prior to the end of the experiment.
4. The data from this experiment is shown on the Graphs & Geometry plot.
5. To rerun the experiment without retaining the current data, press START ( ). The data displayed is erased when the new experiment is started.

   **Note:** When you press START, an Overwrite Data message displays, warning you that the existing data will be lost.

   - Select Cancel and read the section entitled "Storing collected data" to save the existing data.
   - Select OK to rerun the experiment and overwrite the existing data.

**Data Collection names**

The naming system for Data Collection data includes a group designator and a member designator (group.member). For example, in a temperature versus time experiment, the data is named `run0.temp_C` and `run0.time_s`. Remember that TI-Nspire™ computer software is case insensitive: `RUN0.TEMP_C` and `run0.temp_c` reference the same set of data.

**Storing collected data**

To save the current data before rerunning an experiment, use the following instructions.

**To save temperature data**

1. Cut and paste each column of data into new columns.
   
   The first two columns (Columns A and B) will be reused by the next run of the experiment.

2. Rename each moved column.

Repeat the steps for each data sample you want to save. To permanently save a set of data generated by an experiment, save the document.

**To save motion data**

1. Cut and paste each column of data into new columns.
   
   The first two columns (Columns A and B) will be reused by the next run of the experiment.

2. Rename each moved column.
3. To save velocity data, select a third column.

Highlight the column, and select variable. Select Link to: and choose the velocity variable.

The column is filled with the velocity values for the experiment. Rename the column with a unique name.
4. Repeat this procedure to save acceleration data.

5. Repeat the steps for each experimental data set you want to save.

To permanently save all experimental runs retained on the page, save the document.
Retrieving stored experimental results

To review stored experimental data, open the document that contains the data. If necessary, set up and configure Graphs & Geometry and Lists & Spreadsheet. You can perform further data analysis using the Lists & Spreadsheet application.

Troubleshooting the Data Collection tool

Following are some of the most common situations you might experience along with guidelines for correcting them.

Sensor was not detected by TI-Nspire™ software when connected to a TI-Nspire™ handheld or computer.

- Check that the sensor connectors are completely inserted into the handheld/computer.
- Unplug the sensor then reconnect it. This should restart the communication link.

Low batteries.

This message displays when the batteries in your Vernier Go!® Motion or CBR2™ unit are low. Replace the batteries at the next convenient opportunity.

Note: If you connect these sensors to your computer, batteries are not required. The sensors will obtain their power from the computer by way of the USB port.

Bad batteries: <hardware name>

This message displays when the batteries in your Vernier Go!® Motion, CBR2™, or TI-Nspire™ handheld are too low to continue data collection. Consult the Battery Information section of this manual or your sensor’s manual to replace them.

Communication Failure.

This message displays when communication is disrupted between the TI-Nspire™ handheld or TI-Nspire™ computer software and the connected data collection device. Check all connections and power, then restart the Data Collection tool.

Data Collection Conflict.

This message displays when another computer application is managing data collection. To collect data using TI-Nspire™ computer software, close the other data collection application and restart the TI-Nspire™ software.
**Unrecognized Device.**

This message displays when you attempt to collect data with Vernier EasyLink® or Vernier Go!® Link and the TI-Nspire™ Data Collection tool. TI-Nspire™ software does not support the use of EasyLink® or Go!® Link at this time.

**Overwrite Data.**

This message displays when you start a Data Collection experiment and you already have data present from a previous run. To save the existing data, press Cancel. See the Storing Data section of this chapter for detailed instructions on saving different types of data.

**Device not found.**

The expected data collection device was not found. This message displays when you open a document that had a Data Collection tool open, and either no sensor is connected or the wrong sensor is connected. To correct the error situation, close the document, attach the correct sensor and then reopen the document.

**Error.**

This message displays when an unexpected error occurs that in some way interferes with the Data Collection tool. Data Collection is terminated. Verify that all connections and batteries are good, then retry the experiment.
Appendix: Service and Support

Texas Instruments Support and Service

For general information
For more information about TI products and services, contact TI by e-mail or visit the TI Internet address.

E-mail inquiries: ti-cares@ti.com
Home Page: education.ti.com

Service and warranty information
For information about the length and terms of the warranty or about product service, refer to the warranty statement enclosed with this product or contact your local Texas Instruments retailer/distributor.
Index

Symbols
©, comment 319

A
absolute cell references in a table 236
adding
a Calculator to a page 46
Notes to a page 303
adding text and numbers to a
Graphs & Geometry page 143
adjacent cells
filling 240
alphanumerics
adding to a Graphs & Geometry page 143
analytic and geometric work areas
(Graphs & Geometry) 81
analytic/geometric work area
differences 85
angle
finding the measure of 141
Angle Bisector tool 158, 159
Angle tool 141
angles
bisecting 158
animating a point on an object 162
animating objects 162
animation 162
changing speed of 164
pausing and resuming 164
resetting 164
starting 162
stopping 164
animation control panel (Graphs & Geometry) 163
animation values
capturing from Graphs & Geometry 260
capturing with Lists & Spreadsheet 260
answer
using last answer 57
application
adding to a page 12
Calculator 41
Program Editor 313
applications
adding to pages 24
approximate results 47
area
of a circle 140
of a polygon 140
of a rectangle 140
of a triangle 140
Area tool 140
Attribute tool 97, 98, 163
attributes (Graphs & Geometry) 95
automatic start mode (Data Collection) 342
axes
adjusting end styles 86
adjusting length 85, 207, 209
adjusting location on card 87
adjusting tic marks 86
creating 85
Ages Setting tool 87
B
bisecting a segment 155, 156, 157
bisecting an angle 158
C
Calculate output option 268
Calculate tool 144
Calculator
adding to a page 46
getting started with 41
Calculator history 65
viewing 65
Calculator toolbar 42, 229
Calculator toolbar, using 46
capturing
Graphs & Geometry data 260
Catalog
inserting items from 48, 51, 237, 268
catalog
inserting commands 17

cell range, inserting into a formula 232

cell references

absolute and relative 236

cells

copying in a table 239

filling adjacent 240

linking to a variable 38, 241

selecting a block of 239

sharing table cells 241

character strings

examples of 32, 55

Chi 290

chi-square goodness of fit test 290

circle

creating with Compass tool 127

finding perimeter of 140

finding the area of 140

moving 126

resizing 126

Circle tool 125

circles

creating 125

Circular definition error 331

clear

error, ClrErr 339

clearing

the Calculator history 67

clearing the work area (Graphs & Geometry) 105

ClrErr, clear error 339

column

inserting into a matrix 50

columns

based on other columns 251

copying in a table 245

deleting contents of 244

deleting from a table 244

generating data in tables 250

inserting in a table 244

linking to a list variable 257

moving in a table 246

resizing 243

scrolling independently 244

selecting in a table 243

sharing table column as a list 254

comments

inserting in Notes application 305

Compass tool 127

Construction Menu tools (Graphs & Geometry) 77

contact information 353

context menu 79

control panel, animation 163

controls (Data Collection) 344

Coord. and Eq. tool

labeling with the 115

copying

table cells 239

table data 295

table rows or columns 245

copyright statement ii

creating

a system of equations 53

functions and programs 58

lists from a table column 254

matrices 50

piecewise functions 52

creating a circle 125

creating a point 114

creating a point on an object 114

creating a polygon 131

creating a rectangle 130

creating a regular polygon 133

creating a triangle 129

creating linear objects

line 118

parallel line 121

perpendicular line 122

ray 118

segment 119

segment with midpoint 120

tangent line 124

vector 123

creating midpoints 120

creating objects 125

creating parallel lines 121

creating perpendicular lines 122

creating points and lines (Graphs & Geometry) 113

creating scatter plots (Graphs & Geometry) 165

creating segments 119
creating shapes 125
creating tangents 124
creating vectors 123
customer support and service 353

D
data
capturing from Graphs & Geometry 260
generating columns of 250
graphing table data 258
sorting in a table 247

Data & Statistics
getting started with 169
plotting contents of linked variables 178
plotting data from Lists & Spreadsheet 175

Data Collection
automatic start mode 342
controls 344
data types supported 341
manual start mode 343
retrieving stored experimental results 350
running an experiment 345
sampling intervals 341
sensors supported 341
storing collected data 347
test durations 341

Data Collection Tool
starting 342

deferring evaluation in Calculator 53

defined function
recalling 62

defining
functions and programs 58
internal subroutine 330
multiple-line functions 58, 60
piecewise functions 52
variables with Calculator 53
defining an intersection point 115
deleting
an element from a list in Lists & Spreadsheet 257
an entry from the Calculator history 67

contents of a row or column 244
contents of table cells 238
part of an expression 63
table rows and columns 244
deleting functions 105
derivative
finding the 148
desktop view
changing 20
dilating an object 153
Dilation tool 154
Disp, for debugging 339
display
Disp command 328
document settings
applying 17
documents
adding a problem to a 27
creating new 23
printing 30
saving 29
saving with a new name 29

Draw output option 268

E
editing
math expressions 62
values in a list 257

editing functions 103
else if, ElseIf 333
else, Else 333
ElseIf, else if 333
end
for, EndFor 332, 335
if, EndIf 332
loop, EndLoop 337
try, EndTry 339
while, EndWhile 336
EndFor, end for 332, 335
EndIf, end if 332
EndLoop, end loop 337
EndTry, end try 339
EndWhile, end while 336

entering
table data, methods for 234
entering math expressions 46
entry line expand button (Graphs & Geometry) 100

equations
  identifying 137
  labeling 137

errors and troubleshooting
  Circular definition 331
  clear error, ClrErr 339
  pass error, PassErr 339
  programs 339

evaluating
  math expressions 47
  evaluating a math expression 49
  evaluating math expressions 46
  exchanging table data 295
  execute program, Prgm 330
  expand button (Graphs & Geometry) 100
  experiment (Data Collection) 345
  experimental data, supported types 341
  experimental results
    retrieving 350
  expression templates
    using 48, 237

expressions
  deleting part of 63
  editing 62
  entering and evaluating 46, 47
  entering from a template 49
  entering in a table 235
  entering with a wizard 51, 268
  examples of 32, 55
  in Notes application 307
  reusing in Calculator 66
  selecting in Calculator 63

finding the mix/max of a function 146

for, For 332, 335

formula
  inserting a cell range into 232

function
  Trace 105
  function definition
    recalling 62
  function tables 263
  function, y= 100
  functions
    creating 58
    creating piecewise 52
    defining multiple-line 58, 60
    deleting 105
    editing 103
    entering (Graphs & Geometry) 99
    examples of 32, 55
    finding the min/max 146
    renaming 102
    rules for naming 56
    user-defined 329
    working with (Graphs & Geometry) 99

G
generating
  data in tables 250

decimal places, 10

decimal separator, 10

decimal format, 10
decimal point, 10

decimal point, Changing 15

decimal point, Changing 235, 240

decimal point, Removing 15

generation, 325

generation, formula 15

generation, table data 250

generation, table data 258

generation, table data 232

generating
  data in tables 250
geometric shape symbols
  in Notes application 306

go to, Goto 331, 334, 338

graphing
  table data 258
  graphing inequalities 102
Graphing Type Menu tools (Graphs & Geometry) 73

graphs
  Trace 105

Graphs & Geometry
  work area 79

grid
  displaying 88
  hiding 89

H

Hide/Show Axes tool 87
Hide/Show Grid tool 88
history
deleting Calculator history 67
in Calculator 65
viewing Calculator 65
history button (Graphs & Geometry) 100
home screen (TI-NspireTM) 3

I
identifying a point 115
identifying an equation 137
if, If 332, 333
inequalities
  graphing 102
inferential statistics
  calculating test results
    (Calculate) 268
  graphing test results (Draw) 268
input descriptions table 294
pooled option 293
inserting
  a Calculator on a page 46
  a row or column in a table 244
  a row or column into a matrix 50
  an element in a list in Lists & Spreadsheet 257
comments in Notes application 305
Notes on a page 303
Integral tool 147
integral, finding for a function 147
Intersection Point tool 115
intersection points
  defining 115
invT (inverse Student T distribution) 281

L
label, Lbl 331, 334, 338
labeling a point with Coord. and Eq. Tool 115
labeling an equation 137
last answer
  using 57
length
  labeling 138
  measuring 138
Length tool 138, 140
libraries 309
library objects
  using 311
line
  finding the slope of 142
Line tool 118
lines
  changing style 97
  changing thickness 97
  creating 113
lines, creating 118
linking
  table cell to a variable 38, 241
  table column to a list 257
linking variables 36
lists
  capturing Graphs & Geometry data 260
  deleting elements in a table 257
  examples of 32, 55
  inserting elements in a table 257
  sharing table columns as 254
  viewing and editing 257
Lists & Spreadsheet
  adding to a page 231
  getting started with 227
local variable, Local 328
locking
  measurements 98
  points 98
locus
  creating 160
Locus tool 160, 161
loop, Loop 337

M
manual start mode (Data Collection) 343
math expressions
  editing 62
  entering and evaluating 46
  entering in a table 235
  selecting in Calculator 63
  with multiple statements 55
math templates
using 48, 237
matrices
 creating 50
 examples of 32, 55
matrix
 inserting a row or column 50
max
 finding the function 146
maxima
 finding 146
Measurement Menu tools (Graphs & Geometry) 76
Measurement Transfer tool 134
measurements
 finding angle 141
 transferring 134
 types that can become variables 32
measuring length 138
menu
 context (Graphs & Geometry) 79
menus
 options 4
Midpoint tool 120
min
 finding the function 146
minima
 finding 146
modes
 setting in programs 338
moving
 circle 126
 rows and columns in a table 246
 triangle 129
 vector 124
moving text 144
multiple cells
 selecting 239
multiple work areas
 creating, creating multiple work areas 12
multiple-line functions
 defining 58, 60
multiple-statement expressions 55

N
naming

note

O
object
 finding perimeter of 140
objects
 creating 125
 dilating 153
 naming while constructing 116
 reflecting 150
 rotating 152
 symmetry of 149
 translating 151

P
page contents, checking layout
 (Graphs & Geometry) 92
page sorter pane 10
pages
 adding a Lists & Spreadsheet application 231
 adding to problems 27
 panning the work area 87
 Parallel (Line) tool 121
 pass error, PassErr 339
 pasting
 table data 295
 pause, Pause 339
 perimeter
 finding 140
 Perpendicular (Line) tool 122

360
Perpendicular Bisector tool 155, 156, 157
piecewise functions
creating 52
plotting
table data 258
Point On tool 114
Point tool 114
points
creating 113, 114
identifying 115
labeling 115
redefining 117
Points and Lines Menu tools (Graphs & Geometry) 75
points of interest, finding 146
points on
creating 114
polygon
creating 131
finding perimeter of 140
finding the area of 140
Polygon tool 131
pooled option 293
precision of results 47
presentation view 21
Print preview 31
printing documents 30
problems
adding to documents 27
Program Editor
overview 313
programs
creating 58
programs and programming
arguments 327
branching 332, 334
calling another program 330
clear error, ClrErr 339
comment, © 319
debugging 339
Disp 328
else if, ElseIf 333
d elseif, Else 333
end for, EndFor 332, 335
d endif, EndIf 332, 333
d end loop, EndLoop 337
d end try, EndTry 339
d end while, EndWhile 336
d for, For 332, 335
d functions 329
g o to, Goto 331, 334, 338
d if, If 332, 333
dl abel, Lbl 331, 334, 338
d local, Local 328
d loop, Loop 337
d looping 332, 335, 336
d pass error, PassErr 339
d passing values 327
d return, Return 331
running 324
subroutines 330
Then, Then 333
d try, Try 339
while, While 336
Proof template
using 304

Q
Q & A template
using 304
Quick Graph, using 258

R
range of cells, inserting by selecting
232
ray
finding the slope 142
Ray tool 118
rays
creating 118
recalling
a function definition 62
rectangle
creating a 130
finding perimeter of 140
finding the area of 140
Rectangle tool 130
Redefine tool 117
redefining a point 117
reflecting an object 150
Reflection tool 150
Regular Polygon tool 133
regular polygon, creating 133
relative cell references in a table 236
renaming functions 102
repositioning a measured value 142
reshaping
triangle 130
resizing
table rows and columns 243
vector 124
resizing the work area 88, 89
results
approximating 47
deferring in Calculator 53
reusing in Calculator 66
using last answer 57
return, Return 331
reusing
expressions or results 66
last answer in Calculator 57
rotating an object 152
Rotation tool 153
row
inserting into a matrix 50
rows
copying in a table 245
deleting contents of 244
deleting from a table 244
inserting in a table 244
moving in a table 246
resizing 243
selecting in a table 243
S
sampling intervals (Data Collection) 341
saving documents 29
Scatter Plot tool 165
scatter plots
creating 165
scrolling
a sequence column
independently 244
a table 231
segment
bisecting 155, 156, 157
finding the slope of 142
Segment tool 119
selecting
a block of table cells 239
expressions in Calculator 63
multiple objects in Graphs & Geometry 112
single object from group (Graphs & Geometry) 112
table rows or columns 243
text in Notes application 306
sensors (Data Collection) 341
sequences
generating in a table column 252
service and support 353
settings
system, system settings 17
shape symbols in Notes application 306
shapes
creating 125
Shapes Menu tools (Graphs & Geometry) 77
sharing
a table column as a list 254
table column as a list 254
table-cell values 241
slope
finding the derivative of a function 148
of a line 142
of a ray 142
of a segment 142
of a vector 142
Slope tool 142, 149
sorting
table data 247
special characters
entering 19
specifying x-min, x-max, y-min, y-max 87
spreadsheet applications,
exchangeing data with 295
starting Data Collection 342
storing
methods for 54
values in variables 53
storing data (Data Collection) 347
substituting a value for a variable 58
support and service 353
symbol palette 19
symmetry 149
Symmetry tool 150
syntax
  using to prevent naming conflicts 35, 242
system of equations 53

T
table data
  exchanging with other applications 295
graphing 258
  sorting 247
table of function values 263
tables
  capturing Graphs & Geometry data 260
copying a row or column 245
deleting contents of cells 238
deleting list elements in 257
deleting rows and columns 244
generating column data 250
generating started with 227
  inserting a row or column 244
  inserting list elements 257
  linking a column to a list 257
methods for entering data 234
  moving a row or column 246
  navigating in 231
  selecting a row or column 243
  sharing a column as a list 254
  working with cells 236
Tangent tool 124, 148
templates 19
  Proof 304
  Q & A 304
  using 49
text
  adding to a Graphs & Geometry page 143
  formatting in Notes 306
  moving 144
  selecting in Notes application 306
Text tool 100, 143
Then, Then 333
TI Connect, exchanging data with 295
tool bars
description 8
tool menus (Graphs & Geometry) 70, 170
toolbar
  Notes 301
  using in Calculator 46
toolbar (Graphs & Geometry) 70, 170
toolbars
  Calculator 42, 229
Tools
  Angle 141
  Angle Bisector 158, 159
  Area 140
  Attributes 97, 98, 163
  Axes Setting (Graphs & Geometry) 87
  Calculate 144
  Circle 125
  Compass 127
  Dilation 154
  Hide/Show Axes 87
  Hide/Show Grid 88
  Integral 147
  Intersection Point 115
  Length 138, 140
  Line 118
  Locus 160, 161
  Measurement Transfer 134
  Midpoint 120
  Parallel 121
  Perpendicular 122
  Perpendicular Bisector 155, 156, 157
  Point 114
  Point On 114
  Polygon 131
  Ray 118
  Rectangle 130
  Redefine 117
  Reflection 150
  Regular Polygon 133
  Rotation 153
  Scatter Plot 165
  Segment 119
  Slope 142, 149
  Symmetry 150
  Tangent 124, 148
Text 100, 143
Trace 106, 107
Translate 152
Triangle 129
Variables 32, 37, 39
Vector 123
Zoom 89
Trace tool 105, 106, 107
tracing a function or graph 105
transferring a measurement onto a
circle 136
transferring measurements (Graphs & Geometry) 134
transferring numerical text entries to an axis 135
Transformation Menu tools (Graphs & Geometry) 78
Translate tool 152
translating an object 151
triangle
  finding perimeter of 140
  finding the area of 140
  moving 129
  reshaping 130
Triangle tool 129
triangle, creating 129
troubleshooting (Data Collection) 350
try, Try 339

U
Undo 92
user-defined functions 329
using variables 36

V
variable names
  examples 35
variables 53
  checking in Calculator 36, 54
  creating 32
  creating from table cells 241
  linking table column to a list 257
  linking to 38, 241
  local, Local 328
  methods for storing in Calculator 54
  preventing naming conflicts 35, 242
  removing 39
  rules for naming 56
  sharing table column as a list 254
  storing, example 53
  substituting a value for 58
  types 32
  types of 55
  updating in Calculator 55
  using 37
  using in a calculation 54
Variables Tool 32, 37, 39
vector
  finding the slope of 142
  moving 124
  resizing 124
Vector tool 123
verifying page contents for
  handheld screen 92
view
  handheld, handheld view 20
  handheld, view
    changing 20
    presentation 20, 21
View Menu tools (Graphs & Geometry) 72
viewing
  values in a list 257

W
while, While 336
Window Menu tools (Graphs & Geometry) 73
wizard
  entering expressions with 51, 268
work area
  description 11
  Graphs & Geometry 79
  panning 87
  resizing 88
work areas
  multiple 11
working with functions (Graphs & Geometry) 99
X
x-min, x-max, y-min, y-max 87

Y
y= functions, graphing 100

Z
zeroes
  finding 146
Zoom tool 89
  Default Zoom 91
  Fit 92
  Stat 92
  Trig 91
  User 91
  Zoom - Box 90
  Zoom - In 90
  Zoom - Out 90
  Zoom - Quadrant 1 91